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For B1500A Users

Agilent B1500A supports the following modules. For reading this manual, ignore the
information about the other modules.

+  B1510A High power source/monitor unit (HPSMU)

+  B1511A Medium power source/monitor unit (MPSMU)

+ B1517A High resolution source/monitor unit (HRSMU)

+  B1520A Multi frequency capacitance measurement unit (MFCMU or CMU)

+ B1525A High voltage semiconductor pulse generator unit (HVSPGU or SPGU)
+  B1530A Waveform generator/fast measurement unit (WGFMU)

For B1505A Users

Agilent B1505A supports the following modules. For reading this manual, ignore the
information about the other modules.

+  B1510A High power source/monitor unit (HPSMU)

+ B1512A High current source/monitor unit (HCSMU)

+  B1513A High voltage source/monitor unit (HVSMU)

»  B1520A Multi frequency capacitance measurement unit (MFCMU or CMU)

EasyEXPERT is a trademark of Agilent Technologies. Microsoft and Windows are registered trademarks of Microsoft
Corporation. All other trademarks are the property of their respective owners.



NOTE

In This Manual

This manual describes the reference information of Agilent Technologies EasyEXPERT
which is the system software of Agilent Technologies B1500 device analyzer series.
This manual consists of the following chapters.

+ Chapter 1, “Main GUI”

This chapter provides the reference information of the EasyEXPERT main GUI.
+ Chapter 2, “Classic Test Definition”

This chapter provides the reference information of the classic test setup GUI.
+ Chapter 3, “Application Test Definition”

This chapter provides the reference information of the application test definition
setup GUL

+ Chapter 4, “Function Details”

This chapter explains the several functions and the initial settings of the
B1500/EasyEXPERT.

+ Chapter 5, “Built-in Programming Tool”

This chapter provides the reference information of the built-in mathematical
functions and the read out functions.

+ Chapter 6, “If You Have a Problem”

This chapter explains how to solve a problem you may encounter, and describes
error codes. This chapter also describes how to perform the system recovery and
the data backup/recovery.

+ Chapter 7, “Application Library and Utilities”

This chapter introduces the application library and the utility programs.
To get the latest firmware/software/electronic manuals/support information, visit
Agilent Technologies support site (http://www.home.agilent.com), and click

Oscilloscopes, Analyzers, Meters > Parametric & Device Analyzers, Curve Tracers.
You can reach the support site for the Agilent B1500A, B1505A, and EasyEXPERT.
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NOTE

Main GUI

This chapter provides the reference information of Agilent EasyEXPERT main GUI.

“Start EasyEXPERT”
“Workspace Configurator”
“Main Screen”

“Application Test”

“Tracer Test”

“Quick Test”

“Repeat M easurement Setup”
“Organize Preset Group”
“Calibration”

“Configuration”

“Switching Matrix Operation Panel”
“Standby Channel Definition”
“Data Display”

“Preview”

“Text File Export settings’

Touch Screen Operation

If you use touch screen operation than mouse, change the font size of menu. Font
size 14 is recommended for the touch screen operation.

Open the Control Panel, select Appearance and Themes, and select Display to open
the Display Properties dialog box. Select the Appearance tab, and click the
Advanced button to open the Advanced Appearance dialog box. On the dialog box,
set Item to Menu, and set the Size of Font to 14.
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Main GUI

To start EasyEXPERT, see “ Start EasyEXPERT” on page 1-4 and “Workspace
Configurator” on page 1-5.

To perform application test setup, see “Application Test” on page 1-27.
To perform classic test setup, see “ Classic Test Definition” on page 2-1.
To perform tracer test setup, see “Tracer Test” on page 1-29.

To perform quick test setup, see “ Quick Test” on page 1-38.

To perform measurement, see “Main Screen” on page 1-10.

To display measurement data and perform dataanalysis, see“ Data Display” on page
1-61.

To perform self-test or diagnostics, see “ Configuration” on page 1-50.
To perform self-calibration, see “ Calibration” on page 1-44.

To control Agilent B2200A/B2201A/E5250A switching matrix connection, see
“Switching Matrix Operation Panel” on page 1-58.

To set the standby channels and the standby mode, see “ Standby Channel
Definition” on page 1-60.

To define your application test, see “ Application Test Definition” on page 3-1.
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Start EasyEXPERT

File menu

Option menu

Main GUI
Start EasyEXPERT

Sart EasyEXPERT

The Start EasyEXPERT window is opened after the B1500 is booted up or by using
the Start EasyEXPERT menu in the Start menu or the Start EasyEXPERT icon on
Windows desktop. Thiswindow is not opened after the boot if the automatic start
function is effective. This window provides the following graphical user interface.

€ 815004 =JoEd

File Option

Start EasyEXPERT

This button launches EasyEX PERT.

Provides the following function.
Exit Closes the Start EasyEXPERT window.

Provides the following functions.

Auto Start of EasyEXPERT Enables or disables the automatic start function. If
thislabel is checked, the function is enabled. From
the next boot or logon, the Start EasyEXPERT
window will be skipped and EasyEXPERT will be
launched. To disable this function, use the Start
EasyEXPERT window opened by the File > Exit
menu on the EasyEXPERT main screen. This
function is not effective for Desktop EasyEXPERT.

EasyEXPERT Database Provides the following functions.

» Backup EasyEXPERT Database

Opens the EasyEXPERT Database Backup Creation Wizard used to make
backup of the EasyEXPERT database. You can make backup easily by following
the wizard. Required time depends on the database size.

* Restore EasyEXPERT Database

Opens the EasyEXPERT Database Restoration Wizard used to restore the
EasyEXPERT database backup. You can restore the backup easily by following
the wizard. Required time depends on the database size.

EasyEXPERT Database is the folder used to store your test setup data and such.

1-4 Agilent EasyEXPERT User’s Guide, Edition 1



Main GUI
Workspace Configurator

Wor kspace Configurator

Workspace means the space created in the B1500 internal hard disk drive, and is
used to store the test setup, test result data, and so on. The workspace can be created
and allocated for each user.

The workspace configurator will run after you launch Agilent EasyEXPERT. The
workspace configurator displays a screen used to select the workspace you use.
There are three types of display, depending on the number of existing Workspace.

» “If thereis no workspace”
» “If thereis one workspace”

» “If there are Workspace more than two”

If thereisno workspace

EasyEXPERT will automatically create aworkspace and display the EasyEXPERT
main screen.

Fie DataDisplay Help
[ |category - T~
g |Dem | >
B |0 amos il | e |
‘a [ODsaete ) Run Option
2 | everce =1 Choose test categories from the left area, — 8| o
?n ] GenericTest ot
= | Memory Device ID: m
-g [ MixedSignal > | a J
= =
% TEEary _l My Favorite Setup~- @
& o —
o
bl
= rod
B
b g —_—
=
o
« S
T
g
@
@
% E Ja—
]
A |Flag |SetuD Name |Date |Coumt |Device I} lRemarks
»
2
< —
&
&
Initial Workspace | Mult Display OFF 3] Standoy OFF  [b0] 5L zero OFF  [[S] Auto Export OFF  [15] Auta Record ON
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Main GUI
Workspace Configurator

If thereisoneworkspace

You will seethe screen asking you if you want to create a workspace or not. Select
Yes or No for the message and click OK.

File  Help

You have used this instrument previously. Do you want to
continue warking on the previaus setups and data ?

¢ Yes, I want to continue working on the previous setups
and data.

€ No, I want to start a new session.

Note: Even if you start a new session, you can still
access setups and data from previaus sessions.

[ Work on the same setups and dala
in the next time.

« OK

This button displays the EasyEXPERT main screen using the specified
workspace.

»  Work on the same setups and data in the next time.

If this check box is checked, the workspace selection screen will be skipped at
the next startup and EasyEXPERT will be launched with the workspace used at
the last operation. To perform this setup again, click the File > Close Workspace
menu on the EasyEXPERT main screen.

* Yes, | want to continue working on the previous setups and data.

This button must be selected if you do not want to create a new workspace, and
want to use the workspace previoudy used.

The OK button will work to open the EasyEXPERT main screen.
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Main GUI
Workspace Configurator

* No, | want to start a new session.

This button must be selected if you want to create a new workspace, and want to
useit instead of the workspace previously used. If you select No, the label of the
OK button will change to Next.

The Next button will work to display the following entry fields used to set the
workspace name.

e Entry field for the name of the new workspace

« Entry field for the new name of the existing workspace
Thisfield is available only for the owner of the existing workspace.

Check the Allow other users to access this workspace box to create a public
workspace that is opened for all users.

The OK button creates and/or renames the workspace, and opens the
EasyEXPERT main screen.

The Prev button cancel s the workspace creation and returns the screen message
to the previous one.

File Help

Agilent EasyEXPERT software manages setups and data in
enclosures known as "Workspaces.* Since you want to
start a new session, you should create a new Workspace
with a distinctive name. Please specify a name for the new
wWorkspace:

[untitied =
™ Allow other users to access this Workspace.
You can also rename a previously defined Workspace:
finitial wiorkspace =
™ Allow other users to access this Workspace.
«m
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Main GUI
Workspace Configurator

If there are Workspace more than two

You will seethe screen as shown in the following example.

Fie Help

Agilent Desktop EasyEXPERT
Please choose the target Workspace below.
A Workspace is an enclosure of data and application tests. It includes test setups, test

results, graphical plots, and user-customized application tests. You have three options when
starting a session in EasyEXPERT:

1. Create a new Workspace from scratch.
2. Dpen and use an existing Workspace that you previously created. Continue »
3. Open and use a public Workspace that has been previously published.
Target Workspace ‘ J Chooss the same workspace o
in the next tine.

 Create a new Workspace

workspace Name: I 5 S

™ Allow other users to access this workspace.

Open an existing Workspace

& Your Workspaces:

MNarme |Scope | e
Initial Workspace Private Warkspaces
test Private

€ Public Workspaces awmed by other users:

Name \ Cwner

» Continue
This button displays the main screen with the specified workspace.

» Choose the same Workspace in the next time.
If this check box is checked, the workspace selection screen will be skipped at
the next startup, and EasyEXPERT will be launched with the workspace used at
the last operation. To perform this setup again, click the File > Close Workspace
menu on the EasyEXPERT main screen.

Create a new Workspace

This button must be selected if you want to create a new workspace. Enter the
name of the new workspace in the Workspace Name field.

Check the Allow other users to access this workspace box to create a public
workspace that is opened for all users.
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Main GUI
Workspace Configurator

e Open an existing Workspace

Your Workspace

This button must be selected if you want to open your workspace. Select the
name to specify the workspace to open.

» Name: Workspace name
e Scope: Private (only for owner) or Public (for all users)

The Manage Workspaces button opens Workspace Manager that allows you
to delete, rename, or make a copy of the specified workspace. Select the
workspace name and click a button.

» Delete: Deletes the selected workspace.

» Rename: Renames the selected workspace.

» Duplicate: Makes a copy of the selected workspace.

» Public: Changes the scope of the selected workspace to Public.
» Close: Closes the Workspace Manager.

Public Workspace owned by other users

This button must be selected if you want to open a public workspace created
by another user. Select the name to specify the workspace to open.

» Name: Workspace name

*  Owner: Owner of the workspace
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Main GUI
Main Screen

Main Screen

The EasyEXPERT main screen will be displayed after the workspace is specified or
created by the workspace configurator. The main screen provides several tools and
functions described in this section.

e “Main Screen GUI”

*  “Run Option”

» “DataDisplay Manager”

» “DataDisplay Properties’

* “Test Result Editor”

* “Test Results Data Filter”

*  “Exportin My Format”

* “Test Results Data Folder Export”
* “Test Results Data Auto Export”
» “Test Results Data Properties’

File DataDisplay Help
& |category - »
5 |oBeT = =
% |Domos ol
g [Doscete || Run Option
2 | O Exercie B thoose test cateqories from the left area, T 3 o]
? ] GenericTest o
& memnary Device ID: =
& |0 Miedsignal v ] [l )
% Torary v| My Favorite Setup-
i ~
B
= e
: 2
et o
g &
(=3
. L
T
i
g
-4
# =
] —
A~ |F\ag |Setup Name |Date |C0unt |Device (=] |Remarks
»
2
& —
1
3
=
Initial Workspacs | Multi Display OFF  [[cb] Standby OFF  [40] 5MU Zero OFF |51 Auto Export OFF | 2] Auto Record ON
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File menu

Data Display menu

Help menu

Application Test

Main GUI

Main Screen
Main Screen GUI
Provides the following four functions.
Import Test Setup... Opens adialog box used to specify atest setup to
import.
Export Test Setup... Opens a dialog box used to specify adestination

file for exporting the present test setup.

Save Data As... Only for the tracer test. Opensthe Save Data As...
dialog box used to specify the file name of the
measurement result data to save. Available data
formats are the CSV, XML spreadsheet, BMP,
EMF, GIF, and PNG.

Close Workspace Closesthe work space and returns to the workspace
configurator.
Exit Exits the EasyEXPERT software.

Provides the following three functions.

Show Data Display Opens “Data Display (page 1-61)" used to display
the test result data.

Manage Data Display... Opens“ Data Display Manager (page 1-19)” used to
control the appearances of the Data Display
windows.

Default Data Display

Properties... Opens “Data Display Properties (page 1-20)" used
to set the default setting of the Data Display
window.

Provides the following three functions.

About ThisInstrument... Opens the Configuration window.
About ThisTest... Opens the test description dialog box.
Agilent EasyEXPERT Help  Opensthe EasyEXPERT help window.

Thistab selects the application test mode of EasyEXPERT. For details of the
graphical user interfacein this mode, see “ Application Test” on page 1-27.
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Classic Test

Tracer Test

Quick Test

Data Display

Calibration

Configuratio

Repeat

Main GUI
Main Screen

Thistab selects the classic test mode of the EasyEXPERT. For details of the
graphical user interfacein this mode, see “ Classic Test Definition” on page 2-1.

This tab selects the tracer test mode of EasyEXPERT. For details of the graphical
user interface in this mode, see “Tracer Test” on page 1-29.

Thistab selects the quick test mode of the EasyEXPERT. For details of the graphical
user interface in this mode, see “Quick Test” on page 1-38.

Opens“Data Display (page 1-61)” used to display the test result data. EasyEXPERT
always handles the test setup corresponding to the Data Display window now active
or most recently activated.

Opens “ Calibration (page 1-44)" used to see the self-calibration results, to perform
the self-calibration, or to perform the current offset cancel.

Opens “ Configuration (page 1-50)” used to see the module configuration, to see the
self-test results, to perform self-test, to establish the GPIB connection with Agilent
B2200A/B2201A/E5250A switching matrix, or to see the event log.

Not available for the B1505A. Opens “ Switching Matrix Operation Panel (page

|| 1-58)" used to control Agilent B2200A/B2201A/E5250A switching matrix.

Opens “ Standby Channel Definition (page 1-60)” used to set the standby channel
which isthe channel to keep the specified output when the standby modeis ON and
in the non-measurement state.

Triggers asingle measurement. To abort measurement, click Stop button that
appears instead of the Single button.

Triggers the append measurement. The measurement results will be appended to the

d Data Display window that shows the previous measurement results. The Data

Display window can have maximum 10 layers for displaying measurement results.
To abort measurement, click Stop button that appears instead of the Single button.

This button provides a different function depending on the status of the data record
functions (Auto Record and Auto Export). See “Run Option (page 1-18)" for the
datarecord status.

If Auto Record and Auto Export is OFF, this button starts the repeat measurement
immediately.
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Save
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My Favorite Setup

Main GUI
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If Auto Record or Auto Export is ON, this button opens the “ Repeat M easurement
Setup (page 1-40)” dialog box for setting the repeat measurement condition.

Opensthe “Run Option (page 1-18)” dialog box for setting the data record functions
(Auto Record and Auto Export) and the Multi Display function.

This button will appear to the right side of the Run Option button if a measurement
is performed when the data record functions (Auto Record and Auto Export) are
OFF. Clicking the button will save the last measurement data as a test result record.

Displays the number of single measurements executed for the test setup now
opened. Effective for the measurements triggered by both Single and Repeat.
The 0 button sets the Count field to zero.

Thisentry field is used to enter astring in the test record. The string can data |D,
device ID, test ID, or anything you want.

Performing measurement and changing setup do not change the value in this field.
Change the value if you want.

The button saves the present test setup into the present preset group as anew test
setup of the group.

The button recalls the selected test setup. This means opening and displaying the
measurement definition of the selected test setup.

If atracer test setup isrecalled on the test mode other than the tracer test, it is
converted to and recalled as a Multi Channel 1/V Sweep test setup.

The test setups you create or modify MUST be saved to My Favorite group (preset
group) to reuse them.

Click the My Favorite Setup button to display the menu that provides the following
functions. Select the preset group by using the field below the button. The test
setups can be recalled by using the area below the field.

Cancel Closes the menu.
Preset Group Provides the following seven functions.

Add New Preset Group  Opensthe Add Preset Group dialog box. Creates a new
preset group and savesit as the specified name.
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Rename This Preset
Group Opens the Rename Preset Group dialog box. You can
change the name of the present preset group.

Duplicate This Preset

Group Opens the Duplicate Preset Group dialog box. Creates
acopy of the present preset group and savesit asthe
specified name.

Delete This Preset Group You can delete the present preset group.

Import Preset Group...  Opensthe Preset Group Import dial og box. Importsthe
specified preset group.

Export This Preset
Group... Opensthe Preset Group Export dialog box. Exportsthe
present preset group as the specified name.

Organize Preset Group... Opensthe “Organize Preset Group (page 1-42)” dialog
box used to organize the preset group.

Rename You can change the name of the selected test setup.
Duplicate Creates a copy of the selected test setup.

Delete Deletes the selected test setup.

Delete All Deletes all test setupsin the present preset group.

Shows the flag, Important (1), Valid (#), or Questionable (?) set to the record. The
top button sorts the test records by the flag.

While the “ Show Deleted Data (page 1-15)” function is enabled, the list area can
show the test records in Delete-group. For the records, * is set to the column to the
left of the Flag column. The top button sortsthe list by *.

Shows the test setup name. The top button sorts the test records by name, in
lexicographical order.

Shows the date that the test result is recorded. The top button sorts the test records
by date, in chronological order.

Shows the measurement count shown in the Count field. The top button sorts the
test records by count, in numerical order.

Shows the string set to the record by using the Device ID field. The top button sorts
the test records by device ID, in lexicographical order.
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Remarks Shows the remarks set to the record. The top button sorts the test records by the
remarks in the lexicographic order.

Auto Record OFF Thisindicator islocated at the bottom of the EasyEXPERT main screen and is lit
Z=| while the Auto Record (automatic data record) function is disabled.

Auto Export ON Thisindicator islocated at the bottom of the EasyEXPERT main screen and islit
5=IrJ while the Auto Export (automatic data export) function is enabled.

SMU Zero ON Thisindicator islocated at the bottom of the EasyEXPERT main screen and islit
K1 whilethe SMU current offset cancel function is enabled.

Standby ON Thisindicator islocated at the bottom of the EasyEXPERT main screen and islit
0 while the standby function is enabled (standby modeis ON).

Multi Display ON  Thisindicator islocated at the bottom of the EasyEXPERT main screen and is lit
E while the Multi Display function is enabled.

workspace name  Field below the Results button shows the present workspace name.

Results This button provides the following functions. Thelist area shows the test records.
The up or down arrow button is used to expand or reduce the list area.
Cancel Closes the menu.
Select All Selects all records.
Unselect All Unselects dl records.
Display Data Opensthe “Data Display (page 1-61)” and displaysthe

test result data of the selected record. Up to 15
windows can be opened by this function.

Recall Recalls the test setup of the selected record.
Filter Provides the following four functions.
Show Deleted Data Check this function to see the test records of both

Save-group and Delete-group. To set the data group,
see “Flag and Remarks’ on page 1-17. See also “ Test
Result Editor (page 1-21)".

Filter... Opensthe“ Test Results Data Filter (page 1-22)” dialog
box. You can filter the test recordsin the list area.
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Expand Application Test
Results

Show All Append Data

Transport Data

Import...

Export AsTest Result...

Export As Compressed
Test Result...

Export AsCSV...

Export AsXML Spread
Sheet...

Export in My Format...

Check thisfunction to see all test records created by the
test setups defined in an application test.

If atest record is exported when this function is not
checked, the exported file will contain all records
created by the test setups defined in an application test.
However, if the test record is exported by the Export
As Text File function, the exported file will contain
only the test record of the application test.

Check thisfunction to see all test records created by the
append measurement. In the test record list, Sindicates
the test records obtained by a single measurement, and
A indicates the records obtained by an append
measurement.

Provides the following ten functions.

Opens the Test Result Import dialog box. Imports the
specified test record.

Opens the Test Result Export dialog box. Exports the
selected test record as the specified namein the
EasyEXPERT data format.

Opens the Compressed Test Result Export dialog box.
Exports the selected test record as the specified name
in the compressed EasyEXPERT data format.

Opensthe CSV File Export dialog box. Exports the
selected test record as the specified name in the CSV
format that can be read by a spread sheet software.

Opensthe XML Style Sheet Export dialog box.
Exports the selected test record as the specified name
in the XML spread sheet format that can be read by a
spread sheet software.

Opensthe “Export in My Format (page 1-22)” dialog
box. Exports the selected test record as the specified
name in the style converted by using the specified
XSLT filter.
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Export AsText File...

Text File Export Setting...

Folder Export...

Auto Export Setting...

Edit

Flag and Remarks

Delete

Properties...

Main GUI
Main Screen

Opens the Text File Export dialog box. Exports the
selected test record as the specified namein the style
defined on the “ Text File Export settings (page 1-87)”
dialog box.

Opens the “ Text File Export settings (page 1-87)"
dialog box used to define the style of the test record
exported by the Export As Text File function.

Opensthe “ Test Results Data Folder Export (page
1-23)” dialog box used to export the selected multiple
test records to the specified folder.

Opensthe* Test Results Data Auto Export (page 1-24)”
dialog box used to set the automatic data export
function and the automatic data save function.

Provides the following two functions.

Opensthe “ Test Result Editor (page 1-21)" used to put
the selected test record in Save-group or Delete-group.
Also this dialog box can set aflag and remarksto the
selected record. The available data flags are Important
(), Valid (#), and Questionable (?).

Puts the selected test recordsin Delete-group. The
records can be displayed in the list area while the
“Show Deleted Data (page 1-15)” is checked.

Opensthe “ Test Results Data Properties (page 1-26)"
dialog box used to set the number of test records listed
inthelist areaand the number of recoverablerecordsin
Delete-group.
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Run Option

This dialog box appears by clicking the Run Option button and is used to set the data
record functions (Auto Record and Auto Export) and the Multi Display function.
This dialog box provides the following GUI.

» Record Test Result Data Automatically

This check box changes the status of the datarecord functions (Auto Record and
Auto Export). The functions provide four status shown in Table 1-1. Removing
the check sets Auto Export=Auto Record=OFF. And putting the check again
returns the status to the previous one.

In the checked status, the data record functions can be set to one of three status
except for Auto Export=Auto Record=OFF. To set the functions, use “ Test
Results Data Auto Export (page 1-24)”.

In the unchecked status (Auto Export=Auto Record=0OFF), the test result data
will not be recorded. If a measurement is performed in this status, the Save Data
button will appear to the right side of the Run Option button. Clicking the Save
Data button will save the last measurement data as a test result record.

When the automatic data record function is enabled, one test execution result is
stored in one test record. For the classic test, onetest result is stored in one test
record. For the application test, all test results taken by executing one
application test are stored in one test record. However, the automatic data export
function using the Text File type exports the file for each test result.

Table 1-1 Record Test Result Data Automatically Check Box and Data Record Functions
Checked status Unchecked status
Auto Export Auto Record Auto Export Auto Record
ON OFF OFF OFF
ON ON
OFF ON

e Allocate Data Display for each test

This check box sets the Multi Display function ON (checked) or OFF. This
function controls the operation of the Data Display window.

OFF Test result datawill be always displayed on the singular Data
Display window even if the test setup is changed.
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ON Test result data of the same test setup name will be displayed on the
exclusive Data Display window and the test result data of the
different test setup name will be displayed on the new Data Display
window.

Data Display M anager

Thisdialog box is opened by selecting the Manage Data Display... function of the
Data Display menu, and is used to control the appearances of the Data Display
windows. This dialog box provides the following three action buttons.

OK Applies the setup changes and closes this dialog box.
Cancel Cancels the setup changes and closes this dialog box.
Apply Just applies the setup changes.

This arealists the Setup Name of the Data Display windows opened. The list items
from top to bottom correspond to the windows from front to back in the screen
image. This area supports the following buttons. To select the item, click onein the
list.

Up Moves the selected item upward.

Down Moves the selected item downward.

Select All Selects all items.

Minimize Minimizes the windows corresponding to the selected items.

The list items move to the Minimized Data Displays area.

Close Closes the windows corresponding to the selected items.

This area lists the Setup Name of the Data Display windows minimized. This area
supports the following buttons. To select the item, click onein thelist.

Select All Selects all items.
Restore Restores the windows corresponding to the selected items.
Close Closes the windows corresponding to the selected items.

This area provides the following radio buttons and a check box to change the
appearances of the Data Display windows. All functions are available for the opened
windows.

Keep Setup K eeps the present configuration of the Data Display windows.
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Tiling Resize and collate the data display windows such that they fill
up the entire screen.

Sacking Resize and collate the data display windows so that they
overlap dlightly with an offset.

Overlaying Resize, overlap, and make transparent the data display windows
so that multiple graphs can be viewed and superimposed on one
another.

This check box must be checked to apply the same graph scale to all graphs.

Data Display Properties

This dialog box is opened by selecting the Default Data Display Properties...
function of the Data Display menu, and is used to set the default setting of the Data
Display window. Click the OK button to apply the setup and close this dialog box.

Thisareais used to select the area effective when the Data Display window is
opened, and provides the following check box.

X-Y Graph Check this button to enable the X-Y Graph area.

Grid ON Check this button to display the grid on the X-Y Graph.
List Display Check this button to enable the List Display area.
Parameters Check this button to enable the Parameters area.

Thisareais used to set the color map for the X-Y Graph Plot area. You can change
the color of the background, text, graph grid, and line/cursor. The color paletteis
opened by clicking the pattern of the item.

Thisareais used to set visibility, color, and thickness of the datatracesY1to Y8
plotted on the graph. The color palette is opened by clicking the pattern of the item.

Thisareais used to set the maximum number of decadesto show the minor ticks for
on the log axis. If the number of graph decadesisless than or equal to the entered
value, the minor ticks are displayed. If it is greater than the entered value, the minor
ticks are not displayed.

Thisareais used to set the font size for the graph. The available settings are Largest,
Large, Medium, Small, Smallest, and Fixed. For settings other than Fixed, the
appropriate size is automatically selected. For Fixed, afont size entry field is
provided, and the specified font sizeis always applied.
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X/Y AxisTitle Font size for the axistitle
Scale Font size for the X and Y coordinate values

Legend Font size for the graph legend

Test Result Editor

The Test Result Editor appears when measurement is completed or by clicking
Results > Edit > Flag & Remarks. Thisis used to set aflag and remarks to the
associated test record and provides the following GUI.

Divides test records into groups, Save and Delete.

Test recordsin Save-group are aways listed in the lower area of the EasyEXPERT
main screen.

Test recordsin Delete-group can be listed while Results > Filter >
Show Deleted Data is checked.

The following buttons are available. You can set one of the following flags.

e Important ! button
Sets the important flag (!) to the test record.
+ Vadid# button
Setsthe valid flag (#) to the test record.
* Questionable ? button
Sets the questionable flag (?) to the test record.

You can enter charactersinto thisfield. The characters will be recorded as the
Remarks value of the test record.

Applies the setup on the Test Result Editor, and closes this dialog box.
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Test Results Data Filter

This dialog box appears by clicking Results > Filter > Filter... and is used to specify
the test records listed in the lower area of the EasyEXPERT main screen.

Check this box to list the test records in Save-group.
Check this box to list the test records in Del ete-group.

Select or enter aflag in thisfield to list the test records with the specified flag.
Select or enter atest namein thisfield to list the test records of the specified name.
Specify the date to list the test records within the specified period.

Specify the count valuesto list the test records within the specified range.

Select or enter the device ID to list the test records of the specified device ID.
Specify the remarks value to list the test records with the specified value.

Performs filtering, and closes this dialog box.

Cancelsfiltering, and closes this dialog box.

Export in My For mat

This dialog box appears by clicking Results > Transport Data > Export in My
Format..., and is used to export the test record by performing the style conversion
using the XSLT filter.

Specify the full path name of the XSLT filter (XML style sheet) used to convert the
style of thetest record. The Browse... button opens the Select XML Style Sheet File
dialog box used to select thefile.

Opens the Export As dialog box. Specify the file name and the file type, and export
the test record.

Cancels data export, and closes this dialog box.
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Test Results Data Folder Export

This dialog box appears by clicking Results > Transport Data > Folder Export...
after the test result records are selected (highlighted).

This function is used to export the multiple test records. The test records can be
exported by specifying the records, the destination folder name, and the naming rule
and the file type for the exported files.

Selects the folder used to save the exported test records. The Browse... button opens
the Browse For Folder dialog box used to select the folder.
Specifies the style of the file name for the exported test records.

File nameis automatically generated by using Setup Name, Device ID, Count, and
Date values defined in the main screen. If an impermissible character isused in a
value, the character is automatically replaced with _ (underscore).

» Default Format: File name without extension is as follows.
Setup Name] Device ID( Count) ; Date]
Example: 1 d-Vd [cnpos1(1l) ; 1 22 2006 3_44 55 PM
» Custom Format: You can specify the style by the File Name Format dialog box.

The File Name Format dialog box appears by clicking the Settings... button. In
the dialog box, enter the desired style into the Format field, for example, the
next example sets the same style as the Default Format.

Example: {0} [{3}({2}) ; {1}]

{0}: Setup Name

{1}: Date, mm_dd_yyyy hh_mm_ss AM/PM
{2}: Count

{3}: DevicelD

Selects the file type (data format).

Test Result EasyEXPERT data format
Compressed Test Result Compressed EasyEXPERT data format
csv CSV format

XML Spread Sheet XML spread sheet format
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My Format Custom format created by the specified XSLT filter. The
following two entry fields are available.

* My Format

Specifies the file name of the XSLT filter (XML style sheet) used to export test
records. The Browse... button opens the Select XML Style Sheet File dialog box
used to select the file.

» Extension of Output File

Enters the appropriate extension, or selects the extension from xml, txt, csv, or
xls.

Text File Custom format defined in the “ Text File Export settings
(page 1-87)" dialog box. The Settings... button opensthis
dialog box.

Starts the folder export. This dialog box is closed after the folder export is
compl eted.

Cancels the folder export, and closes this dialog box.

Test Results Data Auto Export

This dialog box appears by clicking Results > Transport Data > Auto Export
Setting... and is used to set the data record functions (Auto Record and Auto
Export).

There isthe following check box at the top of this dialog box.

» Enable automatic data export to the specified storage device

Checking this box setsthe Auto Export function (automatic data export) and enables
the following GUI.

Selects the folder used to save the exported test records. The Browse... button opens
the Browse For Folder dialog box used to select the folder.

Specifies the style of the file name for the exported test records.

File nameis automatically generated by using Setup Name, Device ID, Count, and
Date values defined in the main screen. If an impermissible character isused in a
value, the character is automatically replaced with _ (underscore).
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» Default Format: File name without extension is as follows.
Setup Name[ Device ID( Count) ; Date]
Example: 1 d-Vd [cnps1(1) ; 1 22 2006 3_44 55 PM
e Custom Format: You can specify the style by the File Name Format dialog box.

The File Name Format dialog box appears by clicking the Settings... button. In
the dialog box, enter the desired style into the Format field, for example, the
next example sets the same style as the Default Format.

Example: {0} [{3}({2}) ; {1}]

{0}: Setup Name

{1}: Date, mm_dd_yyyy hh_mm_ss AM/PM
{2}: Count

{3}: DevicelD

Selects the file type (data format).

Test Result EasyEXPERT data format

Compressed Test Result Compressed EasyEXPERT data format

csv CSV format

XML Spread Sheet XML spread sheet format

My Format Custom format created by the specified XSLT filter. The

following two entry fields are available.

* My Format

Specifies the file name of the XSLT filter (XML style sheet) used to export test
records. The Browse... button opens the Select XML Style Sheet File dialog box
used to select the file.

» Extension of Output File

Enters the appropriate extension, or selects the extension from xml, txt, csv, or
xls.

Text File Custom format defined in the “ Text File Export settings
(page 1-87)" dialog box. The Settings... button opensthis
dialog box.

Agilent EasyEXPERT User’s Guide, Edition 1 1-25



Data Storage

OK

Cancel

NOTE

Test Result List
View

Non-preserved
data

Close

Main GUI
Main Screen

Remove a check from the following check box to disable the Auto Record function
(automatic data record).

» Enable automatic data record to the internal storage device
Applies the setup, and closes this dialog box.
Cancels the setup, and closes this dialog box.

Automatic Data Record Output

When the automatic data record function is enabled, one test execution result is
stored in one test record. For the classic test, one test result is stored in one test
record. For the application test, all test results taken by executing one application
test are stored in one test record. However, the automatic data export function using
the Text File type exports the file for each test result.

Test Results Data Properties

This dialog box appears by clicking Results > Properties... and is used to set the
maximum number of test records listed in the main screen and saved in the
Delete-group.

Sets the maximum number of test records listed in the main screen.

Sets the maximum number of test records saved in the Delete-group.

Closes this dialog box.
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Application Test

In the application test mode, the EasyEXPERT main screen has the following
additional graphical user interface.

Category  ~| (D] Vth gmMax Setup Name: [vth omiax = ‘
[ BIT *||Device Parameters
] cmos
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Recall

Lists the categories of the application test definitions. You can select the categories
by using the check box. The test definitions listed in the Library area depend on the
selection of the categories.

The Category button opens the Categories dialog box used to select the categories.

Thisfield just displays the test definition name of the present application test.
Clicking the left i button displays the help message for the test definition.

Lists the application test definitions that belong to the categories selected by the
Category area.

Clicking anicon displaysits brief introduction message and the Select button.
Clicking the Select button loads the application test definition. Now, the B1500 is
ready to start measurement.

The Library button provides the following six functions.
Close Closes this menu.

Define New Test... Opens the “ Test Definition Window (page 3-3)”
used to create a new application test.
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Open Definition of ThisTest...
Opens the “ Test Definition Window (page 3-3)” to
display the definition of the present (selected)
application test or to modify the definition.

Delete Definition of This Test Deletes the present (selected) application test. The
test will be deleted from the application library.

Import Test Definition... Opens adialog box used to specify the test
definition to import.

Export Test Definition... Opens a dialog box used to export the present
application test definition. The test definition will
be saved to the specified file.

Incremental search. Used to search the application test definitions listed in the
Library area.

Used to set the name of test setup. The name must be the identification for the test
setup saved to a My Favorite group (preset group). Enter a unique name that is
distinct from other setup.

The nameis stored in the test result data and is used to differentiate the recordsin
the test record list area.

This area displays the device parameter entry fields if the device parameters are
defined as the variables in the application test definition.

Enter the appropriate value to the entry fields before starting measurement.

This area displays the device connection diagram if it is specified in the application
test definition.

This area also displays the test parameter entry fieldsif the test parameters are
defined asthe variablesin the application test definition. Enter the appropriate value
to the entry fields before starting measurement. If the entry field needs to enter a
vector data, see “Define vector data’ on page 2-18.

This button opens the Extended Setup dialog box that displays the extended
parameter entry fields. See “Ext” on page 3-6 for the parameters shown in this
dialog box.

Enter the appropriate value to the entry fields and click Close button.
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Graph area

Channel area

Main GUI
Tracer Test

Tracer Test

In the tracer test mode, you can start 1/V sweep measurement easily and quickly by
setting up the I/V Trace screen only. The EasyEXPERT main screen has the
following additional graphical user interface.

@/ 1/V Trace

Setup Name: |11-\'1

LIN-SGL «

20V B

20V H

4V

101 @
Interlacing:

1B

00 ma/div

Compliance:

1A H

3 B -me
Function: =

ol -] Wi, VARL - 2us B
Step Time:
500us B

Meas. Time:

Delete

Used to set the name of test setup. The name must be the identification for the test
setup saved to a My Favorite group (preset group). Enter a unique name that is
distinct from other setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area.

This area displays measurement result graph and provides “ Graph Setup Tool” and
“Option Tool” for setting and changing the graph display.

Mouse drag operation zooms in the graph. To set the graph maximum or minimum
value directly, use the entry field displayed by clicking the value on the graph.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Add Adds arow of the channel setup by selecting aSMU listed in
the menu displayed by clicking this button.
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Delete Deletes the selected channel setup.

Up / Down Moves the selected channel setup upward or downward.

Unit SMU used for the source output or measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data

Mode Output mode. V (voltage), | (current), VPUL SE (voltage pulse),

or IPULSE (current pulse).

Function Output function, VAR1 (primary sweep), VAR2 (secondary
sweep), or CONST (constant)

To select a channel setup, use the left radio button of the channel setup. If multiple
output channels are defined, the channels start output sequentially. The order istop
to bottom of the channels defined in this screen. The output stopsin the opposite
order.

Sample setups Clicking this button displays the sample setup menu. Clicking a setup name applies
& its setup to the tracer test environment.

L 41
7]

The B1500A provides the following sample setups.

e MOSFET: ID-VDS, ID-VGS, ID(off)-VDS, BVDSS
» Diode IF-VF, IR-VR

e BJT: IC-VCE, IC-VBE, IC-VCEO, BVCEO

The B1505A provides the following sample setups.

* MOSFET: ID-VDS, ID-VGS, ID(0off)-VDS, BVDSS

+ Diode IF-VF, IR-VR

* |IGBT: IC-VCE, IC-VGE, IC(off)-VCE, BVCES

* BJT:IC-VCE, IC-VCEO, BVCEO, IC-VCBO, BVCBO

NOTE Drag the region of VAR, VAR2, and CONST
Mouse drag operation will scroll this region when it cannot display all setup
parameters.

VAR1 This area defines the primary sweep source output. All of the following parameters

are displayed for the full mode. Only Mode, Stop, NOS, and Compliance are
displayed for the short mode. Click the VARL title bar to switch the mode.
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Mode Sweep mode. The single mode sweeps from start to stop, and
the double mode sweeps from start to stop to start.
LIN-SGL Linear sweep, single mode
LOG-SGL Logarithmic sweep, single mode
LIN-DBL Linear sweep, double mode
LOG-DBL L ogarithmic sweep, double mode

Sart Sweep start value

Sop Sweep stop value

Sep Incremental step value of the sweep output. Thevalueis
automatically calculated by using the start, stop, and NOS
values.

NOS Number of sweep steps N. 1to 1001.

Interlacing Number of the interlace sweep M. 1 to 100.

VAR1 sweep measurement is repeated M times with the
measurement point change of Step/M. Number of measurement
points will be N+(N-1)x(M-1).

Compliance Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.
Measurement is performed within this value.

Pwr Comp. Power compliance value (in W), or OFF

The following parameters are also displayed for the full mode if the IPULSE or
VPULSE is set to the VAR channel.

Pulse Base Pulse base value
Pulse Delay Pulse delay time. Set O for HR/MP/HPSMU.
Pulse Width Pulse width. Must be the same value for all of HR/MP/HPSMU.

This area defines the secondary sweep source output. The VAR2 channel performs
the linear single sweep operation. All of the following parameters are displayed for
the full mode. Only Start, Stop, Step, and NOS are effective for the short mode.
Click the VAR2 title bar to switch the mode.

Sart Sweep start value
Sop Sweep stop value

Agilent EasyEXPERT User’s Guide, Edition 1 1-31



CONST

Meas. Time
Step Time

Pulse Period

Main GUI
Tracer Test

Sep Incremental step value of the sweep output. Thevalueis
automatically calculated by using the start, stop, and NOS
values.

NOS Number of sweep steps. 1 to 101.

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.
Measurement is performed within this value.

Pwr Comp. Power compliance value (in W), or OFF

The following parameters are also displayed for the full mode if the IPULSE or
VPULSE is set to the VAR2 channel.

Pulse Base Pulse base value
Pulse Delay Pulse delay time. Set O for HR/MP/HPSMU.
Pulse Width Pulse width. Must be the same value for all of HR/MP/HPSMU.

This area defines the constant output source.

Unit SMU for the constant output. If multiple CONST channels are
defined, thisfield is used to specify the channel for setup.

Source Output value.

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.
Measurement is performed within this value.

The following parameters are also displayed for the full mode if the IPULSE or
VPULSE is set to the CONST channel. Click the CONST title bar to switch the
mode. The Pulse Peak entry field appears instead of the Source entry field.

Pulse Peak Pulse peak value.

Pulse Base Pulse base value

Pulse Delay Pulse delay time. Set O for HR/MP/HPSMU.

Pulse Width Pulse width. Must be the same valuefor al of HR/MP/HPSMU.

Thisfield is used to set the measurement time for a sweep step.
Thisfield is used to set the output time for a sweep step. 500 usto 5 s, 100 us step.

Thisfield is used to set the pulse period. This entry field appears instead of the Step
Time entry field if a pulse output channel exists.
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Tracer Test

Graph Setup Tool
The graph setup tool provides the following GUI for setting the graph display.

This button is used to set the X-axis direction, |eft to right (—) or right to left («-).
This button is used to set the Y-axis direction, down to up ( T ) or up to down ().

Thisfield is used to set the X-axis/Y-axis variable nameto plot.

Variable must be V Name or | Name used for sweep output or measurement.

This button is used to set the X-axig/Y-axis scale, linear (LIN) or logarithm (LOG).

This button is used to set the X-axig/Y-axis polarity, plus (+) only, minus (- ) only,
or both plus and minus (). Both plus and minus (+) is available only for the linear
scale.

Option Tool
The following tool is available for changing the graph display.

This button is used to set the trace style, line or dot.

This button is available for the graph zoomed in, and is used to return the graph
scale to the original setting. The graph can be zoomed in by the point and drag
operation.

This button is used to set the abnormal region on the graph, and shows the present
status of the abnormal region setup by using the button’s signal color. While the
abnormal region is effective, the measurement is automatically stopped if the
measurement datais in the region.

Green Abnormal region has not been defined. Clicking this button changesthe
button’s signal color to Yellow.

Yellow Status for defining the abnormal region. Clicking this button changes
the button’s signal color to Green.
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The abnormal region can be defined by the point and drag operation. It
will be the square specified by the red grids. After defining the region,
this button’s signal color is changed to Red.

Red Abnormal region is effective. Clicking this button changes the button’s

signal color to Green.

This button opens/closes the dialog box used for managing the record and replay of
traces. For the dialog box, see “ Replay traces’” on page 1-35.

This button is used to capture the trace as the reference trace. Clicking this button
captures one reference trace. Up to 10 traces can be captured. To manage reference
traces, click the reference trace button.

This button opens/closes the dialog box used for managing reference traces
memorized by clicking the Capture button. For the dialog box, see“ Select reference
traces’ on page 1-36.

This button opens/closes the dialog box used for managing tracking traces. For the
dialog box, see* Select tracking traces” on page 1-37. Tracking trace meansthe trace
which contains at least two measurement results by the append measurement.

This button enables/disables the marker which can be moved on the active trace by
using rotary knob or mouse. The marker position X and Y coordinate values are
displayed in the upper left of the graph.

This button enables the marker and enables/disables the tangent line for the marker
point. The line X-axis intercept, Y-axis intercept, and gradient values are displayed
in the upper right of the graph. The tangent line disables the regression line.

This button enables the marker and enables/disables the line which is given by the
regression calculation. The line X-axisintercept, Y-axisintercept, and gradient
values are displayed in the upper right of the graph. The regression line disables the
tangent line. The measurement data for the regression calculation can be specified
by the point and drag operation.

This button opens/closes the dialog box used for changing the graph color and trace
thickness. For the dialog box, see “Color and thickness’ on page 1-37.
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Replay traces

Thisdialog box isopened/closed by clicking the Replay traces button and is used for
managing the record and replay of traces.

X,

e OQ

HEM

Replay Interval:

1/1

100ms B

Maximum Records:
100 B

Recording Interval:
0s B

This button enabl es/disables the automatic trace record function. While this button

E on labels ON, thisfunction is enabled and continues recording the measurement trace.

Open

Save

Slide bar

B

<< (fast back)

< (step back)

> (step forward)

>> (fast forward)

Replay Interval

This button opens the Open Trace Record dialog box which is used to open a

3 recorded-trace saved by using the Save Trace Record dialog box.

This button opens the Save Trace Record dialog box which is used to save the
recorded-trace selected on this dialog box. The trace datais saved in the
EasyEXPERT Compressed Trace Record format (.gtr).

The slide bar is used to specify the recorded-trace to display. The trace is specified
1 by N/M put on the space right next to the slide bar. N is the record number assigned
to the recorded-trace now on graph and M is the total nhumber of the recorded-traces.

Clicking this button changes the displayed recorded-trace to the trace N- 1.

[« Long-click makes this operation fast.

Clicking this button changes the displayed recorded-trace to the trace N- 1.

Clicking this button changes the displayed recorded-trace to the trace N+1.

Clicking this button changes the displayed recorded-trace to the trace N+1.
[» Long-click makes this operation fast.

Thisfield isused to set the time interval of the fast back and fast forward operation.
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Thisfield isused to set the maximum record count. After the record number reaches
this value, the record numbers are shifted to the newer side and the oldest record is
deleted. This number is always assigned to the last record.

Thisfield is used to set the timeinterval of the automatic trace record operation.

Select referencetraces

This dialog box is opened/closed by clicking the Select reference traces button and
is used for managing the reference traces memorized by clicking the Capture button.

X,

TR | —
HIBER OE
i Trace
i vi-in

This button enables/disables the graph display of the trace selected/highlighted on
this dialog box.

This button enables/disables the inversion of the trace selected/highlighted on this
dialog box.

This button deletes the trace selected/highlighted on this dialog box.

This button opens the Open Reference Trace dialog box which is used to open a
reference trace saved by using the Save Reference Trace dialog box.

This button opens the Save Reference Trace dialog box which is used to save the
reference trace selected/highlighted on this dialog box. The trace datais saved in the
XML spreadsheet format (.xml).

This field shows the time stamp of the reference trace.

Thisfield showsthe title of the reference trace. Thetitle is same asthe title appears
top of the graph frame.
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Select tracking traces

Thisdialog box is opened/closed by clicking the Select tracking traces button and is
used for managing the tracking traces.

This button deletes the trace selected/highlighted on this dialog box.

This field shows the time stamp of the tracking trace.

This field shows the title of the tracking trace. The title is same as the title appears
top of the graph frame.

e .. e . -
r%t Apply | Reset
L= gl :

Time Trace Background - Marker

BI26/2009 5:37:06 P vi-1

3/26/2009 5:27:02 PM Vi-T1 Text Line

Bxis Working Trace e

Grid - Tracking Trace
Frame - Reference Trace

Color and thickness

This dialog box is opened/closed by clicking the Color and thickness button and is
used for changing color of the graph color and the trace thickness.

The graph elements supported by this dialog box are background, text, X and Y
axes, graph grid, frame around graph, marker, line, and traces.

Clicking the color pattern opens the color palette for selecting color. The color
palette provides the function to add the custom colors.

This button applies the setup change made on this dialog box to the graph.

This button applies the initial setting to this dialog box and the graph.

Agilent EasyEXPERT User’s Guide, Edition 1 1-37



My Favorite Setup

Preset Group

Setup Name

Main GUI
Quick Test

Quick Test

In the quick test mode, you can execute the test setups saved in a preset group (My
Favorite Setup) sequentially. The EasyEXPERT main screen has the following
additional graphical user interface.

The following menu is displayed by clicking this button.

Cancel Closes this menu.

Duplicate This
Preset Group Opensthe Duplicate Preset Group dialog box. Creates a copy of
the present preset group and savesit as the specified name.

Import Preset

Group... Opens the Preset Group Import dialog box. Imports the
specified preset group.
If the preset group contains atracer test setup, it is converted to
and recalled as aMulti Channel 1/V Sweep test setup.

Export Preset

Group... Opens the Preset Group Export dialog box. Exports the present

preset group as the specified name.
Organize Preset
Group Opens the Organize Preset Group dialog box used to organize
the preset group. See “Organize Preset Group” on page 1-42.
Selects the preset group to open.
If the preset group contains a tracer test setup, it is converted to and recalled asa
Multi Channel 1/V Sweep test setup.
Lists all test setups saved in the preset group.

To select the test setup for the quick test setup operation, click the line. For multiple
selection, use ctrl-click, shift-click, or Select All.

When you are doing the quick test setup, the softkeys are available to start the
associated test. The softkey label will show the Setup Name.
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The following buttons are available for the quick test setup operation.

Select All

Execution on/off

Data save on/off

Up
Down

Recall

Rename

Duplicate

Delete

Selects all test setup in the test setup list.

The [ button is effective for the selected test setup and is used
to enable/disable execution of the tests. Once the quick test is
started, only the tests marked with [ will be executed in order
from top to bottom of the test setup list.

The & button is effective for the selected test setup and is used
to enable/disable data save of the tests. The data save will be
performed only for the tests marked with .

Moves the selected test setup upward
Moves the selected test setup downward.

Recalls the selected test setup. The screen is changed to
Application Test or Classic Test.

You can change the name of the selected test setup.

Creates a copy of the selected test setup and placesit at the
bottom of the test setup list.

You can delete the selected test setup.
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Repeat M easurement Setup

Thisdialog box is opened by clicking the Repeat button, and is used to set the repeat
measurement condition. This dialog box supports the following action buttons.

Run Starts measurement.

Abort Aborts the measurement.

Cancel Cancels performing the repeat measurement and closes this
dialog box.

The repeat measurement is performed as shown in Figure 1-1. The repeat
measurement operation is controlled by the value of Count and status. Where, Count
is the number displayed in the Count field of the main screen, and status must be a
parameter of the response created by Start Procedure and Iteration Procedure. For
the response, see Figure 1-2.

Repeat M easurement Execution Flow

Count=0

Repeat Measurement Setup

Repeat Procedures

| | Start Procedure | |

Start Procedure:

E‘ Browse...
Arguments: =
Iteration Procedure:
EJ Browse...
Arguments: E
Final Procedure: | .
Test Execution |
ﬂ Browse... I
Al its: )
A H | Count=Count+1 |
v Automatically fill in Device ID I
Repeat Stop Condition | » | | Iteration Procedure | |
n
Stop repeating by:

[17 Counter reaching to: {5 E] | Abort I
Yes [———

[W Procedure return condition ] Cincet
L | | Final Procedure | |

If Abort is clicked | P

End

status limit

Thisareais used to specify the procedure to be called while the repeat measurement
is performed. The procedure must be the execution file (.exefile). If no procedureis
needed, empty the field. The Browse button opens a file browser.
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Sart Procedure  Specifies the procedure executed before starting measurement.

Iteration
Procedure Specifies the procedure executed every single measurement.

Final Procedure Specifies the procedure executed after the repeat measurement.
If the procedure requires arguments, enter the values to the Arguments field.

If the procedure specified by Start Procedure or Iteration Procedure creates the
response as shown in Figure 1-2, EasyEXPERT performs the operation following
the response. See Figure 1-1. The parameter status value must be the string True or
False, and the parameter device_id value should be any string. EasyEXPERT
ignores the response of the different format.

This check box is available when the Procedure return condition box has been
checked, and is used to enable the device ID automatic input function. Thisfunction
enters the Device ID of the test record automatically. The value is given by
device_id which is a parameter of the response created by Start Procedure and
Iteration Procedure.

Thisareais used to set the repeat measurement stop condition. The following stop
conditions are available.

» Counter Reaching to: limit
The repeat measurement will be stopped if Count > limit.
*  Procedure return condition

The repeat measurement will be stopped if the response shows status = True.

Procedure Response Expected by EasyEXPERT

» Response (input to EasyEXPERT):
XML format data

<Response>
<Break>status</Break>
<Target>device_id</Target>

</Response>
status: True (break) or False
device_id: Device ID
» Example: <Response>

<Break>False</Break>
<Target>waf1a:3 1</Target>
</Response>
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Organize Preset Group

This dialog box is opened by selecting the Organize Preset Group function of the
main screen, the Quick Test setup screen, or the Switching Matrix Operation Panel,
and is used to organize the preset group.

Lists the preset group saved in the workspace. The following buttons are available.

Add Opens the Add Preset Group dialog box. Creates a new preset
group and saves it as the specified name.

Rename Opens the Rename Preset Group dialog box. You can change
the name of the selected preset group.

Duplicate Opensthe Duplicate Preset Group dialog box. Creates a copy of
the selected preset group and saves it as the specified name.

Delete You can delete the selected preset group.

Import Only for the quick test setup. Opens the Preset Group Import
dialog box. Imports the specified preset group.

Export Only for the quick test setup. Opens the Preset Group Export
dialog box. Exports the selected preset group as the specified
name.

Sets the operation of the >> button and the << button. They work as Copy when this
box is checked, and as Move when this box is unchecked.

Copies or moves the preset setup selected in the left Preset Group box to the right
Preset Group box.

Copies or moves the preset setup selected in the right Preset Group box to the | eft
Preset Group box.

Closes the Organize Preset Group dialog box.
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Preset Group Lists the preset setup saved in the preset group. The following buttons are available.
Preset Group Selects the preset group to open.

Setup Name Lists all preset setup saved in the preset group.

Select All Selects all preset setup.

Unselect All Unselects all preset setup.

Rename You can change the name of the selected preset setup.

Duplicate Creates a copy of the selected preset setup and placesit at the
bottom of the test setup list.

Delete You can delete the selected preset setup.
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Abort
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Calibration

The Calibration window is opened by clicking the Calibration button, and is used to
perform the self-calibration, SMU current offset cancel, CMU data correction, and
SO on.

*  “Module Self Calibration”
e “SMU Zero Cancel”
« “CMU Cdlibration”

M odule Self Calibration

The Module Self Calibration tab screen is used to perform the self-calibration of
modules. Check the left check box of Name to select the module for self-calibration.
Open the measurement terminals at the cable end before performing the
self-calibration.

Displays the following values.

Name Name of module.

Full Range Full range calibration On or Off. Only for HRSMU+ASU.
Satus Calibration status. Pass or fail.

Notes Error information when calibration failed.

Selects all modules for calibration. This checks the check box for all modules.
Unselects all modules. This unchecks the check box for all modules.

Starts calibration for the selected modules.

Aborts calibration.

Only for the B1500A. Check this box to enable the 1 pA range calibration of
HRSMU+ASU.

If you do not use the 1 pA range, uncheck this box. The B1500A does not perform
the 1 pA range offset data measurement and calibration.
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Enables or disables the auto-calibration capability. If this box has been checked
(function ON), and the B1500 automatically starts calibration for all modules every
30 minutes if the output switches of all modules are off for 30 minutes. If
auto-calibration is enabled, do not forget to open the measurement terminals or
disconnect the device under test from the terminal's after measurement.

SMU Zero Cancel

The SMU Zero Cancel tab screen is used to perform the SMU path offset current
measurement, and set the offset cancel function. Check the left check box of Name
to select the effective module. Open the measurement terminals at the cable end
before performing the offset measurement.

See also “Current Offset Cancel” on page 4-43.

Displays the following values.

Name Name of module
Full Range HRSMU+ASU full range measurement On or Off.
InA Offset current measurement datain the 1 nA range. Not

available for HCSMU.

100pA Offset current measurement datain the 100 pA range. Available
for HRSMU+ASU and HRSMU.

10pA Offset current measurement datain the 10 pA range. Available
for HRSMU+ASU and HRSMU.

1pA Offset current measurement datain the 1 pA range. Available
for HRSMU+ASU only.

Enables (On) or disables (Off) the 1 pA range of HRSMU+ASU.

Sets the integration time for the SMU path offset current measurement. 1 PLC
(power line cycle) to 100 PLC, initial setting 16 PLC.

Selects al modules. This checks the check box for all modules.
Unselects all modules. This unchecks the check box for all modules.

Performs the SMU path offset current measurement for the effective modules.
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CMU Calibration

The CMU calibration tab screen is used to perform the measurement data correction
of the multi frequency capacitance measurement unit (MFCMU). For the easy way,
perform the phase compensation and the open correction at least.

See also “Error Correction” on page 4-25.

For a more accurate measurement, perform correction data measurement at the
measurement frequency before starting the capacitance measurement.

If the measurement frequency is not included in the list of default frequencies
below, click the Advanced Options... button and set the measurement frequency on
the Frequency area of the Advanced Options for CMU Calibration window.

Default frequencies:

1k, 2k, 5k, 10k, 20k, 50k, 100k, 200k, 500k, 1 M, 1.2 M, 1.5M,2 M, 25 M,
27M,3M,32M,35M,3.7M,4M,42M,45M, 5MHz

Opens adialog box used to perform correction/compensation data measurement. To
perform the measurement, follow the dialog box.

The correction/compensation measurement data is saved and managed by the
workspace. And the last measured correction/compensation data will be loaded
when the workspace will be opened next time.

Opensthe “ Advanced Optionsfor CMU Calibration (page 1-48)” dialog box used to
set the frequencies for the correction data measurement and the reference values of
the working standard.

This check box is effective after the phase compensation data is measured, and is
used to enable or disable the phase compensation. Uncheck this box to disable the
phase compensation.

To measure the compensation data, open the measurement terminals at the end of
the device side and click the Measure... button.

If you extend the measurement cables to the device end by using the four terminal
pairs method, do not forget to connect following terminal s together at the device
end.

» thehigh potentia (Hp) terminal and the high current (Hc) terminal

» thelow potential (Lp) terminal and the low current (Lc) terminal
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This check box is effective after the open correction datais measured, and is used to
enable or disable the open correction. Uncheck this box to disable the correction.

To measure the correction data, connect the open standard that has the calibration
value or reference value, or open the measurement terminals at the end of the device
side. Then, click the Measure... button.

If you extend the measurement cables to the device end by using the four terminal
pairs method, do not forget to connect following terminal s together at the device
end.

» thehigh potential (Hp) terminal and the high current (Hc) terminal
» thelow potential (Lp) terminal and the low current (Lc) terminal

If the standard is used, click the Advanced Options... button and enter the reference
value to the OPEN Reference entry fields. If you do not use the standard, enter O to
thefields.

This check box is effective after the short correction datais measured, and is used to
enable or disable the short correction. Uncheck this box to disable the correction.

To measure the correction data, connect the short standard that has the calibration
value or reference value, or directly connect the measurement terminals at the end of
the device side. Then, click the Measure... button.

If the standard is used, click the Advanced Options... button and enter the reference
value to the SHORT Reference entry fields. If you do not use the standard, enter 0 to
thefields.

This check box is effective after the load correction datais measured, and is used to
enable or disable the load correction. Uncheck this box to disable the correction.

To measure the correction data, connect the load standard that has the calibration
value or reference value. Then, click the Measure... button.

Before performing the load correction data measurement, click the Advanced
Options... button and enter the reference value to the LOAD Reference entry fields.
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Advanced Optionsfor CMU Calibration

Thisdialog box is opened by clicking the Advanced Options... button, and is used to
set the information required to measure the open/short/load correction data and the
phase compensation data. This dialog box provides the following action button.

OK Applies the setup changes and closes this dialog box.
Cancel Cancel the setup changes and closes this dialog box.

You can select one of the following radio buttons to select the measurement
frequency setup mode.

» Usefactory specified frequencies (Default)

Usually, select this mode. 23 points are automatically set. They are 1k, 2k, 5k,
10k, 20k, 50k, 100k, 200k, 500k, 1 M, 1.2M,1.5M,2M,25M,2.7M, 3 M,
32M,35M,3.7M,4M,42M,45M, and5 MHz.

e Specify list of calibration frequencies

Select this mode when you want to set the frequencies independently. The
frequency must be 1 kHz to 5 MHz. The number of frequencies must be 1 to
101.

Click Add to open adialog box, and enter the value.
For the unnecessary value, select the value and click Delete.
e Specify frequencies by range
Select this mode when you want to set the frequencies sequentially and
automatically.

Specify the start frequency, the stop frequency, the number of steps, and the
scale LINEAR/LOG. The start frequency must be less than the Stop value and at
least 1 kHz. The stop frequency must be more than the Start value and no more
than 5 MHz. The number of steps must be 2 to 1001.

If the device measurement frequency is not equal to the correction data
measurement frequency, calculation will be performed automatically to get the
correction data for the device measurement frequency, and the cal culated correction
datawill be used for the data correction of the measurement data.
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Integration Time This area defines the integration time used for measuring phase compensation data
or open/short/load correction data. The number of averaging samples
(Mode=AUTO) or the averaging time (Mode=PLC) is set.

Mode A/D converter operation mode, AUTO or PLC
Factor Factor for the initial value. See “Mode, Factor” on page 4-20.
Reference Thefollowing entry fields are availabl e to set the calibration values or the reference

Standard Values  values of the open/short/load standard. If you use the standard, enter the values to
the following entry fields.

» OPEN Reference: Capacitance and Conductance

If you do not use the reference, enter O in the both fields.
* SHORT Reference: Inductance and Resistance

If you do not use the reference, enter O in the both fields.

* LOAD Reference: Inductance and Resistance
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Configuration

The Configuration window is opened by clicking the Configuration button, and is
used to display the system information and event log, as well asto perform
diagnostics and self-test.

* “Main Frame’

e “Modules’

e “ASU”

* “Switching Matrix”

e “SMU/PG Selector”

*  “Module Selector”

e “SMU Output Setting Limits’
* “Event Log”

Main Frame

The Main Frame tab screen is used to display the system information and perform
diagnostics.

Displaysthe instrument ID. B1500A or B1505A.

Sets the power line frequency, 50 Hz or 60 Hz.
Displays the revision number of the EasyEXPERT.
Displays the revision number of the B1500 firmware.
Displaysthe host id of the B1500 internal computer.

This arealists Item and Status.
Item Name of diagnostics item. To select, check the left check box.

Satus Diagnostics status. Pass or fail.

Selects all items for diagnostics. This checks the box for all items.
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Abort
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Main GUI
Configuration

Unselects all items. This unchecks the box for al items.

Starts diagnostics for the selected items. To perform diagnostics, specify the items
to perform and click this button. A dialog box appears. Follow the dialog box to
perform the diagnostics. Some items need your judgement, pass or fail. Also you
will need to connect an adapter, press keys, check LEDs, and so on.

Modules
The Modules tab screen is used to perform self-test of modules.

This arealists Slot, Module Type, Name, and Status.

Slot Slot number where the module is installed. To select, check the
|eft check box.

Module Type Module model number

Name Module name

Satus Self-test status, Passed, Failed, Recovered, or - - - - (self-test
has not been performed)

SCuuU Specifiesif the module is connected to the SCUU.

Notes Error information when the modul e self-test failed.

Selects al modules for self-test. This checks the check box for all modules.
Unselects all modules. This unchecks the box for all modules.
Starts self-test for the selected modules.

This button isfor service use only. Makes the failed modules respond again. This
button does not solve the problem that causes the Failed status.

Aborts self-test.

Enables (ON) or disables (OFF) the status indicator (LED) of the ASU (Atto Sense
and Switch Unit), the SCUU (SMU CMU Unify Unit), and the module selector.
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ASU

Only for the B1500A. The ASU tab screenis availableif the B1500A installsthe
HRSMU calibrated with the ASU (Atto Sense/Switch Unit) regardless of the ASU
connection status, and shows the ASU information.

Slot number

Type of module

Name of module

Seria number of the usable ASU. This cell showsthe serial number even if the ASU

is disconnected.

If anincorrect ASU is connected to the HRSMU, this cell displays an error message
instead of the serial number. Error message is also displayed if an ASU is connected
to the HRSMU which is not available for using ASU.

ASU input to output connection, SMU or AUX

If thisfield is set to SMU, the ASU makes the path from the ASU Force input to the
ASU output.

If thisfield is set to AUX, the ASU performs automatic switching in every test. The
ASU normally makes the path from the AUX In input to the ASU output and makes
the path from the ASU Force input to the ASU output for the test with the HRSMU.

Switching Matrix

Not available for the B1505A. The Switching Matrix tab screen is used to confirm
the GPIB connection with Agilent B2200A/B2201A/E5250A switching matrix, and
defines the connections between the measurement units and the switching matrix
input ports.

Displays the type of the switching matrix. One of the following.
» B2200A Femto Leakage Switch Mainframe (standard)

» B2201A 14ch Low Leakage Switch Mainframe (standard)

» EB250A Low Leakage Switch Mainframe (option)

» No Switching Matrix (if switching matrix isnot connected)

Specifies the GPIB address of the switching matrix. 1 to 30.
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Confirmsiif the switching matrix with the specified GPIB Addressis connected to
the B1500A.

This button starts the selftest of the switching matrix.
SWM INn means the switching matrix input port n. where, nisan integer 1 to 10 for

the E5250A or an integer 1 to 14 for the B2200A/B2201A.

Enter the label used to specify the input port to the right entry field. The port name
and the connected module name can be the label. Or select one from the pull-down
menu. There must be no colon (:) in the label.

If the Kelvin check box is checked, the coupled even number port is grayed out.
If the CMU check box is checked, the SWM IN10 for the E5250A or the SWM
IN14 for the B2200A/B2201A is grayed out.

Check this box if this port is used for the Kelvin connection. Connect the switching
matrix inputs to the SMU as follows.

» for the E5250A (m: integer 1to 3)
SMU INPUT 2m- 1 to the SMU Force terminal
SMU INPUT 2mto the SMU Sense terminal
» for B2200A/B2201A (m: integer 1 to 6)
Input 2m- 1 to the SMU Force terminal
Input 2mto the SMU Sense terminal

Check this check box if this port is connected to the CMU. Connect the switching
matrix inputs to the CMU as follows.

+ for the E5250A
AUX INPUT CV1 to the CMU Hpot/Hcur terminals
AUX INPUT CV2to the CMU Lpot/Lcur terminals
+ for B2200A/B2201A
Input 13 to the CMU Hpot/Hcur terminals
Input 14 to the CMU Lpot/Lcur terminals

To obtain accurate capacitance measurement result, perform capacitance
compensation. See Agilent B1500A User’s Guide for the capacitance compensation
when the switching matrix is used.
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Also see “Extended Configuration” on page 1-56.

This button opens the “ Extended Configuration” on page 1-56 dialog box.

SMU/PG Selector

Not available for the B1505A. The SMU/PG Selector tab screen is used to specify
the input connection and the channel connection status of the Agilent 16440A
SMU/PG selector. The selector can be controlled by the B1500A viathe Digital 1/0
connector and the Agilent 16445A selector adapter.

Two selectors can be used. The first selector must be connected to the Digital 1/0
connector viathe 16445A. And if the second selector is used, it must be connected
to the first selector’s Control Output connector. See “ SMU/PG Selector” on page
4-49.

To use the selector, connect the selector to the B1500A, and check this check box.

CH1 and CH2 indicates the channels 1 and 2 of the first selector respectively.
CH3 and CH4 indicates the channels 1 and 2 of the second selector respectively.

Specifies the SMU connected to the SMU input of the selector channel CH1, CH2,
CH3, or CHA4.

Specifies the connection status of the selector channel CH1, CH2, CH3, or CH4.

If thisfield is set to Always SMU, the selector makes the path from Input SMU to
Output.

If thisfield is set to Normally PGU (AUX), the selector performs automatic
switching in every test. The selector normally makes the path from Input PGU to
Output and makes the path from Input SMU to Output only for the test which uses
the SMU connected to the Input SMU terminal.

The CH1 and CH3 also provides the PGU Open status which is set by using the
Advanced window of the Measurement Setup.

M odule Selector

Only for the B1505A. Thistab screen is used to specify the input connection and the
default input-output path of the module selector. The selector can be controlled by
the B1505A viathe Digital 1/0O connector.
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This check box is used to enabl e/disable the modul e selector. If this box is checked,
the modul e sel ector can be used.

Specifies the modul es connected to the modul e selector’s HVSMU, HCSMU, and
HPSMU input ports respectively. For the port which no module is connected, blank
the entry field.

The Enable Series Resistor (100 kohm) for HVSMU check box must be checked if
you want to insert the series resistor to the HY SMU path.

The Default field is used to specify the module connected to the module sel ector
output port in the idle state. When a measurement is performed, the module
specified by the test setup is automatically connected.

Shows one of the following status.
Not Detected Module selector has not been detected yet.
Communication Established  Normal status. Module selector can be used.

Once the modul e selector was detected. However
the communication has been broken now.

Communication L ost

This check box is used to enabl e/disable the modul e sel ector automatic detection. If
this box is checked, the automatic detection of the module selector is performed
when EasyEXPERT islaunched.

The Start Diagnosis button is used to start the module selector diagnosis. And the
Status shows the diagnosis result.

This button applies the setting.

SMU Output Setting Limits

Only for the B1505A.. This screen is used to set the upper limit of the SMU output
value and compliance value.

Sets the upper limit of the voltage output value and compliance value.
Effective value: 200 V to 3000 V, in 100 V step.

Sets the upper limit of the current output value and compliance value.
Effectivevalue: 1At0 20 A, in 1 A step.

This button applies the setting.
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Event Log
The event log tab screen displays the event log.

Displays date and time of the event.
Event message

Process ID of the event

Process name

User name. Windows login name.
Host name of the B1500

Refreshes the event log.

Extended Configuration

Not available for the B1505A. This dialog box opens by clicking the Extended
Configuration button in the Configuration window’s Switching Matrix screen and
closes by clicking the Close button.

Switching matrix hardware configuration can be saved as the hardware profile.
Save Saves the present hardware profile.

The hardware profile can be made for each workspace individually.

Sel ects the compensation mode of the capacitance measurement using the switching
matrix. Click one of the radio buttons, No Compensation, Select, and User

Compensation Data File. See Agilent B1500A User’s Guide for the capacitance
compensation when the switching matrix is used.

» No Compensation

Select thisradio button if you do not need the capacitance compensation. The
raw data without compensation is displayed and saved.

» B2200A/B2201A (standard)
The following setup is available for the B2200A/B2201A hardware profile.

*  Sdlect
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Select thisradio button to perform the capacitance compensation for the path
from the B2200A/B2201A input ports to Agilent 16495F/G connector plate
or Agilent B2220A probe card interface. The data after compensation is
displayed and saved.

DUT I/F Specifies the model number of the path you use. The
selections are the 16495F/G and B2220A.
Cable Specifies the model number of the cable from the

B2200A/ B2201A output to the DUT I/F. The selections
are the 16494A/B/C-001 (1.5 m) / 002 (3 m) / 005 (4 m).

This mode cannot perform the capacitance compensation for the cables to
positioner/manipulator or the probe card.

User Compensation Data File

Select thisradio button and specify the compensation datafile to perform the
capacitance compensation for the path from the B2200A/B2201A input
ports to the end of positioner/manipulator/probe card. See Agilent B1500A
User’s Guide for creating the compensation datafile. The data after
compensation is displayed and saved.

» EB250A (option)
The following setup is available for the E5250A hardware profile.

User Compensation Data File

Select thisradio button and specify the compensation datafileto perform the
capacitance compensation for the path from the E5250A input ports to the
end of positioner/manipulator/probe card. See Agilent B1500A User’s
Guidefor creating the compensation datafile. The data after compensationis
displayed and saved.

Clear Clearsthe User Compensation Data Filefield.

Triaxial Cable Enter the length of the 16494A triaxial cable
connected between the E5250A outputsto the
connector plate.

User Triaxial Cable Enter the length of the triaxial cable between
the connector plate and the DUT. Enter O if
thetriaxial cableisnot used.

User Coaxial Cable Enter the length of the coaxial cable between
the connector plate and the DUT. Enter O if
the coaxial cableis not used.
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Switching Matrix Operation Panel

Not available for the B1505A. The Switching Matrix Operation Panel is opened by
clicking the Switching Matrix button, and is used to create the switch setup for
Agilent B2200A/B2201A/E5250A switching matrix, send the setup to the switching
matrix, and so on. The switch setup can be saved to the switch setup preset group.
This group is different from the preset group for test setups.

This areais used to create the switching matrix switch setup. You can create the
setup by clicking the Input-Output cross point. The switch setup can be sent to the
switching matrix by clicking the Apply Switch Setup button.

Color of cross point Switch setup
green close
gray open
Setup Name Name of switch setup
Clear All Setsdll cross point open.
Input Shows the switching matrix input port and the measurement

resource connected to it. Thisinformation is set in the
“Configuration”.

L abel Shows the label set to the measurement resource. The labdl is
set in the application test definition or the classic test setup.

ALL Checking this box sets al of thisline to close.
Unchecking this box sets all of thisline to open.

Thisbox isgray and have acheck when acrosspoint in thisline
is set to close.

Output Output channels 1 to 12, 24, 36, or 48. Available numbers
depend on the number of the matrix cardsinstalled in the
switching matrix. Thefield below the channel number isused to
enter the label for the output channel.

This button converts the switch setup to the switching matrix setup dataformat of
the classic test, and savesit to the present My Favorite Setup group.
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This button sends the switch setup to the switching matrix.

This button reads the switch setup from the switching matrix.
This button opens all relays on the switching matrix.

The switch setups you create MUST be saved to the preset group to reuse them.

Click the Preset List button to display the menu that provides the following
functions. Select the preset group by using the field below the button. The switch
setups can be recalled by using the area below the field.

Cancel Closes the menu.
Preset Group Provides the following three functions.

Add New Preset Group  Opensthe Add Preset Group dialog box. Creates anew
preset group and saves it as the specified name.

Rename This Preset
Group Opens the Rename Preset Group dialog box. You can
change the name of the selected preset group.

Duplicate This Preset

Group Opens the Duplicate Preset Group dialog box. Creates
acopy of the present preset group and savesit asthe
specified name.

Delete ThisPreset Group You can delete the selected preset group.

Organize Preset Group... Opensthe Organize Preset Group dialog box used to
organize the preset group. See “Organize Preset
Group” on page 1-42.

Rename You can change the name of the selected switch setup.
Duplicate Creates a copy of the selected switch setup.

Delete Deletes the selected switch setup.

Delete All Deletes al switch setupsin the present preset group.

The button saves the present switch setup into the present preset group as a new
setup of the group.

The button recalls the selected switch setup. This means opening and displaying the
definition of the selected switch setup.
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Sandby Channel Definition

The Standby Channel Definition window is opened by clicking the Standby button,
and is used to define the standby channels and set the standby mode. See “ Standby
Function” on page 4-38.

The standby channel is the channel for maintaining specified output when the
standby mode is ON and in the non-measurement state. The standby channels will
be in the standby state, while the other channelswill bein theidle state whichisOV
output and 100 pA compliance. When the standby mode is OFF and in the
non-measurement state, all channelswill bein theidle state.

Standby Channel  Thisarea provides the following button.

Control
Sandby ON/OFF Sets the standby mode ON or OFF.

Standby Channel  This area defines the standby channels. The standby channels will start to output in

Definition order, from the top to bottom, as listed in this area. The order of bias stop is bottom
to top.
Sandby Check the check box to specify the standby channel.

Theradio button is used to select the channel setup availablefor
the Up/Down button.

Unit SMU (Source Monitor Unit) used for the standby output

Standby channel cannot be set for the HRSMU connected to the
ASU (Atto Sense and Switch Unit) which makes the path to the

AUX port.

Mode Output mode, V (voltage) or | (current)

Source Standby channel output value, inV or A

Compliance Compliance value, in A or V. Enter the current limit value for
the voltage source, or the voltage limit value for the current
source.

Up Moves the selected channel setup upward. To select a channel

setup, use the radio button on the left.

Down Moves the selected channel setup downward.
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Data Display

The Data Display window is opened by clicking the Data Display button, and is
used to display measurement data and analyze the data.

e “DataDisplay GUI”

» “Display Setup”

» “Graph Properties’

o “List Display Properties’
* “Tool Bar”

e “Data Status’

» “Miscellaneous Operations’
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About Display Mode

The Data Display window provides two display mode Overwrite and Append.

In Overwrite mode, the “ Display Data (page 1-15)” function opens a new Data
Display window and displays data.

In Append mode, the “ Display Data (page 1-15)” function creates a new display
layer on the present Data Display window and displays data.

Updating Data Calculation

When the classic test result is displayed, you can update the cal culation results of the
user function, analysis function, and auto analysis function. So use the Apply
button. See “Function Setup (page 2-42)".

Append M easurement

After the Append measurement, you will see tabs between the tool bar and the graph
plot area. The tabs are used to select the display layer for data display and analysis
operation. The Data Display window can have maximum 10 display layers.

Multi Display Function

In the Multi Display OFF status, the test result datawill be always displayed on the
singular Data Display window even if the test setup is changed.

In the Multi Display ON status, the test result data of the same test setup name will
be displayed on the exclusive Data Display window and the test result data of the
different test setup name will be displayed on the new Data Display window.

The settings on the Display Setup are applied to the X-Y Graph on the Data Display
window. The X-Y Graph can handle one X dataonthe X axisand up to eight Y data
ontheY axis.

Define the X axis carefully when plotting Multi Channel I/V Sweep measurement
results that may contain data measured by multiple VAR1 channels, as the result
may contain multiple X datathat can be selected for the X axis.

The Display Setup must be set properly to match the X axis data and the X data of
the plot to be displayed.
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Data Display GUI
Thisfield just displays the name of the test setup used to get this test record.

This area displays the measurement result graph, traces, marker, cursor, and lines.
The Properties button opens “ Graph Properties (page 1-73)".

This area lists the user-defined output parameters if the output parameters are set.

This area displays the measurement result data list. The Properties button opens
“List Display Properties (page 1-74)".

The Data Display window can keep up to 10 display layers. And the earliest layer
over 10 will be automatically deleted. This button is available when the window
keeps at least two layers. If this button shows the standing pin, the layer will be kept.
If this button shows the laid pin, the layer can be deleted.

Double clicking the tab gives the same result as this button.
This button closes the selected display layer.

Provides the following functions.

Switch to Append Mode/
Switch to Overwrite Mode  Used to switch the display mode.

Update Test Result Stores the information of the scale and the analysis
toals.

Delete Test Result Deletes the present display data or the selected
display layer.

Close This Display Closes the selected display layer.

Close All Displays Closes all display layers.

Save Image As... Opens the Save Image As... dialog box used to

specify the file name of the graph image to save.
See Figure 1-3. Available data formats are the
BMP, EMF, GIF, and PNG

Page Setup... Opens the Page Setup dialog box used to set the
print page.
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Print Preview

Opens the Print Preview dialog box used to specify
Print Range/Data to print/Scaling of the graph
image to display. Clicking the Preview button
opens the Print preview window. See Figure 1-4.

» Print Range sets Whole Data Display window
or Graph Only.

» Datato print sets Current Data Display window
only or All Data Display windows now opened.

» Scaling sets Adjust To the specified percent of
the normal size or Fit To Page (automatic
adjustment).

Print... Opens the Print dialog box used to specify Print
Range/Data to print/Scaling (see Print Preview) of
the graph image to print. See Figure 1-3. Clicking
the Next button opens another Print dialog box used
to select the printer, print range, and number of
copies, and start print.

Close Closes the Data Display window.

Figure1-3 Save Image As... and Print...
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Figure1-4 Print Preview Example
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Edit menu Provides the following functions.

Copy When the X-Y Graph Plot areais active, this
function copies the graph image as BMP and EMF
into the clipboard.

When the line cursor in the List Display areais
active, this function copies the datalist as CSV.
When the Parameters area is active, this function
copies the parameter dataas CSV.

Copy Graph Copies the graph image as BMP and EMF into the
clipboard.

Copy List Copiesthelist dataas CSV.

Copy Parameters Copies the parameter data as CSV.

Graph Properties... Opens “ Graph Properties (page 1-73)".

List Display Properties... Opens “List Display Properties (page 1-74)".
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Figure 1-5 shows the graph copy and paste example. Click the X-Y Graph Plot area
on the Data Display window, select Edit > Copy menu, and paste it to WordPad. You
will see the result as shown in this example.

Figure 1-5 Graph Copy and Paste
(@0 Gummatbtos (141 £ 71372005 1237729 PUA] Aghent ComOIPEAT =~ |
| Fla Edit View Marker Cursor Line Window Help |
| Ceprome ) e i3 l
I Setup Neme:  |BIT GummedF| w“:”:TQWM-WU. . —_TQ:E
S T [ Flie Edit View Inserl Format Help
£+ .t - r o
« Copy to Clipboard 0®@W &2 a ‘&-=
o0 m | s ~l i Vi ¥ nsU P EEAE
wom —T
18nse ' _,.-"'--'J_-‘
docade s ,_/"'-/‘-
[ d I/-"'
e s s Paste to WordPad l
1

St e 1 T

Figure 1-6 shows the list copy and paste example. Click aline of the List Display
area on the Data Display window, select Edit > Copy menu, and paste it to Notepad.
You will seetheresult as shown in this example. The datain Notepad isa CSV data
(separated by acomma). Save it as atext file and open it by using a spreadsheet
software. Each data (comma separated value) will be entered to a separate cell.

Figure 1-6 List Copy and Paste
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View menu

Main GUI
Data Display

Provides the following functions.

X-Y Graph

List Displays
Parameters

Graph Legend ON/OFF

Line Information ON/OFF

Open Preview Window

Auto Scale

Run Time Auto Scale

Zoom In

Zoom Out

Cancel Scaling

Choose ActiveY Axis

Display Setup...

Displays or hides the X-Y Graph Plot area.
Displays or hidesthe List Display area.
Displays or hides the Parameters area.

Displays or hides the graph legend below the plot
area.

Displays or hides the line information (X-intercept,
Y-intercept, gradient) in the plot area.

Opens “Preview (page 1-84)" and “Preview
Settings (page 1-86)”.

Changes graph scale to fit the trace in the graph
automatically.

Enables or disables the run time auto scaling. This
function is set to independently for the X and Y
axes.

If this function is enabled, the graph scale will be
changed automatically to fit the trace in the graph
during the measurement.

Zooms the data graph in the cursor. If the cursor is
not displayed, zooms the data graph in the last
cursor position or the graph center. This enlarges
the trace in the graph.

Zoomsthe data graph out the cursor. If the cursor is
not displayed, zooms the data graph out the last
cursor position or the graph center. Thisreducesthe
trace in the graph.

Returnsto the initial graph scale. This Display
works only for the selected layer. All Displays
works for the all display layers.

Selects the Y-axis that is effective for the marker
control and the auto scale.

Opens “Display Setup (page 1-72)".

If multiple layers are opened on the Data Display window, the scale change is
applied to all layers. This means that the X-Y graph scale will be shared by all
display layers. The auto scaling is performed as follows.
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Marker menu

Cursor menu

Line menu

Main GUI
Data Display

1. Graph scaleis optimized for the data on the selected layer (top layer).

2. The graph scaleis applied to the graph in al layers.

Note that auto scaling is performed independently for the left and right Y axes.
Marker can move on the measurement data curve. The Marker menu provides the
following six functions.

Marker ON/OFF Enables or disables the marker.

I nter polation ON/OFF Enables or disables the interpolation function of
measurement data. You can read the interpolation
data between two actual measurement points.

Skip Moves the marker to the next measurement curve
that is added by the VAR2 variable.

Go ToMaximum Moves the marker to the maximum value point.

Go ToMinimum Moves the marker to the minimum value point.

GoTo.. Opensthe Direct Marker/Cursor dialog box used to

specify the coordinate values to move the marker.

Cursor can move anywhere on the graph. The Cursor menu provides the following
three functions.

Cursor ON/OFF Enables or disablesthe cursor.
GotoMarker Moves the cursor to the marker position.
Goto... Opensthe Direct Marker/Cursor dialog box used to

specify the coordinate values to move the cursor.

Provides the following five functions. When aline is enabled, gradient, X-intercept,
and Y-intercept are displayed in the graph. See Figure 1-7.

Line 1 ON/OFF Enables or disablesline 1.
Line 2 ON/OFF Enables or disablesline 2.
Line Mode Selects the line mode: normal, gradient, tangent,

regression, or fix.

Adjust Gradient Available when agradient line is active. Checking
this function enables the rotary knob and the mouse
wheel to increase/decrease the gradient of the line.
Unchecking this function, clicking the rotary knob,
or clicking the mouse wheel disables this function.
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Gradient...

Main GUI
Data Display

Opens the Gradient Value dialog box used to
specify the gradient value of the gradient line.

You can draw aline as shown below:

1. SetLinelorLine?2on.
2. Select aLine Mode.

Normal

Gradient

Tangent

Regression

Fix
Figure1-7 Line Mode

Normal line

A line and two cursors appear. Move cursors to the points
where the line passes through.

A line and a cursor appear. Move cursor to the point where
the line passes through. Enable Adjust Gradient function,
then increase/decrease the gradient of the line by using the
rotary knob or the mouse wheel.

A line appears. Set the marker on. The tangent line appears
on the marker point.

A line and two cursors appear. Move cursors for specifying
the measurement data used for the regression calculation.
The calculation is executed by using the dataincluded in the
square drawn by the extended cross cursor lines. For the
subordinate sweep measurement data, specify the datacurve
by using the marker.

Fixesthe line on the graph.

Gradient line Tangent line Regression line

1 cursor marker 2 cursors
qradient data curve measured data

e
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Text menu

Main GUI
Data Display

Up to 20 texts can be added to a graph. The following functions are provided.

New Opens the text editor for adding a new text.
Hide All/ Show Al Hides or shows all texts.
Delete All Deletes dl texts.

Clicking on atext will select the text. To select multiple texts, click the texts while
holding down the Shift key on the keyboard.

The following functions are available for the selected text(s) via the Text menu, the
Text icons, or the right-click menu.

Edit Mode Edits the selected text.

Size Sets the font size of the selected text(s). The
available setting values are Largest, Large,
Medium, Small, Smallest, and Fixed Point (6, 7, 8,
9, 10, 11, 12, 14, 16, 18, or 20). For settings other
than Fixed Point, an appropriate size will
automatically be applied. For Fixed Point, the
specified font size will always be applied.

Font Sets the font of the selected text(s).

Text Color Sets the text color of the selected text(s). Click
Customize to open the color palette.

Background Color Sets the background color of the selected text(s).
Click Customize to open the color palette.

Hide Frame/Show Frame Hides or shows the frame for the selected text(s).
Delete Deletes the selected text(s).
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Pointer menu

Window menu

Help menu

Main GUI
Data Display

Up to 30 pointers can be added to a graph. The following functions are provided.

New This function is enabled when the marker is ON.
Adds anew pointer at the position of the active
marker.

Hide All/ Show Al Hides or shows all pointers.

Show All Descriptions Shows all descriptions (pointer ID and X-Y
coordinate values) of the pointers.

Hide All Descriptions Hides all descriptions of the pointers.

Delete All Deletes al pointers.

Clicking on apointer will select the pointer. To select multiple pointers, click the
pointers while holding down the Shift key on the keyboard.

The following functions are available for the selected pointer(s) via the Pointer
menu, the Pointer icons, or the right-click menu.

Shape Sets the shape of the selected pointer(s).

Hide Description/Show

Description Hides or shows the description of the selected
pointer(s).

Delete Deletes the selected pointer(s).

Provides the three functions bel ow. The functions work for opened windows.

Tiling Tilesall Data Display windows on the screen.
Sacking Stacks all Data Display windows on the screen.
Overlaying Overlays all Data Display windows on the screen.

Then the position, window size, and visibility of the
most front window are applied to all windows on
the screen. The background of the X-Y Graph area
is cleared except for the most back window.

Agilent EasyEXPERT Help  Opensthe EasyEXPERT help window.
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X-Y Graph

List Display,
Parameters

Main GUI
Data Display

Display Setup

This setup screen is displayed by selecting View > Display Setup..., and is used to
select the data displayed in the Data Display window.

Selects the data to be displayed in the X-Y Graph Plot area. The X and Y1to Y8

axes can be set.
Name

Sharing

Scale
Min
Max
Add
Delete
Up

Down

Specifies the parameter for the axis.

Specifies the group for sharing the Y axis scale. Select from
Group 1, Group 2, Group 3, Group 4, or None (no grouping).

The Scale, Min, and Max values are shared by the Y axesin the
same group. The scale set by Run Time Auto Scale, Auto Scale,
Zoom in, and/or Zoom out are also shared.

If another layer on the Data Display window contains an X-Y
trace which has the same name for both its grouped Y
parameter and its X parameter, the scaling will also be shared
by this X-Y trace.

Scale of the axis, Linear or Log

Minimum value of the axis

Maximum value of the axis

Adds a parameter (or axis).

Deletes the parameter selected with the radio button on the lft.
Moves the selected parameter upward.

Moves the selected parameter downward.

Selects the data displayed in the List Display area or the Parameters area. Up to 20
parameters can be set for each area.

parameter Specifies the parameter for the data output.

Add Adds arow for the parameter.

Delete Deletes the parameter selected by the left radio button.

Up Moves the selected parameter upward.

Down Moves the selected parameter downward.
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Effective Area

Graph Color

Graph Trace Color

Log Scale

Text Size

Main GUI
Data Display

Graph Properties

This dialog box is opened by clicking the Properties... button in the X-Y Graph Plot
areaor by selecting Edit > Graph Properties..., and is used to set the graph plot area.
Click the OK button to apply the setup and close this dialog box.

This area provides the following check box.
Grid ON Check this button to display the grid on the X-Y Graph.
Thisareais used to set the color map for the graph plot area. You can change the

color of the background, text, graph grid, and line/cursor. The color paletteis
opened by clicking the pattern of the item.

Thisareais used to set visibility, color, and thickness of the datatracesY1to Y8
plotted on the graph. The color palette is opened by clicking the pattern of the item.

This areais used to set the maximum number of decades to show the minor ticks on
thelog axis. If the number of graph decadesis lessthan or equal to the entered
value, the minor ticks are displayed. If it is greater than the entered value, the minor
ticks are not displayed.

Thisareais used to set the font size for the graph. The available settings are Largest,
Large, Medium, Small, Smallest, and Fixed. For settings other than Fixed, the
appropriate size is automatically selected. For Fixed, afont size entry field is
provided, and the specified font sizeis always applied.

X/Y AxisTitle Font size for the axistitle
Scale Font size for the X and Y coordinate values

Legend Font size for the graph legend
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Display

Number Format

Switch Display
Mode

Close All Displays
Show X-Y Graph
Show List Display

Show Parameters

Main GUI
Data Display

List Display Properties

Thisdialog box is opened by clicking the Properties... button in the List Display
area or by selecting Edit > List Display Properties..., and is used to set the data
display format in the List Display area. Click the OK button to apply the setup and
close this dialog box.

Check the following check box to add the data status or the physical unit to data.
Unchecking the box removesit.
Data Satus Adds or removes the status code before data.

Physical Unit Adds or removes the physical unit after data.

Selects the data display format from the following formats.
» Engineering Format (Example: - 1. 2345 mA)
Data display with arithmetic point, SI prefix, and unit.
» Scientific Notation (Example: - 1. 23456789012345E- 003 A)

Data display with arithmetic point, exponential part (E, +/- sign, and three-digit
number), and unit.

Tool Bar

The Data Display window provides the 22 icons on the tool bar. You will see the
following icons from left to right in the Data Display window.

Thisicon switches the display mode.

In Overwrite mode, the “ Display Data (page 1-15)” function opens a new Data
Display window and displays data.

In Append mode, the “Display Data (page 1-15)” function creates a new display
layer on the present Data Display window and displays data.

Thisicon closes al display layers.
Thisicon displays or hides the X-Y Graph Plot area.
Thisicon displays or hides the List Display area.

Thisicon displays or hides the Parameters area.
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Auto Scale

Zoom In

Zoom Out

Display Setup...

Choose Active
Y-axis

Marker ON/OFF

Interpolation
ON/OFF

Marker Skip

Marker Maximum

Main GUI
Data Display

Thisicon will change the graph scale automatically to fit the trace in the graph.

Theright arrow button opens the menu for enabling or disabling the run time auto
scaling. Thisfunction is set independently for the X and Y axes. If thisfunction is
enabled, the graph scale will be changed automatically to fit the trace in the graph
during the measurement.

If multiple layers are opened on the Data Display window, the scale change is
applied to all layers. This means that the X-Y graph scale will be shared by all
display layers. The auto scaling is performed as follows.

1. Graph scaleis optimized for the data on the selected layer (top layer).
2. Thegraph scaleis applied to the graph in al layers.

Note that the auto scaling is performed independently for the left and right Y axes
individually.

Thereisalso afunction for resetting the graph scale. Click View > Cancel Scaling >
This Display or All Displays. This Display will reset the selected layer only. All
Displayswill reset for the all display layers.

Thisicon zooms the data graph in the cursor. If the cursor is not displayed, zooms
the data graph in the last cursor position or the graph center. This enlarges the trace
in the graph.

Thisicon zooms the data graph out the cursor. If the cursor is not displayed, zooms
the data graph out the last cursor position or the graph center. This reduces the trace
in the graph.

Thisicon opens “Display Setup (page 1-72)".

Thisicon selects the Y-axis that is effective for the marker control and the auto
scale.

Thisicon enables or disables the marker.

Thisicon enables or disables the interpolation function of measurement data. You
can read the interpolation data between two actual measurement points.

This icon moves the marker to the next measurement curve that is added by the
VAR2 variable.

This icon moves the marker to the maximum measurement point.
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Marker Minimum

Marker Search...

Line 1 State

Line 2 State

Cursor to Marker

Adjust Gradient

Show Graph
Legend

Show Line
Information

Main GUI
Data Display
This icon moves the marker to the minimum measurement point.

Thisicon opens the Direct Marker/Cursor dialog box used to specify the coordinate
values to move the marker.

Thisicon enables or disablesline 1 and its function: disabled, normal, gradient,
tangent, regression, or fix.

Thisicon enables or disablesline 2 and its function: disabled, normal, gradient,
tangent, regression, or fix.

This icon moves the cursor to the marker position.

Thisiconisavailable when aregression lineis active. Clicking thisicon enables the
rotary knob and the mouse wheel to increase/decrease the gradient of the line.
Clicking thisicon again, pressing the rotary knob, or pressing the mouse wheel
disables this function.

Thisicon displays or hides the graph legend below the plot area.

Thisicon displays or hides the line information (X-intercept, Y-intercept, gradient)
in the plot area.
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Main GUI
Data Display

Data Satus

If measurement unit detects any status while measurement, the status code is
recorded with the measurement data. And the status code will be displayed in the
Data Display window as shown in the following example.
Example e X-Y Graph Plot area
MARKER( 5.9000000 C 1.82520000 XV 3.33249E-3 )

Thislinewill be displayed at the top of the plot area when marker is ON. The
marker is used to read data of the marker point.

e ListDisplay area

| ndex Vi V2 12
123 5.9 V C 1.8252 V XV 3.33249 mA
Status Code SMU status code:

e C: Compliance

e T: Other channel compliance
* X: Oscillation

* V:Overflow

MFCMU status code:

e U: Unbalance
e D: I/V amp saturation

* V: Overflow
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Main GUI
Data Display

Miscellaneous Oper ations

The following user interfaces provide several miscellaneous functions when you
operate the Data Display window.

*  “Mouse/Touch Panel”
* “Rotary Knob”

o “Softkeys’

»  “Keyboard’

M ouse/Touch Panel

While the Data Display window is focused, the mouse/touch panel operations
shown in Table 1-7 (p. 1-82) are available.

Rotary Knob
The following miscellaneous functions are available by using the rotary knab.

e Marker movement in the VARL1 direction

While the Data Display window is focused and the marker is displayed on the
graph, the rotary knob can be used to move the marker. Rotating the knob fast
increases the marker speed.

* Marker movement in the VAR2 direction
Clicking the knob moves the marker in the VAR2 direction.
e Slope adjustment of the gradient line

In the slope adjustment mode (Line > Adjust Gradient) for the gradient line, the
rotary knob can be used to adjust the slope. Clicking the knob quits this mode.

e Pointer movement in the VARL direction
Therotary knob can be used to move the selected pointer. The pointer can not be
moved in the VAR2 direction.

Softkeys

The softkeys can be used for setting the following fields on the Display Setup (p.
1-72) window.

» Name (parameter name)

» Scae(Linear or Log)
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Table 1-2

Keyboard

Main GUI
Data Display

While the Data Display window is focused, the key operations shown in Table 1-2

are available.

Miscellaneous K ey Operations on Data Display Window

Key Description
F1 Displaysthe online help
F2 Shortcut to View > X-Y Graph
F3 Shortcut to View > List Display
F4 Shortcut to View > Parameters
F12 Changes the display mode, Append — Overwrite — Append
Ctrl+W Shortcut to File > Close This Display
Ctrl+Shift+W | Shortcut to File > Close All Displays
Ctrl+S Shortcut to File > Save Image As...
Ctrl+P Shortcut to File > Print...
Ctrl+C Shortcut to Edit > Copy

While the X-Y Graph (graph display area) is focused, the key operations shown in
the following tables are available.

» Table1-3, “Controlling X-Y Graph.”
» Table1-4, “Controlling Marker.”

» Table1-5, “Controlling Cursor.”

» Table1-6, “Controlling Line.”
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Table 1-3

Table 1-4

Main GUI
Data Display

Controlling X-Y Graph

Key Description
S Shortcut to View > Auto Scale
z Shortcut to View > Zoom In
Shift+z Shortcut to View > Zoom Out
Ctrl+z Shortcut to View > Cancel Scaling
Y Changesthe activedata, Y1 > Y2 —> ... > Y8—> Y1
R Activatestheright Y axis and changes the data set to the axis,
Y2-5Y3—>5..5Y8>Y2
W Shortcut to View > Graph Legend ON/OFF
K Shortcut to View > Line Information ON/OFF

Controlling Marker

Key Description

M Shortcut to Marker > Marker ON/OFF

I Shortcut to Marker > Interpol ation ON/OFF

F Moves the marker +1 2in the VAR1 direction
Shift+F Moves the marker +10 2in the VAR1 direction

B Moves the marker - 1 2in the VAR1 direction
Shift+B Moves the marker - 10 2in the VAR1 direction

P Moves the marker +1 2in the VAR direction
Shift+p Moves the marker - 1 2in the VAR2 direction

J Shortcut to Marker > Go To...

X Shortcut to Marker > Go To Maximum

N Shortcut to Marker > Go To Minimum

a. Multiply 1/10if the interpolation is ON.
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Table 1-5

Table 1-6

Main GUI

Data Display
Controlling Cursor
Key Description
C Shortcut to Cursor > Cursor ON/OFF
T Shortcut to Cursor > Go To Marker
) Movesthe cursor +1/1000 in the Y axis direction
Shift+ T Moves the cursor +1/100 in the Y axis direction
- Moves the cursor +1/1000 in the X axis direction
Shift+ — Movesthe cursor +1/100 in the X axis direction
d Moves the cursor - 1/1000 in the Y axis direction
Shift+ 4 Movesthe cursor - /100 in the Y axis direction
“— Movesthe cursor - /1000 in the X axis direction
Shift+ « Moves the cursor - 1/100 in the X axis direction
Controlling Line
Key Description
12 Shortcut to Line > Line 1 ON/OFF
oa Shortcut to Line > Line 2 ON/OFF
\% Changesthe activeling, Linel — Line2 — Line 1
(availableif both line 1 and line 2 are ON)
L Changes the line mode of the active line,
Normal — Gradient — Tangent — Regression — Normal
G Shortcut to Line > Adjust Gradient

a. 1 and 2 on the numeric pad cannot be used.

Agilent EasyEXPERT User’s Guide, Edition 1 1-81



Main GUI

Data Display
Table 1-7 Mouse/Touch Panel Operationson Data Display Window
Location Operation Description
X-Y Graph clickingontheleft | Activatesthe Y1 data

Y axis

clicking on the
right Y axis

Activatesthe data of theright Y axis, or changesthe active data
if itisaready active.

clicking on a plot

Moves the marker to the position of the mouse pointer if the
marker is displayed on the graph.

clicking on a cursor

Specifies the active cursor if multiple cursors are displayed.

dragging a cursor

Moves the cursor.

clicking on aline

Specifies the active line if multiple lines are displayed.

clicking on atext

Selects the text.

Clicking with pressing the Shift key on the keyboard selects
multiple texts.

dragging a text

Moves the text.

clickingon a Selects the pointer.

pointer Clicking with pressing the Shift key on the keyboard selects
multiple pointers.

clickingon a Selects the description of pointer.

description of Clicking with pressing the Shift key on the key board selects

pointer ) o .
multiple descriptions of pointers.

dragging a Moves the description of pointer.

description of

pointer

rotating the mouse
wheel

Moves the marker if the marker is displayed on the graph,
moves the pointer if the pointer is selected, or adjusts the slope
of the gradient lineif it isin the slope adjustment mode (Line >
Adjust Gradient).
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Main GUI
Data Display

L ocation Operation Description

X-Y Graph clicking the mouse | Same as clicking the rotary knob.

wheel Thisiseffective if the mouse properties assign the center button
functions to the wheel button.

List Display dragging acolumn | Moves the column.
heading
dragging boundary | Changes the width of the column.
of the column
clickingonarowin | Movesthe marker to the corresponding position.
the table
moving the scroll Changes the data displayed in the List Display area.
bar Scroll is effective for both portrait and landscape.
rotating the mouse | Changes the data displayed in the List Display area.
wheel

Others Specifies the display layer for the data display and analysis.

clicking on atab?
under the tool bar

double clicking on

Changes the status of the pin marked to the display layer.

ata}bs under the Standing pin must be marked to the display layer to be kept.
tool bar
Laid pin is marked to the display layer under the automatic
delete.
dragging boundary | Adjuststhe size of the display area (X-Y Graph, List Display,
of the display area | Parameters) without changing the window size.

dragging the frame
of the Data Display
window

Changes the window size with adjusting the size of the display
area (X-Y Graph, List Display, Parameters).

a. Tabisdisplayed if the display mode is Append and the test result record contains the append
measurement data.
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Setup Name
X-Y Graph Plot
Parameters
List Display

File menu

Main GUI
Preview

Preview

The Preview window and the Preview Settings dialog box are opened by selecting
View > Open Preview Window in the Data Display window. The Preview Settings
dialog box is used to set the graph title, X axistitle, Y axistitle, and line style. And
the Preview window displays a new plot, and is used to output it to the specified
printer.

The Data Display window cannot do the above settings and display the new plot.
*  “Preview Window GUI”
*  “Preview Settings’

Preview Window GUI

The Preview window provides the following GUI.

Thisfield just displays the name of the test setup used to get this test record.

This area displays the measurement result graph, traces, marker, cursor, and lines.
This area lists the user-defined output parameters if the output parameters are set.
This area displays the measurement result data list.

Provides the following functions. See also Figure 1-3 and Figure 1-4.
Page Setup... Opens adialog box used to set the print page.

Print Preview Opens a dialog box used to specify the data graphs
to make previews. After selecting the graphs,
previews appear on the Print preview window.

Print... Opens adialog box used to specify the print target.
After selecting the target, the Print dialog box is
opened. The dialog box is used to start print.

Close Preview Window Closes the Preview window.
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Edit menu

View menu

Help menu

Main GUI
Preview

Provides the following functions. See also Figure 1-5 and Figure 1-6.

Copy

Copy Graph

Copy List
Copy Parameters

While the X-Y Graph Plot areais active, this
function copies the graph image as BMP and EMF
into the clipboard.

While theline cursor inthe List Display areais
active, this function copies the datalist as CSV.

While the Parameters areais active, this function
copies the parameter data as CSV.

Copies the graph image as BMP and EMF into the
clipboard.

Copiesthelist dataas CSV.
Copies the parameter data as CSV.

Provides the following functions.

X-Y Graph
List Displays
Parameters

Preview Settings...

Displays or hidesthe X-Y Graph Plot area.
Displays or hidesthe List Display area.
Displays or hides the Parameters area.

Opens “ Preview Settings (page 1-86)”.

Agilent EasyEXPERT Help  Opensthe EasyEXPERT help window.
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General

X/Y Axis Title

Line Style

Color and
Thickness...

OK
Cancel
Apply

Reset

Main GUI
Preview

Preview Settings
The Preview Settings dialog box provides the following GUI.

Defines the graph title in the Graph Title field. Thetitle will appear at the bottom of
the plot area.

Definesthe X axistitleinthe X field and the Y axistitleintheY field, Y1to Y8.
Thetitle will appear near the axis.

Selectsthe line style for theline 1, line 2, and trace Y1to Y 8.

Opens the Color and Thickness dialog box that provides the same GUI as “Graph
Properties (page 1-73)".

Applies the setup to the Preview window, and closes this dialog box.
Cancels the setup, and closes this dialog box.
Applies the setup to the Preview window.

Clears the setup and returns to the default setting.
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Reset
OK
Cancel

Miscellaneous,
Save As

Miscellaneous,
Quotation

Identification
section

Table 1-8

Main GUI
Text File Export settings

Text File Export settings

This dialog box is opened by clicking Results > Transport Data > Text File Export
Settings... or the Settings button on the Test Results Data Folder Export dialog box
or the Test Results Data Auto Export dialog box. This dialog box is used to define
the style of the test record exported by the Export As Text File function.

Appliesthe default value to the all setup items.
Defines and memorizes the present setting, and closes this dialog box.
Cancels and clears the setting changes, and closes this dialog box.

Specifies the delimiter (data separator) and file extension. CSV (comma separated,
.csv, default), Text (tab separated, .txt), or Formatted Text (space separated, .prn).

Specifies the quotation for the string values. Single (single quotes), Double (double
guotes), or None (no quote, default). Even if None is specified, the string which
contains delimiter and/or new line character will be double quoted.

Record items which are used to identify and characterize the test record. They are a
sub set of the meta data, test type, and test name. See Table 1-9 for the definition of
the record items. Check the box for the items you want to record, and uncheck the
box for the items you do not want to record. In the default, al items are checked.

The pull-down menu specifies the action for recording the itemsin the I dentification
section. See Table 1-8 to specify the action.

Actionsfor Identification and Setup Data Items

Action Description

Save with measurement data | The checked items are recorded in the test record
with the measurement data. Default.

Do not save No item isrecorded even if any box is checked.

Save as separate file The checked items are recorded in a separatefile.
The name will be the test record’s file name plus
- s before the extension.
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Table 1-9 Identification Section Record Items

Item Description

Setup title | Test setup name

Classictest | Classic test name. I/V Sweep, Multi Channel I/V Sweep, 1/V-t
name Sampling, C-V Sweep, SPGU Control, Switching Matrix Control,
or Direct Control. This record item is exclusive against the
“Application test name” record item.

Application | Application test name. Thisrecord item is exclusive against the
test name “Classic test name” record item.

Test date Test execution date corresponding to the date part of the
RecordTime meta data.

Test time Test execution time corresponding to the time part of the
RecordTime meta data.

DevicelD Device ID corresponding to the TestTarget meta data.

Count Test count corresponding to the Iterationlndex meta data.
Flags Flags set to the test result data, corresponding to the Flag meta
data.

Remarks Remarks set to the test result data, corresponding to the Remarks
meta data.

Setup data section Record itemswhich describesthe test conditions. They are the test parameters, DUT
parameters, and analysis setup. See Table 1-12 for the definition of the record items.
Check the box for the items you want to record, and uncheck the box for the items
you do not want to record.

Tag information for the setup datais string value; TestParameter, DutParameter, or
AnalysisSetup, which means the type of data put in the same row in the exported
test record. If Tag information box is unchecked (default), the tag information is not
recorded. Then, the setup parameter names, such as Channel.Unit, are recorded in
the first column in the test record and the parameter values are recorded in the
following columns. If the Tag information box is checked, the tag information is
recorded in the first column and the parameter names and values are shifted to the
next columns.

The pull-down menu specifies the action for recording the items in the Setup data
section. See Table 1-8 to specify the action.
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Measurement data Record items of the measurement data. It may contain the measurement parameter

section

Table 1-10

Table 1-11

names, data units, and data size. See Table 1-13 for the definition of the record
items. Check the box for the items you want to record, and uncheck the box for the
items you do not want to record.

Tag information for the measurement dataiis string value; Dimensionl, Dimension2,
Data Name, Data Unit, or Data Value, which means the type of data put in the same
row (in case of By Row orientation) or column (in case of By Column orientation)
in the exported test record. The tag information will be recorded in the test record if
the Tag information box is checked.

See Table 1-10 for the By Row orientation. All data relative to a measurement
parameter will be put in the same column. The first column (ex. column A) contains
the tag information. For the By Column orientation, see Table 1-11. All datarelative
to a measurement parameter will be put in the same row. And the first row (ex. row
1) contains the tag information. If the Tag information box is unchecked (default),
the tag information is not recorded and the measurement data is shifted.

By Row Orientation Export Example

A B C D E F
1 Dimensionl | 101 101 101 1
2 Dimension2 | 1 1 1 1
3 Data Name Vg Id Gm Vth
4 Data Unit \% A S \%
5 Data Value 0 4.55E-09 1.24E-10 1.23
6 | DataVaue 0.02 8.59E-09 5.25E-10

By Column Orientation Export Example

A B C D E F
Dimensionl | Dimension2 | DataName Data Unit Data Value Data Vaue
101 1 Vg \% 0 0.02
101 1 Id A 4.55E-09 8.59E-09
101 1 Gm S 1.24E-10 5.25E-10
1 1 Vth \% 1.23
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Table 1-13

Main GUI

Text File Export settings

Setup Data Section Record Items (ON: checked, OFF: unchecked)

Item Description Default
Test parameters | Test parameters defined by the classic test or the ON
application test.
DUT parameters | DUT parameters defined by the application test. ON
Analysis setup Data Display setup status at and after the OFF
measurement, such as Graph configuration, Graph
format, Graph text, Marker configuration, Cursor
configuration, Line configurations, Pointer
configuration, List configuration, and Scalar list
configuration.
Measurement Data Section Record Items (ON: checked, OFF: unchecked)
Item Description Default
Data names | Measurement parameter name. ON
Dataunits | Unit of measurement data. OFF
Size Dimensionl (VARL size) and Dimension2 (VAR2 size) OFF
of the measurement data.
Datavalues | Record items can be specified by the following segments.
Segment Default
Data assigned to X-Y Graph ON
Data assigned to List Display ON
Data assigned to Parameter Display ON
User function defined but not displayed OFF
Analysis function defined but not displayed OFF
Any datareferred to by the user function but not OFF
directly displayed
Any datareferred to by the analysis function but not OFF
directly displayed
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Classic Test Definition

This chapter provides the reference information of the classic test setup GUI of

Agilent EasyEXPERT software.

“1/V Sweep”

“Multi Channel I/V Sweep”

“1/V List Sweep”

“1/V-t Sampling”

“C-V Sweep’

“Direct Control”

“Function Setup”

“Auto Analysis Setup”

“Display Setup”

“SMU Range Setup Window”

“ADC and Integration Time Setup Window”
“Pulse Setup Window”

“Advanced Setup Window”

“Range Setup Window”

“Advanced Setup Window for C-V Sweep”
“Switching Matrix Control”

“SPGU Control”

“SPGU Pulse Setup Window”

“Load Z Setup Window”

“Pulse Switch Setup Window”
“SPGU ALWG Setup Window”
“Define ALWG Waveform Window”

2-2
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NOTE

Classic Test Definition

To perform measurement, see “Main Screen” on page 1-10.

To display measurement dataand perform dataanalysis, see “ Data Display” on page
1-61.

To perform self-test or diagnostics, see “Configuration” on page 1-50.
To perform self-calibration, see “ Calibration” on page 1-44.

If You Use GNDU (Ground Unit)

Keep to the following rule to use the ground unit.

1. Set Modeto COMMON.

2. Set Function to CONST.

3. Do not use the | Name assigned to the ground unit.

Missing any one will cause an execution error.
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

Classic Test Definition
I/V Sweep

1/V Sweep

On the EasyEXPERT main screen, click the Classic Test tab and select the I/V
Sweep icon. The main screen displaysthe I/V sweep test setup screen. For the
measurement mode, see “1/V Sweep Measurement” on page 4-3.

Used to set the name of test setup. The name must be the identification for the test

setup saved to a My Favorite group (preset group). Enter a unique name that is
distinct from other setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area.

This tab displays the Channel Setup screen. See “Channel Setup” on page 2-5.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
2-6.

This tab displays the Function Setup screen. See “Function Setup” on page 2-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 2-43.

This tab displays the Display Setup screen. See “Display Setup” on page 2-46.
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Channel Definition

Miscellaneous
Variables

Classic Test Definition
I/V Sweep

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, measurement data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Unit Module used for the source output or measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data
Mode Output mode. For SMU, V (voltage), | (current), VPULSE

(voltage pulse), IPUL SE (current pulse), or COMMON
(ground). For SPGU, VPUL SE (voltage pulse) or ALWG
(arbitrary linear waveform voltage).

Function Output function, VAR1 (primary sweep), VAR2 (secondary
sweep), VARL' (synchronous sweep), or CONST (constant)

Add SMU Adds arow for the SMU channel setup.

Add SPGU Adds arow for the SPGU channel setup.

Delete Deletes the channel setup. To select the channel setup, use the
left radio button.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. The output stopsin the
opposite order.

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data gives the
time when step measurement is started.

Index Name Variable name of the dataindex. Integer above O is returned.

Agilent EasyEXPERT User’s Guide, Edition 1 2-5



VAR1

Classic Test Definition

I/V Sweep

M easurement Setup

This setup screen is used to set the source channel outputs, the measurement ranging
mode, the sweep abort condition, the measurement channel A/D converter, the
series resistor, the filter, and the source output/measurement wait time.

This area defines the primary sweep source output.

Unit SMU used for the VAR output

Name Variable name for the VAR output data

Direction Sweep direction, single (start to stop) or double (start to stop to
start)

Linear/Log Sweep output, LINEAR, LOG10, LOG25, or LOG50. where
the number following LOG means the number of sweep points
in one decade.

Sart Sweep start value

Sop Sweep stop value

Sep Incremental step value of the sweep output

No of Step Number of steps. The value is automatically calculated by using
the start, stop, and step values.

Compliance Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Pwr Comp Power compliance value (in W), or OFF
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VAR2

VARY’

Timing

Classic Test Definition
I/V Sweep

This area defines the secondary sweep source output.

Unit
Name
Sart
Sop

Step
No of Step

Compliance

Pwr Comp

SMU used for the VAR2 output
Variable name for the VAR2 output data
Sweep start value

Sweep stop value. The value is automatically calculated by
using the start, step, and number of step values.

Incremental step value of the sweep output
Number of sweep steps

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Power compliance value (in W), or OFF

This area defines the synchronous sweep source output. The VAR’ output is given
by the following formula.

VARY' output = Offset + Ratio x VARL output

Unit

Name
Offset
Ratio

Compliance

Pwr Comp

SMU used for the VARY' output
Variable name for the VARL' output data
Offset value

Ratio value

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Power compliance value (in W), or OFF

This area defines the hold time and the delay time. See “To Specify Source Output
Time” on page 4-62.

Hold

Delay

Hold time. Thisisthe time from beginning of channel output to
beginning of delay time. 0to 655.35 s, 10 ms resolution.

Delay time. Thisisthe time from end of hold time to beginning
of measurement. The measurement channels start measurement
as soon as the wait time elapses. 0t0 65.535 s, 0.1 ms
resolution.
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Constant

SMU Pulse

Sweep status

Range

ADCl/Integ

Advanced

SPGU Pulse/
ALWG Setup

Classic Test Definition
I/V Sweep

This area defines the constant output source.

Unit SMU used for the constant source

V Name Variable name for the constant voltage output or measurement
data

| Name Variable name for the constant current output or measurement
data

Mode Output mode, V (voltage), | (current), VPUL SE (voltage pulse),
or IPULSE (current pulse)

Source Output value

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.

This area defines the SMU pul se setup parameters. See “SMU Pulse” on page 4-58.

Unit SMU used for the pulse output

Period Pulse period. Entering AUTO sets the optimum value
automatically.

Width Pulse width

Base Pulse base value

Thisfield specifies the sweep abort condition. See Sweep Abort Function” on page
4-37.

This button opens awindow used to set the measurement ranging operation. See
“SMU Range Setup Window” on page 2-48.

This button opens awindow used to set the A/D converter of the measurement
channels. See“ADC and Integration Time Setup Window” on page 2-50.

This button opens awindow used to set the other functions of the measurement
channel. See “ Advanced Setup Window” on page 2-53.

This button opens awindow used to set the SPGU output. See “ SPGU Pulse Setup
Window” on page 2-63 or “SPGU ALWG Setup Window” on page 2-67.
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

NOTE

Classic Test Definition
Multi Channel I/V Sweep

Multi Channel I/V Sweep

On the EasyEXPERT main screen, click the Classic Test tab and select the Multi
Channel 1/V Sweep icon. The main screen displays the Multi Channel 1/ Sweep
test setup screen. For the measurement mode, see “Multi Channel 1/V Sweep
Measurement” on page 4-12.

Sets the name of the test setup. The nameis used to identify the test setup savedto a
My Favorite group (preset group). Enter a unique name that is distinct from other
setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area

This tab displays the Channel Setup screen. See “Channel Setup” on page 2-10.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
2-11.

This tab displays the Function Setup screen. See “ Function Setup” on page 2-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 2-43.

Thistab displays the Display Setup screen. See “Display Setup” on page 2-46.

Setting of the Display Setup is applied to the X-Y Graph on the Data Display
window. And the X-Y Graph can handle one X datafor the X axisand the maximum
eight Y datafor the Y axis.

Definethe X axis carefully to plot the Multi Channel 1/V Sweep measurement result
which may have the data measured by the multiple VAR channels. Because the
result may also contain the multiple X data which can be the selections of the X
axis.

The Display Setup must be set properly to match the X axis data and the X data of
the plot you look at.
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Classic Test Definition
Multi Channel I/V Sweep

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, measurement data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Unit Module used for the source output or measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data
Mode Output mode. For SMU, V (voltage), | (current), VPULSE

(voltage pulse), IPUL SE (current pulse), or COMMON
(ground). For SPGU, VPUL SE (voltage pulse) or ALWG
(arbitrary linear waveform voltage).

Function Output function, VAR1 (primary sweep), VAR2 (secondary
sweep), or CONST (constant)

Add SMU Adds arow for the SMU channel setup.

Add SPGU Adds arow for the SPGU channel setup.

Delete Deletes selected channel setup. To select achannel, use the
radio button on the left.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. The output stopsin the
opposite order.

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data indicates
the time at which step measurement was started.

Index Name Variable name of the dataindex. Integer above O is returned.
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VAR1

Constants

VAR2

Classic Test Definition
Multi Channel I/V Sweep

M easurement Setup

This setup screen is used to set the source channel outputs, the measurement ranging
mode, the sweep abort condition, the measurement channel A/D converter, the
series resistor, the filter, and the source output/measurement wait time.

This area defines the primary sweep source output.

Direction

Linear/Log

No of Step
Unit
Name
Sart

Sop

Compliance

Pwr Comp

Sweep direction, single (start to stop) or double (start to stop to
start)

Sweep output, LINEAR, LOG10, LOG25, or LOG50 where the
number following LOG indicates the number of sweep pointsin
one decade.

Number of sweep steps

SMU used for the VAR output
Variable name for the VARL1 output data
Sweep start value

Sweep stop value

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Power compliance value (in W), or OFF

This area defines the constant output source.

Unit

V Name

| Name

Mode
Source

Compliance

SMU used for the constant source

Variable name for the constant voltage output or measurement
data

Variable name for the constant current output or measurement
data

Output mode, V (voltage) or | (current)
Output value

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

This area defines the secondary sweep source output.

Unit

SMU used for the VAR2 output
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Sweep status

Range

ADClInteg

Pulse

Advanced

SPGU Pulse /
ALWG Setup

Classic Test Definition
Multi Channel I/V Sweep

Name Variable name for the VAR2 output data

Sart Sweep start value

Sop Sweep stop value. The value is automatically calculated from
the start, step, and number of step values.

Sep Incremental step value for the sweep output

No of Step Number of sweep steps

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.

Pwr Comp Power compliance value (in W), or OFF

This area defines the hold time and the delay time. See “To Specify Source Output
Time” on page 4-62.

Hold Hold time. Thisis the time between the beginning of channel
output and the beginning of delay time. 0 to 655.35 s, 10 ms
resolution.

Delay Delay time. Thisis the time between the end of the hold time

and the beginning of measurement. The measurement channels
start measurement as soon as the wait time elapses. 0 to 65.535
s, 0.1 msresolution.

Thisfield specifies the sweep abort condition. See “ Sweep Abort Function” on page
4-37.

This button opens awindow for setting measurement ranging operation. See “SMU
Range Setup Window” on page 2-48.

This button opens awindow for setting the A/D converter of the measurement
channels. See “ADC and Integration Time Setup Window” on page 2-50.

This button opens awindow for setting the SMU pulse output. See * Pulse Setup
Window” on page 2-51.

This button opens awindow for setting other functions of the measurement channel.
See* Advanced Setup Window” on page 2-53.

This button opens awindow used to set the SPGU output. See “ SPGU Pulse Setup
Window” on page 2-63 or “SPGU ALWG Setup Window” on page 2-67.
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Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

Classic Test Definition
I/V List Sweep

I/V List Sweep

On the EasyEXPERT main screen, click the Classic Test tab and select the I/V
Sweep icon. The main screen displaysthe I/V List sweep test setup screen.

I/V List Sweep measurement issimilar to 1/V Sweep measurement described in“1/V
Sweep Measurement” on page 4-3.

Changes from the I/V Sweep are listed bel ow.

*  VARLV/VAR?2 step output values are set by using a vector data. Vector data from
aspreadsheet software, either tab separated or comma separated can be copied to
the Define vector data dialog box via the Windows clipboard. See “Define
vector data’ on page 2-18.

* All SMU instaled in the B1500 can be set to VARL.
* VARZY’ isnot supported.
Sets the name of the test setup. The nameis used to identify the test setup savedto a

My Favorite group (preset group). Enter a unique name that is distinct from other
setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area.

This tab displays the Channel Setup screen. See “Channel Setup” on page 2-5.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
2-6.

This tab displays the Function Setup screen. See “ Function Setup” on page 2-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 2-43.

This tab displays the Display Setup screen. See “Display Setup” on page 2-46.
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Classic Test Definition
I/V List Sweep

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, the measurement data, the time stamp data, and the index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Unit Module used for the source output or measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data
Mode Output mode. For SMU, V (voltage), | (current), VPULSE

(voltage pulse), IPUL SE (current pulse), or COMMON
(ground). For SPGU, VPUL SE (voltage pulse) or ALWG
(arbitrary linear waveform voltage).

Function Output function, VAR1 (primary sweep), VAR2 (secondary
sweep), or CONST (constant).

If aSMU is set to Mode=VPUL SE or IPULSE:

¢ Number of VAR1 channels must be one or two.

* |f aVAR1 channel is set to Mode=VPULSE, the other
VAR1 channel must be Mode=V.

* |f aVAR1 channdl is set to Mode=IPUL SE, the other VAR1
channel must be Mode=I.

Add SMU Adds arow for the SMU channel setup.

Add SPGU Adds arow for the SPGU channel setup.

Delete Deletes the selected channel setup. To select a channel setup,
use the radio button on the | eft.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. The output stopsin the
opposite order.
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Miscellaneous
Variables

VAR1

NOTE

Classic Test Definition
I/V List Sweep

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data indicates
the time at which step measurement was started.

Index Name Variable name of the data index. Integer above O is returned.

M easurement Setup

This setup screen is used to set the source channel outputs, the measurement ranging
mode, the sweep abort condition, the measurement channel A/D converter, the
series resistor, the filter, and the source output/measurement wait time.

This area defines the primary sweep source output.

Unit SMU used for the VAR1 output

Source Click the grid button to open the Define vector data dialog box.
See “Define vector data’ on page 2-18.

Compliance Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Pwr Comp Power compliance value (in W), or OFF

To define VARL/VAR2 step outputs

To define these parameters, create a vector data by using the Define vector data
dialog box which is opened by clicking the grid button in the vector data entry field.
See Figure 2-1.

Available array size for the vector datais as follows (column x row).

*  VARL1 step output value: Nq = 1 x 1001 maximum (initial setting: 1 x 1)
* VAR step output value: N5 = 1 x 1001 maximum (initial setting: 1 x 1)
» Deélay time: N3 =1 x 1001 maximum (initial setting: 1 x 1)

Then, the following formula must be satisfied.

1<NjxN,<128128

Agilent EasyEXPERT User’s Guide, Edition 1 2-15



VAR2

Timing

SMU Pulse

Classic Test Definition

I/V List Sweep

This area defines the secondary sweep source output.

Unit
Name

Sour ce

Compliance

Pwr Comp

SMU used for the VAR2 output
Variable name for the VAR2 output data

Click the grid button to open the Define vector data dialog box.
See “Define vector data’ on page 2-18.

Compliance value. Enter the current limit value for the voltage
source, or the voltage limit value for the current source.

Power compliance value (in W), or OFF

This area defines the hold time and the delay time. See “To Specify Source Output
Time” on page 4-62.

Hold

Delay

Hold time. Thisis the time from the beginning of channel
output to the beginning of delay time. 0to 655.35 s, 10 ms
resolution.

Delay time. Thisis the time between end of step changing and
the beginning of measurement. For thefirst step, thisisthetime
between the end of hold time and the beginning of
measurement. The measurement channels start measurement as
soon as the wait time elapses. 0to 65.535 s, 0.1 ms
resolution.Click the grid button to open the Define vector data
dialog box. See “ Define vector data” on page 2-18.

This area defines the SMU pulse setup parameters. See “SMU Pulse” on page 4-58.

Unit SMU used for the pul se output

Period Pulse period. Cannot set this value. SMU applies the pul se after
the delay time immediately.

Width Pulse width

Base Pulse base value
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Constant

Sweep status

Range

ADCl/Integ

Advanced

SPGU Pulse/
ALWG Setup

Classic Test Definition
I/V List Sweep

This area defines the constant output source.

Unit SMU used for the constant source

V Name Variable name for the constant voltage output or measurement
data

| Name Variable name for the constant current output or measurement
data

Mode Output mode, V (voltage), | (current), VPUL SE (voltage pulse),
or IPULSE (current pulse)

Source Output value

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.

Thisfield specifies the sweep abort condition. See “ Sweep Abort Function” on page
4-37.

This button opens awindow for setting the measurement ranging operation. See
“SMU Range Setup Window” on page 2-48.

This button opens awindow for setting the A/D converter of the measurement
channels. See “ADC and Integration Time Setup Window” on page 2-50.

This button opens awindow for setting other functions of the measurement channel.
See “ Advanced Setup Window” on page 2-53.

This button opens awindow used to set the SPGU output. See “ SPGU Pulse Setup
Window” on page 2-63 or “SPGU ALWG Setup Window” on page 2-67.
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Classic Test Definition
I/V List Sweep

Define vector data

This dialog box is opened by clicking the grid button in the vector data entry field.
See Figure 2-1. The vector data entry field can be displayed on the followings.

» Application test setup screen which contains the entry field for avector type test
parameter, on the EasyEXPERT main screen or the Test Definition window

» Test Specification setup screen which contains the definition of avector type test
parameter, on the Test Definition window

» Define symbols dialog box for avector type test parameter

The Define vector data dialog box displays the array defined by using the Define
dimensions dialog box opened from the Test Specification setup screen. Figure 2-1
shows the array created by setting DimiMin=1, Dim1Max=11, Dim2Min=1, and
Dim2Max=3, where Dim1 is the vertical direction (row) and Dim2 is the horizontal
direction (columns). The array index always starts from 1.

Figure 2-1 Vector Data Entry Field

B 15004 Semiconductor Device Anslgred
o ! Tiain Oy Hek

g e gﬂmlemwmwmv Bt Name: - [samle test parametar setup
i:&"&‘? | Vector data entry field
Elowesos | Grid button
g CtanoTech x| \
5 Ubrary | [Test Paranleters /
A / i
E Tmg vth o
Parami: Ii il I
@
st paramz: 0 &)

f.'? Param3: W LH -l

Define vector data

o] _ow |

NOTE Rotary knob and mouse wheel can be used to change the numeric valuein the
highlighted cell.

To delete column/row, highlight the line and press the Delete key.
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OK button

Cancel button

File menu

Edit menu

Mouse menu 1

Mouse menu 2

Classic Test Definition
I/V List Sweep

The Define vector data dialog box provides the following GUI.
Saves the vector data displayed on the dialog box and closes the dialog box.
Displays a confirmation message and closes the dial og box. Vector datais not saved.

Provides the following function.

Exit Displays a confirmation message and closes the dialog box.
Vector datais not saved.

Provides the following four functions.

Copy Copies the highlighted item to the clipboard.

Paste Pastes the data in the clipboard to the specified | ocation.
Delete Deletes the highlighted item.

Select All Selects and highlights all cellsin the array.

The following menus are displayed when the right mouse button is clicked on a cell.

Cut Moves the highlighted characters to the clipboard.
Copy Copies the highlighted characters to the clipboard.
Paste Pastes the data in the clipboard to the specified | ocation.

The following menus are displayed when the right mouse button is clicked on the
array display area.

Copy Copies the highlighted item to the clipboard.

Paste Pastes the data in the clipboard to the specified | ocation.

Insert Inserts arow before the selected row. Available when the row
header providesthe * button and arow header is selected.

Delete Deletes the highlighted item.

Select All Selects and highlights all cellsin the array.
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To import vector
data

To export vector
data

Classic Test Definition
I/V List Sweep

The Define vector datadialog box can import comma separated data (each data must
be separated by acomma, and have a CR/LF or LF at the end of each line) and tab
separated data (each data must be separated by atab, and have aCR/LF or LF at the
end of each line). The procedure for importing vector datais as follows.

1
2.
3.

Open avector datawith Notepad.
Copy the datain Notepad.

On the Define vector data dialog box, click acell to be used asthe top left corner
of the imported vector data.

Right click on the corner box between the column header and the row header,
and select Paste.

Thus, the Define vector data dialog box can read vector data created on a
spreadsheet software.

The Define vector data dialog box can export vector datain tab separated format.
The procedure for exporting vector datais as follows.

1.
2.
3.
4.

Highlight a vector data on the Define vector data dialog box.
Select Copy from the Edit menu or the mouse menu 2.
Create anew file in Notepad, and paste the vector data.
Savethe dataas afile.

The data can then be read by opening the file with a spreadsheet software.
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

NOTE

Classic Test Definition
I/V-t Sampling

|/V-t Sampling

On the EasyEXPERT main screen, click the Classic Test tab and select the I/V-t
Sampling icon. The main screen displays the I/V-t sampling test setup screen. For
details of the measurement mode, see “1/V-t Sampling Measurement” on page 4-13.

Used to set the name of test setup. The name must be the identification for the test
setup saved to a My Favorite group (preset group). Enter a unique name that is
distinct from other setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area

This tab displays the Channel Setup screen. See “Channel Setup” on page 2-22.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
2-23.

This tab displays the Function Setup screen. See “ Function Setup” on page 2-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 2-43.

This tab displays the Display Setup screen. See “Display Setup” on page 2-46.

If you set Interval < 0.002 s

Sampling mode must be linear. This setting is not permitted for the log sampling.

All measurement channels must use the high speed A/D converter (ADC). This
setting is not permitted if a measurement channel uses the high resolution ADC.

If the multiple measurement channels are used, all channels perform measurement
inparallel.

If the measurement ranging mode is not the fixed mode, the measurement channels
automatically select the minimum range that covers compliance value set to the
channel.

If the measurement time is expected to be longer than Interval, the measurement
channels automatically adjust the number of averaging samples (ADC settings) to
keep the sampling interval.
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Channel Definition

Miscellaneous
Variables

Classic Test Definition
I/V-t Sampling

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, measurement data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Unit Module used for the source output or measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data

Mode Output mode. For SMU, V (voltage), | (current), or COMMON

(ground). For SPGU, VPUL SE (voltage pulse) or ALWG
(arbitrary linear waveform voltage).

Add SMU Adds arow for the SMU channel setup.

Add SPGU Adds arow for the SPGU channel setup.

Delete Deletes the channel setup. To select the channel setup, use the
left radio button.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. The output stopsin the
opposite order. However, if the Output Sequenceis SIMULTANEOUS, the channels
start and stop output simultaneously.

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data gives the
time when step measurement is started.

Index Name Variable name of the dataindex. Integer above O is returned.
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Sampling
Parameter

Classic Test Definition
I/V-t Sampling

M easurement Setup

This setup screen is used to set the sampling timing parameters, constant
voltage/current outputs, and so on.

This area defines the sampling timing parameters.

Linear/Log

Interval

No of Samples

Total Sampling
Time

Output Sequence

Hold Time

Sampling mode. LINEAR for linear sampling. LOG10,
LOG25, LOG50, LOG100, LOG250, or LOG500 for
logarithmic sampling.

For the logarithmic sampling, the number after LOG indicates
the number of measurement datain a decade. For example,
LOG10 mode is used to get 10 data/decade.

Interval of the sampling, in seconds. 0.002 to 65.535 s, 0.001 s
resolution.

Interval < 0.002 sin 0.00001 s resolution is aso available for
the linear sampling. It must satisfy the following formula. See
NOTE on page 2-21.

Interval > 0.0001 + 0.00002 x (number of measurement
channels- 1)

Number of samples. Integer. 1 to the following value.
For linear: 100001 / (number of measurement channels)

For logarithmic: 1 + (number of datafor 11 decades)

Thisfield just displays the total sampling time that isthe time
from the measurement start time for the first point to the end of
sampling measurement. It does not include the hold time.

Total Sampling Time = Interval x No of Samples

Source output sequence. SIMULTANEOUS or SEQUENTIAL.
See “ Source Output Sequence and Time Origin” on page 4-18.

Time since the Source value output until the first sampling
point, in seconds. 0o 655.35 s, resolution 0.01 s.

The following values are also available for Interval < 0.002 s.
[Hold Time] will be the time since the sampling start until the
Source value output.

- 0.09 to - 0.0001 s, resolution 0.0001 s.
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Stop Condition

Constants

Classic Test Definition

I/V-t Sampling

Base Hold Time

Hold time of the Base value output until the Source value
output, in seconds. 0 to 655.35 s, resolution 0.01 s.

This area defines the sampling measurement stop condition. See “ Stop Condition”
on page 4-18 for this function.

Enable/Disable
Enable Delay

Name

Threshold

Event

No. of Events

Enables or disables the stop condition.

Delay time. in second. Thisis the time from starting sampling
measurement to enabling this function.

Name of measurement data or user function to monitor for stop
condition. Val of Event.

Threshold value at which to stop sampling measurement.
Th of Event.

Event for stop condition.

Val >Th True if Name parameter valueis greater
than Threshold value.

Val <Th True if Name parameter valueisless than
Threshold value.

[Val| > [Th| Trueif absolute Name parameter valueis

greater than absolute Threshold value.

[Val| < [Th] True if absolute Name parameter valueis
less than absolute Threshold value.

Target value of the count the event occurs (true). When the
count of true is this value, sampling isimmediately stopped.

This area defines the constant voltage/current source.

Unit SMU used for the constant source

V Name Variable name for the constant voltage output or measurement
data

| Name Variable name for the constant current output or measurement
data

Mode Output mode, V (voltage), or | (current)

Base, Source Base or Sourcevalue, inV or A.
0to+100V (HRSMU/MPSMU) or +200 V (HPSMU)
0to+0.1 A (HRSMU/MPSMU) or +1 A (HPSMU)
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Range

ADC/Integ

Advanced

SPGU Pulse /
ALWG Setup

Classic Test Definition
I/V-t Sampling

Base valueis available for al output channels for the
SIMULTANEOUS mode and the last source channel for the
SEQUENTIAL mode.

Compliance Compliance value, in A or V.
0to+0.1 A (HRSMU/MPSMU) or £1 A (HPSMU)
0to£100V (HRSMU/MPSMU) or 200 V (HPSMU)

This button opens awindow used to set the measurement ranging operation. See
“SMU Range Setup Window” on page 2-48.

This button opens awindow used to set the A/D converter of the measurement
channels. See “ADC and Integration Time Setup Window” on page 2-50.

This button opens awindow used to set the other functions of the measurement
channel. See “ Advanced Setup Window” on page 2-53.

This button opens awindow used to set the SPGU output. See “SPGU Pulse Setup
Window” on page 2-63 or “SPGU ALWG Setup Window” on page 2-67.

SPGU cannot be used for the sampling measurement of Interval < 0.002 s.
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

NOTE

Classic Test Definition
C-V Sweep

C-V Sweep

On the EasyEXPERT main screen, click the Classic Test tab and select the C-V
Sweep icon. The main screen displays the C-V sweep test setup screen.

For details of the measurement mode, see “C-V Sweep Measurement” on page 4-19.
Used to set the name of test setup. The name must be the identification for the test

setup saved to a My Favorite group (preset group). Enter a unique name that is
distinct from other setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area.

This tab displays the Channel Setup screen. See “ Channel Setup” on page 2-27.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
2-28.

This tab displays the Function Setup screen. See “Function Setup” on page 2-42.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 2-43.

This tab displays the Display Setup screen. See “Display Setup” on page 2-46.

Error Correction

Error correction must be performed before starting measurements. See “CMU
Calibration” on page 1-46 that explains the error correction GUI. There are four
techniques. For the easy way, perform the phase compensation and the open
correction.
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Channel Definition

Miscellaneous
Variables

Classic Test Definition
C-V Sweep

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data.

Unit Module used for the source output or measurement

V Name Variable name of voltage output or measurement data

| Name Variable name of current output or measurement data

Mode SMU output mode, V (voltage), | (current), or COMMON
(ground)

Function Output function, VAR1 (primary sweep) or CONST (constant)

Add Adds arow for the channel setup.

Delete Deletes the channel setup. To select the channel setup, use the
left radio button.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

If multiple output channels are defined, the channels start output sequentially. The
order istop to bottom of the channels defined in this screen. However the last output
channel is aways the MFCMU. The output stops in the opposite order.

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data gives the
time when step measurement is started.

Index Name Variable name of the data index. Integer above O is returned.
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C-V (VAR1)

Signal Source

Classic Test Definition

C-V Sweep

M easurement Setup

This setup screen is used to set the MFCMU measurement mode, source channel
outputs, the sweep abort condition, and the measurement time.

This area defines the MFCM U measurement mode and DC bias output.

V Name
M odel

paral Name
para2 Name

Direction

Linear/Log

Sart

Sop

Sep
Compliance

No of Step

Variable name of the DC bias output data

MFCMU measurement mode. Primary and secondary
measurement parameters. See Table 4-2 on page 4-21. Select
one from the pull-down menu.

Variable name of the primary measurement parameter
Variable name of the secondary measurement parameter

Sweep direction, single (start to stop) or double (start to stop to
start)

Sweep output, LINEAR, LOG10, LOG25, or LOG50. where
the number following LOG means the number of sweep points
in one decade.

Sweep start value
Sweep stop value
Incremental step value of the sweep output

Only for SMU. Compliance value. Enter the current limit value
for the voltage source, or the voltage limit value for the current
source.

Number of steps. The value is automatically calculated by using
the start, stop, and step values.

This area defines the measurement signal.

Frequency List  Fregquency of the measurement signal

F Name Variable name of the frequency data

AC Leve Oscillator level of the measurement signal, 10 mV to 250 mV, 1
mV resolution

Add Adds a measurement frequency.

Delete Deletes the selected frequency. To select the frequency, use the
left radio button.

2-28 Agilent EasyEXPERT User’s Guide, Edition 1



Integration Time

Timing

Constant

Sweep status

Range

ADCl/Integ

Advanced

Classic Test Definition

C-V Sweep
Up Moves the selected frequency upward.
Down Moves the selected frequency downward.
This area setsthe A/D converter of MFCMU.
Mode A/D converter operation mode, AUTO or PLC
Factor Factor for the initial value. See “Mode, Factor” on page 4-20.

This area defines the hold time and the delay time. See “To Specify Source Output
Time” on page 4-62.

Hold Hold time. Thisisthe time from beginning of channel output to
beginning of delay time. 0to 655.35 s, 10 ms resolution.

Delay Hold time. Thisisthe time from end of hold time to beginning
of measurement. The MFCMU starts measurement as soon as
the wait time elapses. 0 to 655.35 s, 0.1 ms resol ution.

This area defines the constant voltage/current source.

Unit SMU used for the constant source

V Name Variable name for constant voltage output or measurement data
| Name Variable name for constant current output or measurement data
Mode Output mode, V (voltage), | (current), or COMMON (ground).

Source Output value

Compliance Compliance value. Enter the current limit value for the voltage

source, or the voltage limit value for the current source.

Thisfield specifies the sweep abort condition. See “ Sweep Abort Function” on page
4-37.

This button opens awindow used to set the measurement ranging operation. See
“Range Setup Window” on page 2-55.

This button opens awindow used to set the A/D converter of the SMU measurement
channels. See “ADC and Integration Time Setup Window” on page 2-50.

This button opens awindow used to set the other functions of the measurement
channel. See“ Advanced Setup Window for C-V Sweep” on page 2-57.
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Setup Name

Channel Setup

Measurement
Setup

Function Setup

Auto Analysis
Setup

Display Setup

Classic Test Definition
Direct Control

Direct Control

On the EasyEXPERT main screen, click the Classic Test tab and select the Direct
Control icon. The main screen displays the Direct Control test setup screen.

Direct Control test mode performs measurement by controlling measurement
resources, SMU, CMU, and SPGU directly. The instrument can be controlled by
using GPIB commands. For the GPIB commands, see Agilent B1500 Programming
Guide.

Available GPIB commands are listed in the Command pull-down menu on the
M easurement Setup screen. Other commands are not supported by the Direct
Control test.

Sets the name of the test setup. The nameis used to identify the test setup savedto a
My Favorite group (preset group). Enter a unique name that is distinct from other
setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area

This tab displays the Channel Setup screen. See “ Channel Setup” on page 2-31.

Thistab displays the Measurement Setup screen. See “Measurement Setup” on page
2-33.

This tab displays the Function Setup screen. See “Function Setup” on page 2-42.

If Agilent B2200A/B2201A/E5250A switching matrix is used, the CMU
measurement data should be compensated. To perform the compensation, define a
user function by using the “compenReZ” and “compenimZ” functions or the
“compenReY” and “compenimY” functions.

Thistab displays the Auto Analysis Setup screen. See “Auto Analysis Setup” on
page 2-43.

This tab displays the Display Setup screen. See “Display Setup” on page 2-46.
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Channel Definition

Additional Data
Variables

Miscellaneous
Variables

Classic Test Definition
Direct Control

Channel Setup

This setup screen is used to define the channel setups and the variables for the
channel output data, measurement data, time stamp data, and index data.

This area defines the channel setups and the variables for the channel output data
and the measurement data.

Unit Module used for the source output or measurement

V Name Variable name of DC voltage output or measurement data

| Name Variable name of DC current output or measurement data

Add SMU Adds arow for the SMU channel setup.

Add CMU Adds arow for the CMU channel setup.

Add SPGU Adds arow for the SPGU channel setup.

Delete Deletes the selected channel setup. To select a channel setup,
use the radio button on the | eft.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

This area defines the variables for the measurement data other than DC voltage and
DC current which can be defined in Channel Definition.

Unit Unit (SMU or CMU) used for the measurement

Type Type of measurement data. See Table 2-1.

Name Variable name of the measurement data

Add Adds arow for the measurement variable.

Delete Del etes the selected measurement variable. To select avariable,

use the radio button on the | eft.

This area defines the variables for the time stamp data and the index data.

Time Samp Name  Variable name of the time stamp. Time stamp data indicates
the time at which step measurement was started.

Index Name Variable name of the dataindex. Integer above O is returned.
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Classic Test Definition
Direct Control

Table 2-1 Available Type Valuesfor M easurement Data Variables
Type Description

SMU Quasi-Static C SMU capacitance measurement data (F)
CMU Re(2) CMU resistance measurement data (Q2)
CMU Im(2) CMU reactance measurement data (Q2)
CMU Re(Y) CMU conductance measurement data (S)
CMU IM(Y) CMU susceptance measurement data (S)
CMU Frequency CMU output signal frequency data (Hz)
CMU AC Level Output Data | CMU oscillator level output data (Vac)
CMU DC Bias Monitor Data | CMU DC bias monitor data (Vdc)
CMU AC Level Monitor Data | CMU oscillator level monitor data (Vac)
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Advanced

Command Setup

Classic Test Definition
Direct Control

M easurement Setup

This setup screen is used to define GPIB commands for controlling the SMU and
CMU directly, and is used to set the SMU seriesresistor, the SMU filter, and the bias
hold function.

This button opens awindow for setting the SMU series resistor, the SMU filter, and
the bias hold function. See “Advanced Setup” on page 2-34.

This area defines GPIB commands for controlling the SMU and CMU directly.

Command Select the command or function from the pull-down menu. See
“Command Setup” on page 2-36.

Arguments Enter the command parameter. To enter multiple parameters,
insert acomma (,) between parameters. Multiple spaces can be
inserted before and after the comma.

All parameters should be entered. If an optional parameter is
abbreviated, theinitial value may be set, the last used value may
be reused, or no value may be set. The result is unique and
depends on the command. For a description of each command,
see Agilent B1500 Programming Guide.

The parameter can be a numeric variable or a numeric
expression with fundamental arithmetic operations.

In an application test definition, the parameter can be anumeric
type test parameters, device parameters, or Symbol.

If theinternal variable is used, it must be used as a string
variable. For example, the variables must be entered as follows.

“%I1", “%R1", “%R2”

Ignore Check this box to comment out this command line.

Add Adds arow for the command setup.

Delete Deletes the selected command setup. To select acommand
setup, use the radio button on the left.

Up Moves the selected command setup upward.

Down Moves the selected command setup downward.
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Options

Channel Settings

After Measurement
Setting

Semiconductor
Relays (16440A
SMU/PG Selector)

Classic Test Definition
Direct Control

Advanced Setup

Thiswindow is opened by clicking the Advanced button on the Direct Control
Measurement Setup screen, and is used to set the SMU series resistor, the SMU
filter, and the bias hold function.

The following setup is available.

Primary Setup Primary setup ON or OFF.

If Primary Setup=ON, the primary setup is applied to the instrument when the
Direct Control test is started. For the setup condition, see “Primary Setup” on page
2-35.

If Primary Setup=OFF, the primary setup is not applied. Set the Primary Setup to
OFF if asetup exists and is proven to problem-free for running atest with. The test
execution time can be reduced by this setting.

This area sets the series resistor and the filter.

Unit SMU used for the measurement

VName Variable name of voltage output or measurement data

IName Variable name of current output or measurement data

SeriesR Seriesresistor NONE or IMOHM . See“SMU Series Resistor”
on page 4-66.

SMU Filter SMU filter ON or OFF. See“SMU Filter” on page 4-65.

This area sets the bias hold function for maintaining the source output after
measurement. The source module applies the specified bias between two
consecutive measurements of arepeated measurement or quick test. See“BiasHold
Function” on page 4-41.

BiasHold after Measurement Bias hold function ON or OFF
Effective only for the instrument installed with SPGU or PGU. Agilent 16445A
selector adapter is needed for connecting Agilent 16440A SMU/PG selector.

This area sets the selector CH1/CH3 status (DEFAULT or PGU OPEN). To use this
function, set the DEFAULT setting to Always SMU or Normally PGU (AUX) by
using the SMU/PG Selector tab screen on the Configuration window before starting
the SPGU output.

CH1 CH1 status, DEFAULT or PGU OPEN.
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Classic Test Definition
Direct Control

CH3 CH3 status, DEFAULT or PGU OPEN.

CH1 represents channel 1 on the first selector and CH3 represents channel 1 on the
second selector. See “ SMU/PG Selector” on page 4-49 for details on the selector.

Primary Setup

Primary setup istheinitial setting set for when the Direct Control test is started. This
setting is different from the initial setting set by the device clear or the *RST
command. The differences are listed below.

« Dataoutput format

FMT 13, 0 is set.
* Program memory

Setup is hot changed. The last used setting is retained.
* Internal variables

Setup is hot changed. The last used setting is retained.
» Measurement condition setup commands

Setup is not changed for the following commands. The last used setting is
retained.

MM
WV, WI, WSV, WSI, WNX

PV, PI, PWV, PWI

BDV

QSV, QSO

LGI,LGV, LS, LSV, LSSI, LSSV
BGI, BGV, BSI, BSV, BSSI, BSSV
FC, WDCV

PDCV, PWDCV

WFC

WACV

MDCV
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Table 2-2

Classic Test Definition

Direct Control

Command Setup

To define the Command Setup, set acommand or a function to the Command field,
and enter the command parameters to the Argument field. Also, be aware of the

following note.

FMT command'sfirst parameter must be 13.

» Usethe Unit value of Channel Setup to specify the channel.
» Usethe ReadDataBuffer function to read measurement data.

» Program memory number must be within the range of 1 to 1000.

» SCR command parameter cannot be abbreviated.

* VAR command's second parameter must be within the range of 1 to 40. Hence,
internal variables %l 1 to %140 and %R1 to %R40 are available.

A setup exampleis shown in Table 2-2. This example uses SMUL to performs
voltage output and current spot measurement.

Command Setup Example

Command Arguments Description
FMT 13,0 Sets the data output format.
MM 1, SMUL:HP Sets the measurement mode.
TSC 1 Enables the time data output.
AV 10,1 Sets the number of averaging.
DV SMU1:HR 0, 1.5, Forcesthe DC voltage.
0.1
CMM SMUZL:HP 0 Sets the SMU operation mode.
RI SMUL:HP, 0 Sets the current measurement range.
TSR Resets the timer.
XE Starts the measurement.
ReadDataBuffer | 1 Reads the measurement data.
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Syntax

Parameters

Example

Classic Test Definition
Direct Control

ReadDataBuffer

This function reads the measurement data. The number of data blocksto beread is
specified by the count parameter. If count is abbreviated, this function reads one
data block.

ReadDat aBuf f er [count]

count Number of data blocks or the number of terminatorsto be read.
A datablock is agroup of datathat ends with aterminator. For
the data output format, see Agilent B1500 Programming Guide.

The following example performs three high speed spot measurements and then
reads three measurement data blocks.

Command Arguments Description

TI 1,0 Measurement channel 1 performsthe high
speed spot measurement.

TI 2,0 Measurement channel 2 performs the high
speed spot measurement.

TI 3,0 Measurement channel 3 performs the high
speed spot measurement.

ReadDataBuffer | 3 Reads three measurement data bl ocks.

NOTE

NOTE

The data output buffer is cleared when the Direct Control test is started.

If aSMU performs the force side measurement operation and the source data output
isenabled (by the FMT command), the SMU’s source datais deleted and the SMU’s
measurement datais stored instead of the source data. The force side measurement
operation is the SMU operation which performs the voltage force and voltage
measurement or the current force and current measurement.
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Classic Test Definition
Direct Control

compenReZ

This built-in function performs compensation on the specified impedance data and
returns the real data for the compensation resullts.

Thisfunction is effective for the CMU measurement data compensation while the
switching matrix is used with the CMU to extend the measurement terminals.
Define the compenReZ and compenimZ functions as the user functions on the
Function Setup screen, so that the compensation is performed while the Direct
Controal test is being executed. Also enter the formula to calculate the measurement
parameters. An example definition is shown in Figure 2-2. For the equations, see

“ About Impedance Measurements” on page 4-22.

Syntax conpenReZ(frequency, Real , | magi nary)

Parameters frequency M easurement frequency. Hz. Numeric scalar or vector data.

For the C-f measurement data, frequency should be a vector
variable that stores multiple frequency values.

Real CMU Re(Z) measurement result data. Q2. Numeric vector data.

Real should be a vector variable that stores the impedance real
data before compensation.

Imaginary CMU Im(Z) measurement result data. Q2. Numeric vector data.
Imaginary should be avector variable that stores the impedance
imaginary data before compensation.
Example Name Rconpen
Definition compenReZ( Freq, ReZ, | n¥)

Rcompen returns the impedance real data for the compensation results.
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Syntax

Parameters

Example

Classic Test Definition
Direct Control

compenimZ

This built-in function performs compensation on the specified impedance data and
returns the imaginary data for the compensation results.

Thisfunction is effective for the CMU measurement data compensation while the
switching matrix is used with the CMU to extend the measurement terminals.
Define the compenReZ and compenimZ functions as the user functions on the
Function Setup screen, so that the compensation is performed while the Direct
Controal test is being executed. Also enter the formula to calculate the measurement
parameters. An example definition is shown in Figure 2-2. For the equations, see

“ About Impedance Measurements” on page 4-22.

conpenl nZ(frequency, Real , | magi nary)

frequency M easurement frequency. Hz. Numeric scalar or vector data.

For the C-f measurement data, frequency should be a vector
variable that stores multiple frequency values.

Real CMU Re(Z) measurement result data. Q2. Numeric vector data.

Real should be a vector variable that stores the impedance real
data before compensation.

Imaginary CMU Im(Z) measurement result data. Q2. Numeric vector data.
Imaginary should be avector variable that stores the impedance
imaginary data before compensation.

Name Xcompen

Definition compenl nZ( Freq, ReZ, | n¥)

Xcompen returns the impedance imaginary data for the compensation results.
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Syntax

Parameters

Example

Figure 2-2

Classic Test Definition
Direct Control

compenReY

This built-in function performs compensation on the specified admittance data and
returns the real data for the compensation resullts.

Thisfunction is effective for the CMU measurement data compensation while the
switching matrix is used with the CMU to extend the measurement terminals.
Define the compenReY and compenimY functions as the user functions on the
Function Setup screen as shown in Figure 2-2, so that the compensation is
performed while the Direct Control test is being executed. Also enter the formulato
calculate the measurement parameters. For the equations, see “ About Impedance
Measurements” on page 4-22. Figure 2-2 defines the following formulato calculate
capacitance.

C=ImY/(2xPlIxFreq)

conpenReY(frequency, Real , | magi nary)

frequency M easurement frequency. Hz. Numeric scalar or vector data.

For the C-f measurement data, frequency should be a vector
variable that stores multiple frequency values.

Real CMU Re(Y) measurement result data. S. Numeric vector data.

Real should be a vector variable that stores the admittance real
data before compensation.

Imaginary CMU Im(Y) measurement result data. S. Numeric vector data.
Imaginary should be avector variable that stores the admittance
imaginary data before compensation.

Name Gconpen

Definition compenReY( Freq, ReY, | nY)

Gcompen returns the admittance real data for the compensation results.

Function Setup Example

R [
Name: Unit: Definition:

ol [T = x|[3.1415 ]

‘& iIm‘r‘ glohm j |compenIm‘r’[Fl'eq,G,B} E]

r IRe‘r‘ §|0hm _vJ|CD|11|JEI1RE‘T'I:FI'EE|,G,B] E

& I = |F _x|[tmivf(2*PI*Freq) E]
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Syntax

Parameters

Example

Classic Test Definition
Direct Control

compenlmY

This built-in function performs compensation on the specified admittance data and
returns the imaginary data for the compensation results.

Thisfunction is effective for the CMU measurement data compensation while the
switching matrix is used with the CMU to extend the measurement terminals.
Define the compenReY and compenimY functions as the user functions on the
Function Setup screen as shown in Figure 2-2, so that the compensation is
performed while the Direct Control test is being executed. Also enter the formulato
calculate the measurement parameters. For the equations, see “ About Impedance
Measurements” on page 4-22. Figure 2-2 defines the following formulato calculate
capacitance.

C=ImY/(2xPlIxFreq)

conpenl nY(frequency, Real , | magi nary)

frequency M easurement frequency. Hz. Numeric scalar or vector data.

For the C-f measurement data, frequency should be a vector
variable that stores multiple frequency values.

Real CMU Re(Y) measurement result data. S. Numeric vector data.

Real should be a vector variable that stores the admittance real
data before compensation.

Imaginary CMU Im(Y) measurement result data. S. Numeric vector data.
Imaginary should be avector variable that stores the admittance
imaginary data before compensation.

Name Bconpen

Definition compenl mY( Fr eq, ReY, | nY)

Bcompen returns the admittance imaginary data for the compensation results.
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Apply

User Function,
Analysis Function

Classic Test Definition
Function Setup

Function Setup

This setup screen is displayed by clicking the Function Setup tab of the 1/V Sweep /
Multi Channel 1/V Sweep / 1/V List Sweep / I/V-t Sampling / C-V Sweep / Direct
Control test setup screen, and is used to set the user function and the analysis
function.

Calculation of the function is automatically performed after measurement. And the
functions defined in the Display Setup screen will be displayed on the Data Display
window. The user functions are available for the X-Y Graph Plot, List Display, and
Parameters area. The analysis functions are available for the Parameters area.

This button performs calculation of the definition in this screen. If this button is
clicked when the Data Display window associated with this test has been opened,
the display is also updated.

The associated Data Display window will be the Data Display window that displays
the last measurement data or that isrecalled at last.

The User/Analysis Function area sets the user/analysis functions effective for the
test. Up to 20 functions can be set. The user function result is referable from the
other user function defined in the following lines. The analysis function result is
referable from the other analysis function defined in the following lines.

Name Function name
Unit Unit of the function
Definition Definition of the function. The following identifiers can be used.

» Variables for the measurement/output data used in this test
» Functions defined in the above lines

» Local variables passed from the application test that calls this
test as a component

» Built-in functions and global variables
» Read out functions (hot available for the user functions)
Also see Chapter 5, “Built-in Programming Tool.”

Add, Delete  Addsafunction, or deletes the selected function. To select the
function, use the left radio button.

Up, Down Moves the selected function upward or downward.
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Apply

Interpolation Mode

Line 1, Line 2

Classic Test Definition
Auto Analysis Setup

Auto Analysis Setup

This setup screen is displayed by clicking the Auto Analysis Setup tab of the I/V
Sweep / Multi Channel 1/ Sweep / I/V List Sweep / 1/V-t Sampling / C-V Sweep /
Direct Control test setup screen, and is used to set the automatic analysis function.
When a measurement finishes, the function automatically draws lines, a marker, or
both on the X-Y Graph of the Data Display window.

You can set up two lines and one marker for the automatic analysis function.
IntheLine 1 and Line 2 areas, you can set up the lines to be drawn.

In the Marker area, you can set up the marker.

This button performs calculation of the definition in this screen. If this button is

clicked when the Data Display window associated with this test has been opened,
the display is also updated.

The associated Data Display window will be the Data Display window that displays
the last measurement data or that isrecalled at last.

Check this box to enable the interpolation mode. You can position marker between
measurement points.

Thisareasetstheline 1 or line 2 automatically displayed and moved to the specified
position after the measurement.

Enable Check this box to enable the line.

Fix Check this box to fix the line on the graph after the auto
analysis is performed. Remove the check to make the line free.

Type Select one of the available line types listed below.

Axis Axis effective for the line. Specify onefromY1to Y8.

First Point See the following description for the line you selected.

Second Point See the following description for the line you selected.
Available line types:

*  “Normal line": For drawing a line between any two points.

» “Gradient line": For drawing aline through any point with a specified gradient.

» “Tangent line": For drawing atangent line to a measurement point.
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Marker

Normal line

Gradient line

Classic Test Definition
Auto Analysis Setup

» “Regressionling’: For drawing aregression line by using the measurement data
included in the area specified by any two points.

This area sets the marker automatically displayed and moved to the specified
position after the measurement.

Enable Check this box to enable the marker.

Condition Enter a variable name and a condition expression to specify
where you want the marker to appear.

After Check this box to enable the additional condition.

Enter a second variable and condition expression. Thissetsup a
search start condition for finding specified point.

For example, you can specify the following expressionsto search for a measurement
point that satisfies the first condition after the second condition is satisfied.

Condition:] DGM]=[MAX(DGM)*0.01] [x] After [DGM]=[MAX(DGM)]

The First Point area and the Second Point area are used to specify the pointsthe line
passes through. The following two ways are available to specify the point.

* X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition
Enter a variable name and condition expression to specify the point. Thisis the

same method as specifying the Marker point.

The First Point areais used to specify the point the line passes through. The
following two ways are available to specify the point.

» X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition

Enter a variable name and condition expression to specify the point. Thisisthe
same method as specifying the Marker point.

In the Gradient field, enter agradient value or expression.
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Classic Test Definition
Auto Analysis Setup

Tangent line The First Point areais used to specify the measurement point the tangent line passes
through.

Enter avariable name and condition expression to specify the point. Thisisthe same
method as specifying the Marker point.

Regression line The First Point area and the Second Point area are used to specify the range of the
measurement data used for the regression calculation. The following two ways are
available to specify the point.

* X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition

Enter a variable name and condition expression to specify the point. Thisis the
same method as specifying the Marker point.
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X-Y Graph

List Display,
Parameters

Classic Test Definition
Display Setup

Display Setup

This setup screen is displayed by clicking the Display Setup tab of the I/V Sweep /
Multi Channel 1/V Sweep / 1/V List Sweep / I/V-t Sampling / C-V Sweep / Direct
Control test setup screen or by checking the Define own Output Parameters box on
the Test Definition window, and is used to set the test result output.

Selects the data to be displayed in the X-Y Graph Plot area. The X and Y1to Y8
axes can be set.

Name Specifies the parameter for the axis.

Sharing Specifies the group for sharing the Y axis scale. Select from
Group 1, Group 2, Group 3, Group 4, or None (no grouping).

The Scale, Min, and Max values are shared by the Y axesin the
same group. The scale set by Run Time Auto Scale, Auto Scale,
Zoom in, and/or Zoom out are also shared.

If another layer on the Data Display window contains an X-Y
trace which has the same name for both its grouped Y
parameter and its X parameter, the scaling will also be shared
by this X-Y trace.

Scale Scale of the axis, Linear or Log

Min Minimum value of the axis

Max Maximum value of the axis

Add Adds a parameter (or axis).

Delete Deletes the parameter selected with the radio button on the left.
Up Moves the selected parameter upward.

Down Moves the selected parameter downward.

Selectsthe datadisplayed in the List Display areaor the Parameters area of the Data
Display window. Up to 20 parameters can be set for each area.

parameter Specifies the parameter for the data output.
Add Adds arow for the parameter.
Delete Deletes the selected parameter. To select the parameter, use the

|eft radio button.
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Classic Test Definition
Display Setup

Up Moves the selected parameter upward.

Down Moves the selected parameter downward.
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Classic Test Definition
SMU Range Setup Window

SMU Range Setup Window

Thiswindow is opened by clicking the Range button on the I/V Sweep / Multi
Channel 1/V Sweep / I/V List Sweep / 1/V-t Sampling M easurement Setup screen,
and is used to set the measurement ranging operation.

For the measurement ranging function, see “SMU Ranging Mode” on page 4-51.

Unit SMU used for the measurement
Name Variable name for the measurement data
Mode Ranging mode, AUTO (auto ranging), LIMITED (limited auto

ranging), or FIXED (fixed range)

Range Range value. For auto ranging, ignore this field. For limited
auto ranging, the measurement channel never uses ranges less
than the specified range.

Range Change

Ruleand Rate Not avail able for voltage measurement or fixed ranging. See
also “Enhanced Auto Ranging for Current Measurement” on
page 4-54.

Available Range Change Rule valuesare BY FULL RANGE,
GO UP AHEAD, and UP AND DOWN AHEAD.

BY FULL RANGE performs normal auto ranging operation.

For the GO UP AHEAD and UP AND DOWN AHEAD rules,
specify the Rate value, 11 to 100, which fixes the boundary of
the ranging. The ranging occurs when the measurement data
goes across the boundary values shown below.

go up boundary = present measurement range x Rate/ 100
go down boundary = present measurement range x Rate/ 1000

The go down boundary is available only for the UP AND
DOWN AHEAD rule.

Up Moves the selected measurement channel setup upward.
Down Moves the selected measurement channel setup downward.

If multiple measurement channels are defined, the channels perform measurement
sequentially. The order istop to bottom of the channels defined in this screen. For
exceptions and details, see “Multiple Measurement Channels’ on page 4-64.
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Classic Test Definition
SMU Range Setup Window

NOTE To use 1 pA range, only for B1500A

The measurement channel connected to the ASU (Atto Sense and Switch Unit)
supportsthe 1 pA range. To usethe 1 pA range, set the 1 pA fixed range or the 1 pA
limited auto ranging.

The B1500A automatically performs the compensation of the data measured by the
1 pA range and returns the compensated data. You can use either the pre-stored
offset data or the pre-measured offset data.

To measure the offset data, perform the self-calibration before starting the
measurement for a DUT. This offset data is temporarily memorized until the
B1500A is turned off.
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A/D Converter

Integration Time

Pulse Averaging
Count

Classic Test Definition
ADC and Integration Time Setup Window

ADC and Integration Time Setup Window

Thiswindow is opened by clicking the ADC/Integ button on the I/V Sweep / Multi
Channel 1/V Sweep / I/V List Sweep / 1/V-t Sampling / C-V Sweep Measurement
Setup screen, and is used to set the A/D converter of the SMU measurement
channels.

This area selects the ADC type and enables/disabl es the auto zero function. See
“Integration Time” on page 4-60.

Unit SMU used for the measurement

Name Variable name for the measurement data

ADC ADC type, HR ADC (high resolution ADC) or HS ADC (high
speed ADC)

HR ADC is not available for HCSMU and HVSMU. Also it is
not available for the measurements using SMU pul se.

M easurement Compliance Side only, or both Force and Compliance Sides
Force and Compliance Sdesis not available for HRSMU,
MPSMU, and HPSMU.

This area sets the ADC mode and its factor for each ADC type.

Mode ADC operation mode
AUTO, MANUAL, or PLC for High Resolution ADC
AUTO, MANUAL, PLC, or TIME for High Speed ADC
TIME or PLC for the measurements using SMU pulse.

Factor Factor value. Factor value of “Integration Time” on page 4-60.

Auto Zero Auto zero function ON or OFF. Only for the high resolution
ADC. See“ADC Zero Function” on page 4-61.

This area sets the averaging of the pulsed measurement. Not effective for HRSMU,
MPSMU, and HPSMU. The Count value is automatically set to the same value as
the Count value on the Pulse Setup window for using multiple SMU pulse output
channels.

Count Number of pulsed measurements for averaging to get one
measurement data.
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Common

Integration Time

Classic Test Definition
Pulse Setup Window

Pulse Setup Window

Thiswindow is opened by clicking the Pulse button on the Multi Channel 1/V
Sweep Measurement Setup screen, and is used to set the SMU pul se setup
parameters. The setup parameters are different by the number of the pulse output
channels as shown below. For the SMU pulse setup parameters, see“ SMU Pulse”
on page 4-58.

Tousea SMU for pulse output

The followings are the setup parameters to use a SMU for pulse output.

Unit SMU used for the pulse output

Period Pulse period. Entering AUTO sets the optimum value
automatically.

Width Pulse width

Base Pulse base value

To usemultiple SMU for pulse output

The followings are the setup parameters to use multiple SMU for pulse output.

The following parameters are common to the all pulse output channels.

Period Pulse period. Entering AUTO sets the optimum value
automatically.

M easurement

Delay Time Delay time from the beginning of the pulse period to the

beginning of the measurement. Entering AUTO setsthe
optimum value automatically so that the measurement is
completed when the transition from peak to base is started by
the pulse output channel which starts the transition at first.

The following entry fields are available for setting the high speed ADC. High
resolution ADC is not available for this measurement.
Mode ADC operation mode, TIME or PLC

Factor Factor value. Factor value of “Integration Time” on page 4-60.
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Classic Test Definition
Pulse Setup Window

Pulse Averaging The following parameter sets the averaging of the pulsed measurement. The Count
Count value works with the Count value on the ADC and Integration Time Setup window.

The Count value is not effective for HRSMU, MPSMU, and HPSMU.

Count Number of pulsed measurements for averaging to get one
measurement data.

Pulse Channels The followings are the pulse setup parameters set to the pulse output channels
individually.
Unit SMU used for the pulse output
Name Variable name for the pulse voltage output data or the pulse

current output data

Pulse Delay Time Delay time from the beginning of the pulse period to the
beginning of the transition from base to peak. This value must
be 0 for HRSMU, MPSMU, and HPSMU.

Width Pulse width. This value must be the same for HRSM U,
MPSMU, and HPSMU.

Base Pulse base value
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Channel Settings

Wait Time Control

After Measurement
Settings

Classic Test Definition
Advanced Setup Window

Advanced Setup Window

Thiswindow is opened by clicking the Advanced button on the I/V Sweep / Multi
Channel 1/V Sweep / I/V List Sweep / 1/V-t Sampling Measurement Setup screen,
and is used to set the following functions of the measurement channel.

This area sets the series resistor and the filter.

Unit SMU used for the measurement
VName Variable name of voltage output or measurement data
IName Variable name of current output or measurement data
SeriesR Seriesresistor NONE or IMOHM. See“SMU Series Resistor”
on page 4-66.
SMU seriesresistor is not available for HCSMU and HVSMU.
SMU Filter SMU filter ON or OFF. See“SMU Filter” on page 4-65.

This area setsthe source output wait time and the measurement wait time. See “ Wait
Time” on page 4-63. The Output Wait sets the source output wait time. The
Measurement Wait sets the measurement wait time.

Factor Factor value. 0 to 10, 0.1 resolution. Thisis the N value shown
in“Wait Time” on page 4-63.

This area sets the bias hold function used to keep the source output after
measurement. The source module applies the specified bias between a measurement
and the next measurement performed in the repeat measurement or quick test. See
“Bias Hold Function” on page 4-41.

BiasHold after

M easurement Bias hold function ON or OFF
Output Valueafter

M easurement Source output value after measurement

START (sweep start value), STOP (sweep stop vaue),
SOURCE (sampling output source value), or BASE (sampling
output base value)
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Semiconductor
Relays (16440A
SMU/PG Selector)

Classic Test Definition
Advanced Setup Window

Effective only for the instrument installed with SPGU or PGU. Agilent 16445A
selector adapter is needed for connecting Agilent 16440A SMU/PG selector.

This area sets the selector CH1/CH3 status (DEFAULT or PGU OPEN). To use this
function, set the DEFAULT setting to Always SMU or Normally PGU (AUX) by
using the SMU/PG Selector tab screen on the Configuration window before starting
the SPGU output.

CH1 CH1 status, DEFAULT or PGU OPEN.
CH3 CHS3 status, DEFAULT or PGU OPEN.

CH1 represents channel 1 on the first selector and CH3 represents channel 1 on the
second selector. See “ SMU/PG Selector” on page 4-49 for details on the selector.
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CMU Measurement
Range

Table 2-3

SMU Measurement
Range

Classic Test Definition
Range Setup Window

Range Setup Window

Thiswindow is opened by clicking the Range button on the C-V Sweep
Measurement Setup screen, and is used to set the measurement ranging operation.

This area sets the CMU measurement ranging operation.

Unit
Mode

Range

CMU used for the measurement

Ranging mode, AUTO (auto ranging) or FIXED (fixed range).
If Mode=AUTO, the MFCMU automatically searches for and
measures at the range that provides the best resolution.

If Mode=FIXED, the MFCMU measures at the range specified
by the Range field.

Measurement range. Thisfieldis effective when Mode=FIXED.
Available measurement ranges depend on the measurement
frequency setting. See Table 2-3.

Available M easurement Ranges

Frequency Available measurement ranges

< 200kHz | 509, 100 2, 300 Q, 1 kQ, 3kQ, 10 k2, 30 k2, 100 k2, 300 kQ
< 2MHz | 500,100 Q, 300 Q, 1 kQ, 3k, 10 kQ, 30 kQ

< 5MHz | 509, 100 Q, 300 Q, 1 kQ, 3k

This area sets the SMU measurement ranging operation.

For the measurement ranging function, see “SMU Ranging Mode” on page 4-51.

Unit
Name
Mode

Range

SMU used for the measurement
Variable name for the measurement data

Ranging mode, AUTO (auto ranging), LIMITED (limited auto
ranging), or FIXED (fixed range)

Range value. For auto ranging, ignore this field. For limited
auto ranging, the measurement channel never uses ranges less
than the specified range.
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NOTE

Classic Test Definition
Range Setup Window

Range Change

Ruleand Rate Not available for voltage measurement or fixed ranging. See
also “Enhanced Auto Ranging for Current Measurement” on
page 4-54.

Available Range Change Rule values are BY FULL RANGE,
GO UP AHEAD, and UP AND DOWN AHEAD.

BY FULL RANGE performs normal auto ranging operation.

For the GO UP AHEAD and UP AND DOWN AHEAD rules,
specify the Rate value, 11 to 100, which fixes the boundary of
the ranging. The ranging occurs when the measurement data
goes across the boundary values shown bel ow.

go up boundary = present measurement range x Rate/ 100
go down boundary = present measurement range x Rate/ 1000

The go down boundary is available only for the UP AND
DOWN AHEAD rule.

Up Moves the selected measurement channel setup upward.
Down Moves the selected measurement channel setup downward.

If multiple measurement channels are defined, the channels perform measurement
sequentially. The order istop to bottom of the channels defined in SMU
Measurement Range. For exceptions and details, see “Multiple Measurement
Channels’ on page 4-64.

To use 1 pA range, only for B1500A

The measurement channel connected to the ASU (Atto Sense and Switch Unit)
supportsthe 1 pA range. To usethe 1 pA range, set the 1 pA fixed range or the 1 pA
limited auto ranging.

The B1500A automatically performs the compensation of the data measured by the
1 pA range and returns the compensated data. You can use either the pre-stored
offset data or the pre-measured offset data.

To measure the offset data, perform the self-calibration before starting the
measurement for a DUT. This offset data is temporarily memorized until the
B1500A is turned off.
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AC Level/DC Bias
Monitor Settings

Channel Settings

Wait Time Control

After Measurement
Settings

Classic Test Definition
Advanced Setup Window for C-V Sweep

Advanced Setup Window for C-V Sweep

Thiswindow is opened by clicking the Advanced button on the C-V Sweep
M easurement Setup screen, and is used to set the following functions.

This areadefines the variables for the AC level data and the DC bias data monitored
by the CMU while the capacitance measurement is performed.

Unit CMU used for the measurement

AC Level Monitor

Name Variable name of the AC level monitor data
DC Bias M onitor

Name Variable name of the DC bias monitor data

This area sets the SMU seriesresistor and the SMU filter.

Unit SMU used for the measurement
VName Variable name of voltage output or measurement data
IName Variable name of current output or measurement data
SeriesR Seriesresistor NONE or IMOHM. See“SMU Series Resistor”
on page 4-66.
SMU seriesresistor is not available for HCSMU and HVSMU.
SMU Filter SMU filter ON or OFF. See“SMU Filter” on page 4-65.

This area sets the source output wait time and the measurement wait time of SMU.
See “Wait Time” on page 4-63. The Output Wait sets the source output wait time.
The Measurement Wait sets the measurement wait time.

Factor Factor value. 0 to 10, 0.1 resolution. Thisis the N value shown
in“Wait Time” on page 4-63.

This area sets the bias hold function used to keep the source output after
measurement. The source module applies the specified bias between a measurement
and the next measurement performed in the repeat measurement or quick test. See
“Bias Hold Function” on page 4-41.

BiasHold after
M easurement Bias hold function ON or OFF
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Semiconductor
Relays (16440A
SMU/PG Selector)

Classic Test Definition
Advanced Setup Window for C-V Sweep

Output Valueafter
M easurement Source output val ue after measurement

START (sweep start value) or STOP (sweep stop value)
Effective only for the instrument installed with SPGU or PGU. Agilent 16445A
selector adapter is needed for connecting Agilent 16440A SMU/PG selector.

This area sets the selector CH1/CH3 status (DEFAULT or PGU OPEN). To use this
function, set the DEFAULT setting to Always SMU or Normally PGU (AUX) by
using the SMU/PG Selector tab screen on the Configuration window before starting
the SPGU output.

CH1 CH1 status, DEFAULT or PGU OPEN.
CH3 CHS3 status, DEFAULT or PGU OPEN.

CH1 represents channel 1 on the first selector and CH3 represents channel 1 on the
second selector. See “ SMU/PG Selector” on page 4-49 for details on the selector.
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Setup Name

Connection

Classic Test Definition
Switching Matrix Control

Switching Matrix Control

On the EasyEXPERT main screen, click the Classic Test tab and select the
Switching Matrix Control icon. The main screen displays the Switching Matrix
Control setup screen. This setup screen is used to create the relay control setup for
Agilent B2200A/B2201A/E5250A Switching Matrix.

To apply the relay control setup, click the Single button. Before doing this, you have
to establish the GPIB connection to the switching matrix by using the Switching
Matrix tab screen of the Configuration window. See “ Switching Matrix” on page
1-52.

Used to set the name of the relay control setup. The name must be the identification
for the setup saved to a My Favorite group (preset group). Enter a unique name that
isdistinct from other setup.

The nameisrecorded in the test result dataand is used to differentiate the datain the
test record list area.

Thisareais used to create the relay control setup for the switching matrix.

Add Adds arow for the relay connection setup.

Delete Deletes the setup row. To select the setup row, use the left radio
button.

Up Moves the selected setup row upward.

Down Moves the selected setup row downward.

The setup row provides the following entry fields.
Operation Relay control operation

Open All, Switch Setup, Close Range, Open Output,
Open Range, or Open Input. See Table 2-4.

Input Switching matrix input port number or label

Available for the Switch Setup, Close Range, and Open Input
operations.
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Classic Test Definition
Switching Matrix Control

Outputs

Rule

Switching matrix output channel number or label

Four entry fields are available for the Switch Setup and
Open Output operations to specify the output channels.

Two entry fields are available for the Close Range and
Open Range operations to specify the range of output channels.

Relay connection rule

BBM: Breaks the previous connection and then makes the new
connection for the specified outputs.

MBBR: Makes the new connection and then breaks the
previous connection for the specified outputs.

Table 2-4 Relay Control Operations

Operation

Description

Open All

Opens all relays.

Switch Setup

Makes the connection from the specified input port to the
specified output channels. Up to four output channels can be
specified at once.

Close Range

M akes the connection from the specified input port to the
specified output channels. They are between two channels given
by the Outputs fields.

Open Output

Opens the relays connected to the specified output channels. Up
to four output channels can be specified at once.

Open Range

Opens the relays connected to the specified output channels.
They are between two channels given by the Outputs fields.

Open Input

Opens the relays connected to the specified input port.
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Setup Name

Channel Definition

SPGU Setup

Classic Test Definition
SPGU Control

SPGU Control

On the EasyEXPERT main screen, click the Classic Test tab and select the SPGU
Control icon. The main screen displays the SPGU control screen. See “ SPGU
Module” on page 4-27 for the function of the SPGU.

Used to set the name of the SPGU control setup. The name must be able to identify
a setup saved in a My Favorite group (preset group). Enter a unique name that is
distinct from other setup.

The nameis recorded in the execution result data and is used to differentiate the data
in the test record list area.

Defines the SPGU channel setups.

Unit Semiconductor pulse generator unit (SPGU) used for the
voltage pulse output or the arbitrary linear waveform voltage
output

VName Name of voltage output data

Mode Output mode VPUL SE (voltage pul se output) or ALWG

(arbitrary linear waveform voltage output).

All SPGU channels must have the same output mode.

Add Adds arow for the channel setup.

Delete Deletes the channel setup. To select the channel setup, use the
|eft radio button.

Up Moves the selected channel setup upward.

Down Moves the selected channel setup downward.

Provides the following buttons used to open the following setup window.

Pulse/ ALWG Opens “SPGU Pulse Setup Window” if Mode=VPULSE.
Opens “SPGU ALWG Setup Window” if Mode=ALWG.

Advanced Opens “Advanced Setup Window for SPGU Control”.
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Progress Monitor

After Measurement
Setting

Semiconductor
Relays (16440A
SMU/PG Selector)

Classic Test Definition
SPGU Control

Provides the following check boxes used to set the Data Display window displayed
while the SPGU channel output is applied.

Graph: % of
Progress Check this box to display the Percent of Progress vs. Time plot.

List: TimeData Check thisbox to display the Time datalist.

No data may be displayed on the Data Display window if the SPGU output time is
too short. The progress monitor will be used for long duration outputs, for example
when the duration is longer than 30 seconds.

Advanced Setup Window for SPGU Control

Thiswindow is opened by clicking the Advanced button on the SPGU Control
screen, and is used to set the following functions of the SPGU channel.

Sets the bias hold function used to decide the channel output after the SPGU output
operation.

BiasHold after
M easurement Bias hold function ON or OFF

If the bias hold function is OFF, the channel stops the output immediately after the
SPGU output operation.

If the function is ON, the channel maintains the base voltage output (in the VPUL SE
mode) or theinitial voltage output (in the ALWG mode) between a SPGU output
operation and the next operation performed in the repeat execution or quick test.
Channel initialization occurs at the beginning of the next operation.

Setsthe Agilent 16440A selector CH1/CH3 status (DEFAULT or PGU OPEN). To
use thisfunction, set the DEFAULT setting to Always SMU or Normally PGU (AUX)
by using the SMU/PG Selector tab screen on the Configuration window before
starting the SPGU output.

CH1 CH1 status, DEFAULT or PGU OPEN.
CH3 CHS3 status, DEFAULT or PGU OPEN.

CH1 represents channel 1 on the first selector and CH3 represents channel 1 on the
second selector. See “ SMU/PG Selector” on page 4-49 for details on the selector.

Agilent 16445A selector adapter is needed for connecting the 16440A.
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Global Settings

Operation

Pulse Settings

Classic Test Definition
SPGU Pulse Setup Window

SPGU Pulse Setup Window

Thiswindow is opened by clicking the Pulse/ALWG button on the SPGU Control
screen when Mode=VPUL SE, or by clicking the SPGU Pulse Setup button on the
I/V Sweep / Multi Channel I/V Sweep / 1/V List Sweep / 1/V-t Sampling
Measurement Setup screen. It is used to set the SPGU pulse output. See Figure 2-3
for the pulse setup parameters.

Provides the following entry field. The setting is effective for al channels.
Period Pulse period. 20 nsto 10 s, 10 nsresolution.
Provides the following radio buttons used to set the SPGU channel output operation

mode, free run, pulse count, or duration. Select one of the following buttons to set
the operation mode. The setting is effective for all channels.

FREE RUN In this mode, the SPGU continues the pulse output until the
measurement is completed or stopped.

This mode is not available for the SPGU Control classic test.

PULSE COUNT Inthis mode, the SPGU outputs the specified number of pulses.
Specify a number within the range of 1 to 1000000.

DURATION In this mode, the SPGU continues the output until the specified
time elapses. Specify atime within the range of 1 usto
31556926 s (1 year).

Unit Semiconductor pulse generator unit (SPGU) used for the
voltage pul se output

VName Name of voltage output data

Type 2-Level Pulse or 3-Level Pulse. If you choose 3-Level Pulse,
the Additional Pulse fields become effective.

Base, Peak Pulse base and peak voltage. 0to + 40 V, 1 mV resolution.

Delay Delay time. 0 sto Period- 20 ns, resolution 2.5 nsor 10 ns
(pulse transition time > 8 ps).

Width Pulse width. 10 nsto Period- 10 ns, resolution 2.5 nsor 10 ns

(pulse transition time > 8 us).

Leading, Trailing Pulsetransition time. 8 nsto 400 ms, resolution 2 nsor 8 ns
(pulse transition time > 8 us).
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SPGU setup view
order

Load Z

Pulse Switch

Figure 2-3

Classic Test Definition
SPGU Pulse Setup Window

Up Moves the selected channel setup upward.
Down Moves the selected channel setup downward.

Changes are effective only for the display on the SPGU Pulse Setup window and not
memorized. They are not applied to the Channel Setup.

This button opensthe“Load Z Setup Window” used to set the load impedance of the
DUT (device under test) connected to the SPGU channel. The SPGU wiill
automatically adjust the output voltage by using this value, and output the voltage
close to the specified pulse base and peak values.

This button opens the “ Pulse Switch Setup Window” used to set the pulse switch
operation. The pulse switch is used to set the open condition of the SPGU output
channel. The pulse switch is more durable than mechanical relays, and is better
suited for frequent switching applications.

SPGU Pulse Setup Parameters

V/10 4

Normally open  Close _Open
Pulse switch 1 ; ! ‘ !
Delay-sw Width-sw Delay-sw
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Classic Test Definition
Load Z Setup Window

Load Z Setup Window

Thiswindow is opened by clicking the Load Z button on the SPGU Pulse Setup
window or the SPGU ALWG Setup window, and is used to set the load impedance
of the DUT (device under test) connected to the specified SPGU channel.

Set the correct impedance value. The SPGU will automatically adjust the output
voltage by using this value, and output the voltage close to the specified pulse base

and peak values.

Load Z Unit Semiconductor pulse generator unit (SPGU) used for the
voltage pulse output or the arbitrary linear waveform voltage
output

VName Name of voltage output data
Load Z Load impedance of the DUT (device under test) connected to

this channél in Q.
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Pulse Switch

Classic Test Definition
Pulse Switch Setup Window

Pulse Switch Setup Window

Thiswindow is opened by clicking the Pulse Switch button on the SPGU Pulse
Setup window, and is used to set the pulse switch operation. The pulse switch is
used to set the open condition of the SPGU output channel. The pulse switch ismore
durable than mechanical relays, and is better suited for frequent switching

applications.

Unit Semiconductor pulse generator unit (SPGU) used for the
voltage pul se output

VName Name of voltage output data

SW Sync ENABLE (enables the pulse switch) or DISABLE (disables the
pulse switch).

Switching of the pulse switch status (open and close) will be
controlled automatically and synchronized with the output
pulse, as shown in Figure 2-3.

Delay Delay time from start of pulse output to changeover of pulse
switch. 0 sto Period- 100 ns, 10 nsresolution.

Width Duration to hold the switched state of the pulse switch. 100 ns
to Period- Delay ns, 10 ns resolution.

Normal CLOSE (normally closes the pulse switch) or OPEN (normally
opensthe pulse switch). The pulse switch will change the status
after the Delay-sw time and keep the status until the Width-sw
time elapses as shown in Figure 2-3. This operation is repeated
every pulse period.
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Operation

ALWG Setting

Load Z

Figure2-4

Classic Test Definition
SPGU ALWG Setup Window

SPGU ALWG Setup Window

Thiswindow is opened by clicking the Pulse/ALWG button on the SPGU Control
screen when Mode=ALWG, or by clicking the SPGU ALWG Setup button on the
I/V Sweep / Multi Channel I/V Sweep / 1/V List Sweep / 1/V-t Sampling
Measurement Setup screen. It is used to set the arbitrary linear waveform output.

Provides the following radio buttons used to set the SPGU channel output operation
mode, free run, sequence count, or duration. Select one of the following buttonsto
set the operation mode. The setting is effective for all channels.

FREE RUN In this mode, the SPGU continues the ALWG sequence output
until the measurement is completed or stopped.

This mode is not available for the SPGU Control classic test.

SEQUENCE

COUNT In this mode, the SPGU outputs the specified number of
sequences. Specify a number within the range of 1 to 1000000.

DURATION In this mode, the SPGU continues the output until the specified
time elapses. Specify atime within the range of 1 usto
31556926 s (1 year).

Provides the following field.

ALWG Source  Click the start button in this field to open the Define ALWG
Waveform window which is used to define the arbitrary linear
waveform and its output sequence. See “Define ALWG
Waveform Window” on page 2-68.

Thisbutton opensthe“Load Z Setup Window” used to set the load impedance of the
DUT (device under test) connected to the SPGU channel. The SPGU will
automatically adjust the output voltage by using this value, and output the voltage
close to the specified pulse base and peak values.

SPGU ALWG Setup Window

[Operation |

* FREERUN *° PULSE COUNT 10000 2]

" DURATION ]

[ALWG Setting \

ALWG Source: (] ]

start button %= |
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File menu

Pattern menu

Column menu

Classic Test Definition
Define ALWG Waveform Window

Define ALWG Waveform Window

Thiswindow is opened by clicking the start button in the waveform data entry field
or the ALWG Source field on the SPGU ALWG Setup window, and is used to create
the arbitrary linear waveform data which is defined by the pattern data and the
sequence data.

Provides the following five functions.

Export ALWaveform... Exportsthe waveform data.

Import ALWaveform... Imports the specified waveform data.

Export Pattern... Exports the pattern highlighted in the Patterns display
area.

Import Patterns... Imports the specified pattern data.

Close Closes the Define ALWG Waveform window.

Provides the following six functions.

New Thisisfor creating anew pattern. Opens the New Pattern
dialog box. Entering a new name opens Waveform
Pattern Editor (p. 2-71).

Edit Opens the Waveform Pattern Editor with the pattern
highlighted in the Pattern display area.

Cut Cuts the pattern highlighted in the Pattern display area
and storesit on the Clipboard.

Copy Copies the pattern highlighted in the Pattern display area
to the Clipboard.

Paste Pastes the pattern stored on the Clipboard.

Rename Renames the pattern highlighted in the Pattern display
area.

Provides the following five functions.

Edit Opensthe Waveform Pattern Editor with the column data
highlighted in the Sequence Editor area.

Insert Adds a column.
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Sequence Editor

Delete

Move

Repeat Count

Classic Test Definition
Define ALWG Waveform Window

Deletes the column data highlighted in the Sequence
Editor area.

Moves the highlighted column to the left or the right.

Opens the Repeat Count dialog box used to set the repeat
count.

Specifies the output channel, the output pattern, the repeat count of the pattern, and
the output sequence of patterns. These setup information create the arbitrary linear

waveform data

Column No.

Repeat Count

channel
(e.g SPGU1:HV)

Number for specifying the output sequence. The pattern will be
output in the order of this number.

Output repeat count for the pattern specified by the channel
field (e.gright field of the label “SPGU1:HV"). The repeat
count must be entered in thisfield.

Output channel and its output pattern. The channel is specified
by the header (e.g SPGU1:HV) of this row. The pattern data
must be specified by this entry field. A pre-defined pattern can
be selected from the drop down menu in thisfield. The right
button opens the Waveform Pattern Editor.

This area provides the following buttons.

Insert Column
Delete Column
To L eft

To Right

Adds a column.

Deletes the highlighted column.

Move the highlighted column to the left.
Move the highlighted column to the right.

This area also provides the following functions in the menu displayed by
right-clicking this area.

Cancel

Insert Column
Delete Column
Move Column
Repeat Count

Edit

Closes the menu.

Adds a column.

Deletes the highlighted column.

Moves the highlighted column to the left or the right.

Opens the Repeat Count dialog box used to set the repeat count.

Opens the Waveform Pattern Editor with the specified pattern
data (Pattern) or the specified column data (Column).
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Patterns

Classic Test Definition
Define ALWG Waveform Window

The Repeat Count field provides the following functionsin the menu displayed by
right-clicking the field.

Cut Cuts the highlighted value and stores it on the Clipboard.
Copy Copies the highlighted value to the Clipboard.
Paste Pastes the value stored on the Clipboard.

When acolumn is highlighted (light blue), the highlighted area provides the
following functionsin the menu displayed by right-clicking the field.

Cancel Closes the menu.

Edit Column Opens the Waveform Pattern Editor with the specified column
data.

When achannel field is highlighted (light blue), the highlighted field provides the
following functionsin the menu displayed by right-clicking the field.

Cancel Closes the menu.
Edit Pattern Opens the Waveform Pattern Editor with the specified pattern
data.

Displaysiconsfor all pre-defined waveform patterns and provides the following
functionsin the menu displayed by right-clicking this area.

Cancel Closes the menu.

New Pattern Thisisfor creating anew pattern. Opensthe New Pattern dialog
box. Entering a new name opens Waveform Pattern Editor (p.
2-71).

Edit Opens the Waveform Pattern Editor with the highlighted
pattern.

Cut Cuts the highlighted pattern and stores it on the Clipboard.

Copy Copies the highlighted pattern to the Clipboard.

Paste Pastes the pattern stored on the Clipboard.

Rename Renames the highlighted pattern.

Export Pattern... Exportsthe highlighted pattern data.
Import Pattern... Importsthe specified pattern data.

Double-clicking a pattern icon will open the Waveform Pattern Editor with the
clicked pattern.
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File menu

Edit menu

Display menu

Classic Test Definition
Define ALWG Waveform Window

Waveform Pattern Editor

Thiswindow is opened by several actions, for example by selecting New from the
Pattern menu, and is used to create or edit the pattern data.

Provides the following three functions.

Save Saves the pattern data.

SaveAs... Opens adialog box used to specify a pattern name
and save the pattern data.

Close Closes the Waveform Pattern Editor without saving
the data.

Provides the following seven functions.

Undo Undoes the last action.

Redo Cancels the Undo operation.

Add a New Point Adds apoint.

Delete a Point Deletes the highlighted point.

Same Level AsLeft Point Sets the highlighted point to the same level asthe
left point.

Copy Pattern to Clipboard  Copiesthe highlighted pattern data to the Clipboard
in the tab-separated spreadsheet format.

Paste Pattern from Clipboar d Pastes the tab-separated spreadsheet format data
stored on the Clipboard.

Provides the following function.

Channe Opens the Display Channels dialog box used to
select the SPGU channels displayed on the
Waveform Pattern Editor. Thisfunctionisavailable
if the Waveform Pattern Editor was opened with the
column data.
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Pattern Editor

Classic Test Definition
Define ALWG Waveform Window

Defines the pattern data. The Pattern Editor provides two methods, graphic mode
and tabular mode, for defining the pattern data.

In the graphic mode, you can define the pattern data by using the mouse pointer and
GUIs on the graph (on the left side of the Pattern Editor).

In the tabular mode, you can define the pattern data by entering Time in seconds,
Level inV, and Switch O (pulse switch open) or 1 (pulse switch close) into the table
(on the right side of the Pattern Editor).

The Delta Time check box and the Delta L evel check box are used to switch the data
expression in thetable. If the box is not checked, the value will be an absolute value;
if the box is checked, the value will be the difference from the previous point.

The Pattern Editor provides the following buttons.
Undo Undoes the last action.

Redo Cancels the Undo operation.
Add a New Point Addsa point.

Delete a Point Deletes the highlighted point.

The Pattern Editor also provides the following functions in the menu displayed by
right-clicking the area.

Cancel Closes the menu.

Save Saves the pattern data.

Edit Displays the Edit menu.
Display Displays the Display menu.

If the Pattern Editor is opened with the column data, the following GUI will be
available.

Ref Ch. Specifies the channel or the pattern which contains the
reference point.

Ref Pt. Specifies the reference point by the index number (No. column
of table).

DeltaT Displays the difference from the reference point. For time data.

DeltaV Displays the difference from the reference point. For level data.
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Application Test Definition




Application Test Definition

This chapter provides the reference information of the application test definition
setup GUI of Agilent EasyEXPERT software.

* “Test Definition Window”
» “Test Specification”

«  “Test Output”

* “Test Contents’

» “Local Variable Definition”

*  “Program Component”
* “Auto Anaysis’

» “DataDisplay Control”
» “Display Data Setup”

e« “GPIBI/O"

s “Message’

» “Data Store Control”

e “Command Execution”

» “Using Command Execution”

3-2
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Figure 3-1

Application Test Definition
Test Definition Window

Test Definition Window

The Test Definition window is opened by selecting the Define New Test... function
or the Open Definition of This Test... function of the Library menu, and is used to
create atest definition used in the application test mode.

The test definition consists of the elements shown in Figure 3-1. And the Test
Definition window provides the following three tabs for creating atest definition.

» “Test Specification”

The test specification contains test name, description, device parameters, and
test parameters. The parameters will be the variables used to pass the test
conditions to the test execution flow or test setup defined in the test contents.

 “Test Contents’

The test contents are the core of the test definition, and defines the local
variables, test execution flow, and test setup. You can define the test setup by
selecting application tests, classic tests, or My Favorite setup, and entering the
test conditions.

«  “Test Output”

The test output setup is optional. If you need the test result output (test result
display and record) of the test definition, declare the variables (analysis
parameters) and define the display setup.

Test Definition

Test Specification

*Test name *Variables
*Test description *Analysis parameters
+Variables *Test result display
*Device parameters *X-Y graph
*Test parameters *Data list

«Entry fields Tesl ne'inilinn +Parameter display

Local variables
*Test execution flow
*Test setup

+Classic test
*Application test
My Favorite setup
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Application Test Definition
Test Definition Window

The Test Definition window provides the following menus.

File menu Provides the following two functions.

Save Saves the test definition. The sample application
tests furnished with the EasyEXPERT and the
application tests created by other users cannot be
saved without changing the Test Name value. The
Test Name must be your original.

Close Opens adialog box that asksif you want to save
before closing the window. Selecting Yes saves the
test definition and closes the Test Definition
window. Selecting No closes the Test Definition
window without saving the test definition.

Help menu Agilent EasyEXPERT Help  Opensthe EasyEXPERT help window.
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Test Information

Device Parameters
Definition

Application Test Definition
Test Specification

Test Specification

This setup screen is used to define the test definition information and the input
parameters for the test definition.

The test information is defined in this area.

Category

Test Name

Icon

Description

Displays the category of the test definition.

The button opens a dialog box used to set the category. It must
be 1 to 30 characters. Multiple categories can be set to atest
definition.

Specifies the test definition name. It must be 1 to 30 characters.

Specifies a bitmap file used for the test definition icon listed in
the Library area of the main screen.

Browse...: Opens adialog box used to select a bitmap file.
Cancel: Returnsto the default setting.
Enters the description of the test definition.

The device parameters are defined in this area. Type of the device parameter is

Numeric.
Name
Default
Description
Add

Delete

Up

Down

Device parameter name

Default value of the parameter
Description of the parameter

Adds arow for the device parameter.

Deletes the selected device parameter. To select the parameter,
use the left radio button.

Moves the selected device parameter upward.

Moves the selected device parameter downward.
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Test Parameters
Definition

Application Test Definition

Test Specification

The test parameters are defined in this area.

Background

Name

Type

Default

Description

Align

X, Y

Width
Ext

Layout...

Specifies a bitmap file used for the background in the Test
Parameters area of the main screen.

Browse...: Opens adialog box used to select a bitmap file.
Cancel: Returnsto the default setting.
Test parameter name

Type of the test parameter, Numeric, Module, String, Vector, or
ALWaveform (SPGU ALWG output data)

Default value of the parameter

For the Numeric, Vector, or ALWaveform type parameter, this
field provides the button to open Numeric KeyPad at the right
side.

For the Vector type parameter, this field provides the button to
open the “Define vector data (page 2-18)” dialog box at the left
side.

For the ALWaveform type parameter, this field provides the

button to open the “ Define ALWG Waveform Window (page
2-68)" at the left side.

Description of the parameter

Specifiesthe X origin of the entry field in the main screen Test
Parameters area. Check this box to set it to the |eft edge of the
entry field. Uncheck this box to set it to the left edge of the
parameter name placed to the left of the entry field.

Specifies the entry field position. (X, Y)=(0, 0) specifiesthe
upper left corner of the main screen Test Parameters area.
Downward and rightward are positive. See “Layout...”.
Specifies the width of the entry field.

Do not check usually. The entry field for the parameter is put on
the main screen.

If the parameter is minor and do not need changes frequently,
check the Ext check box. The entry field will be put on the
dialog box displayed by clicking the “ Extended Setup (page
1-28)" button.

Opens the “ Define Layout (page 3-10)” dialog box.
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Properties

Add
Delete

Up
Down

Copy
Paste

Application Test Definition
Test Specification

Adds arow for the test parameter.

Deletes the selected test parameter. To select the parameter, use
the left radio button.

Moves the selected test parameter upward.

Moves the selected test parameter downward.
Copies the selected test parameter to the Clipboard.
Pastes the test parameter stored on the Clipboard.

The Properties areais used to define the following values for the specified device
parameter or test parameter. See “ Device Parameters Definition” on page 3-5 and
“Test Parameters Definition” on page 3-6.

To specify the parameter, select the radio button to the | eft of the parameter name.

Min

Max

Digits
Resolution

Unit

Typical Values...

Resource Type

For Numeric or Vector parameters. Allowable minimum value.
For Numeric or Vector parameters. Allowable maximum value.
For Numeric or Vector parameters. Number of effective digits.

For Numeric or Vector parameters. Allowable setup resolution.
For Numeric or Vector parameters. Unit of the parameter.

For Numeric or String parameters.

Opens the Define typical values dialog box used to define the
selections (typical values) for the specified parameter.

The values defined here are the selections for the parameter
entry field displayed on the main screen in the application test
mode. The selections for the active entry field are displayed on
the softkey. And one of the selections can be set by using the
softkey. Also, it can be set by using the Select sub menu
displayed by right-clicking the entry field.

The selections are effective for the specified parameter only.
For Module parameters.

Opens the Define Resource Types dialog box used to specify
the type of measurement resource. Multiple resouces can be set.
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Application Test Definition

Test Specification

Dimension...

Assign Output
Channels...

SMU, HPSMU, HCSMU, HVSMU, HRSMU, MPSMU,
HRSMU/ASU, GNDU, SPGU, HVSPGU, WGFMU,
RSWGFMU, MFCMU, MFCMU/SCUU, SWM I[N,
SWM AUX IN, or SWM SMU IN

For Vector parameters.

Opens the Define dimensions dialog box for defining the
dimension of vector data.

Use Dim1Min and Dim1Max to specify the primary dimension
of vector data. This direction can be for the primary sweep data.

Use Dim2Min and Dim2Max to specify the secondary
dimension of vector data. This direction can be for the
secondary sweep data.

The following conditions must be satisfied.
¢ 1 < DimlMin < DimilMax (ex. Dim1Min=1,
Dim1Max=11)

¢ 1 < Dim2Min < Dim2Max (ex. Dim2Min=1,
Dim2Max=3)

For ALWaveform parameters.

This button opens the Assign ALWaveform Output Channels
dialog box which specifies the variables if they are used to
identify the SPGU channels. The variables must be the Module
type test parameter.

For example, when the parameters are defined as shown bel ow,
PG1 should be set to the Assign ALWaveform Output Channels
dialog box for the WAV E1 parameter.

PG1: Module parameter to identify the SPGU channel
WAVEL: ALWaveform parameter for the PG1 setup data

Use “Define ALWG Waveform Window (page 2-68)” to create
the SPGU ALWG setup data. For the above example, the PGlis
the SPGU channel identifier when creating the WAV E1 data.
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NOTE

Symbols...

Application Test Definition
Test Specification

For Numeric or Vector parameters.

Opensthe Define dimensions dialog box for assigning a symbol
(string value) to a numeric value for the specified numeric
parameter.

By defining the numeric-symbol assignment, the symbol value,
instead of the numeric value, is set to the parameter entry field
displayed on the main screen in the application test mode.

In the test definition, the parameter works as a numeric value.
However, the numeric-to-string translation result will not be the
string value simply trandated from the numeric value but the
symbol assigned to the numeric value.

For example, if Symbol=ON is assigned to Value=1 of the
Param1 parameter, the string ON will be set to the Param1 entry
field when numeric value 1 is entered into the Param1 field.
Also, while the Param1 field shows ON, the Param1 value will
be 1 in the test definition. And when the numeric value of
Paraml is 1, the numeric-to-string translation result will not be
the string 1 but the string ON.

The numeric-symbol assignment is effective for the specified
parameter only.

Value and symbol must be in a one-to-one relationship.

The value must satisfy the Min, Max, Digits, and Resolution
settings. The symbol must be between 1 and 30 characters.

Symbols... numeric-symbol assignment

For parameters defined with a numeric-string assignment, the numeric-to-string
translation result will be the symbol assigned to the numeric value. Be careful when
using the string built-in function that is used to translate a numeric expression to a

string value.

For the following example setup of a numeric-symbol assignment,
st ri ng( Mode) execution result at Mode=0 is the string OFF, not the string O.

Name=Mode, Value=0, Symbol=0FF
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Figure 3-2

Application Test Definition
Test Specification

Define L ayout

This dialog box is opened by clicking the Layout... button on the Test Specification
screen of the Test Definition window, and is used to define the layout of the test
parameter entry fields displayed on the application test setup screen. See Figure 3-2.

To define the layout of the entry field, follow the procedures bel ow.
1. Select the entry fields to move. See“To Select Entry Fields’ on page 3-13.
2. Move the selected entry fields. See “To Move Entry Fields’ on page 3-13.

Define Layout dialog box

Define Layout — -
File Edit View Align Distribute Centralize Tab Order

IntegTime: [MEDIUM =[5~ -2 R

:::F'.rir.n:ag:g\n.iee.p:: i T

: VsubsStep:

s PrlmaryEntryFleld S SR S e e e
OK Cancel

Define Layout GUI
This section describes the Graphical User Interface of the Define Layout dialog box.
The Define Layout dialog box provides the following buttons.

OK Saves the layout definitions and closes the Define Layout
dialog box.

Cancel Closes the Define Layout dialog box without saving the layout
definitions.
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File menu

Edit menu

View menu

Aligh menu

Distribute menu

Centralize menu

Application Test Definition
Test Specification

The Define Layout dialog box provides the following menus.

Exit

Undo
Redo
Select All

Property...

L eft

Center

Right

Top

Middle

Bottom

To Grid

Horizontally

Vertically

Horizontally

Vertically

Closes the Define Layout dialog box without saving the layout
definitions.

Cancels an operation. Up to ten operations can be cancelled.
Performs the canceled operation again.

Selects all entry fields.

Opens the “Properties (page 3-12)” window.

Alignsthe left ends of other selected entry fieldsto the left end
of the primary entry field.

Alignsthehorizontal centers of other selected entry fieldsto the
horizontal center of the primary entry field.

Alignsthe right ends of other selected entry fields to the right
end of the primary entry field.

Alignsthe upper ends of other entry fields to the upper end of
the primary entry field.

Alignsthe vertical centers of other selected entry fields to the
vertical center of the primary entry field.

Alignsthe lower ends of other selected entry fieldsto the lower
end of the primary entry field.

Alignsthe upper left corner of the entry field to the nearest grid.

Distributes the selected entry fields (3 or more) with even
horizontal intervals. The leftmost entry field is used as the base
point.

Distributes the selected entry fields (3 or more) with even
vertical intervals. The leftmost entry field is used as the base
point.

Moves the horizontal center of all selected entry fields to the
horizontal center of the entry field area.

Moves the vertical center of all selected entry fieldsto the
vertical center of the entry field area.
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Tab Order menu

Design

Layout

Behavior

Layout

Application Test Definition

Test Specification

Top to Bottom

L eft to Right

Properties

Sets the Tablndex in ascending order of the X of the entry
fields, starting at the upper l€eft entry field. If the X of the entry
fields are equal, the Tablndex is set in ascending order of the Y
of the entry fields. For more information on X/Y, see
“Properties’ on page 3-12.

Sets the Tablndex in ascending order of the Y of the entry
fields, starting at the upper left entry field. If the Y of the entry
fields are equal, the Tablndex is set in ascending order of the X
of entry fields.For more information on X/Y, see “Properties’
on page 3-12.

Thiswindow is opened by clicking the Property... button in the View menu of the
Define Layout dialog box, and specifies characteristics of the entry field area or the

entry fields.

When the entry field areais selected, the following characteristics can be specified.

DrawGrid
GridSize
SnapToGrid

Size

Sets whether to display the grid.
Sets the width and the height of the grid.
Sets whether to snap to the grid.

Sets the width and the height of the entry field area.

When entry fields are selected, following characteristics can be specified.

Tablndex

Align

Width
X, Y

Setsthe tab traversing order for the test parameter entry fields
of the application test.

Specifiesthe X origin of the entry field.

True: Left edge of the entry field

False: Left edge of the parameter name placed to the left of the
entry field

Specifies the width of the entry field.

Specifiesthe entry field position. The Y origin isthe upper edge

of theentry field.(X, Y)=(0, 0) specifiesthe upper |eft corner of
the entry field area. Values increase downward and rightward.

3-12
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Application Test Definition
Test Specification

To Select Entry Fields
The following methods are available for selecting the entry fields.

» Click ontheentry field. Multiple entry fields can be selected by clicking on the
entry field while holding down the Ctrl key on the keyboard.

» Drag the mouse to draw arectangle around multiple entry fields.
e Select Select All from the EDIT menu to select all entry fields.

The selected entry fields are outlined by the blue rectangles. The primary entry field,
which is the base for layout operations, is surrounded by a highlighted blue
rectangle, as shown in Figure 5-5. Only one primary entry field can be selected. To
change the primary entry field, click on a selected entry field. The selected entry
field that was most recently clicked will be the primary entry field.

The following methods are available for releasing (unselecting) the selected entry
fields.

e Click the selected entry field while holding down the Shift key on the keyboard.
» Click outside of the selected entry fieldsto release all selected entry fields.

ToMove Entry Fields

The following methods are available for defining the layout of the selected entry
fields.

» Drag & drop with the mouse to move the selected entry field(s).

» Changethe X/Y valuesin the property window to move the sel ected entry
field(s).
» Pressthe arrow keys on the keyboard to move the selected entry field(s).

» Using the functions in the Align menu, the selected single or multiple entry
fields can be aligned to the primary entry field.

» Usethe functions in the Distribute menu to evenly distribute the selected entry
horizontally or vertically.

» Usethe functions in the Centralize menu to move the horizontal or vertical
center of all selected entry fields to the horizontal or vertical center of the entry
field area
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Define Own Output
Parameters

Allocate Data
Display for each
test

Define Analysis
Parameters...

X-Y Graph,
List Display,
Parameters

Application Test Definition
Test Output

Test Output

This setup screen is used to set the test result output (test result display and record)
that is the output of the test definition.

The test output setup is optional. If you have the following requirements, define the
analysis parameters and set the display parameters.

» To send thetest result data to the subsequent tests in an application test
» To make the program branching depends on the test result

» To make the calculation using the test datain the Test Contents

» Todisplay/record the test result of this application test

To read the analysis parameters defined in the application test used in atest
definition, use the “External Variable Setup (page 3-23)” dialog box.

Check this check box to set the test result outputs of the test definition. While this
box is checked, the X-Y Graph, List Display, and Parameters areas are available.
The test result output will be obtained every execution of the test definition.

Thisfield setsthe Multi Display function to Enable, Disable, or Comply with above
level.

If Enable is selected, the test result data of the same test setup name will be
displayed on the exclusive Data Display window and the test result data of the
different test setup name will be displayed on the new Data Display window.

If Disable is selected, the test result data will be always displayed on the singular
Data Display window even if it isthe test result data of the different test setup name.

Select Comply with above level for complying with the Multi Display ON/OFF
status or the setting of the application test which uses this application test internally.

This button opens the window. This “ Analysis Parameter Definition (page 3-15)"
window is used to define the vector data and the scalar data used in the test result
output. The defined variable is called as the analysis parameter.

The areas are used to set the test result output (test result display and record) that is
the output of the test definition. See “Display Setup” on page 2-46.
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NOTE

Vector Parameters

Scalar Parameters

Application Test Definition
Test Output

Analysis Parameter Definition

Thiswindow is opened by clicking the Define Analysis Parameters button, and is
used to define the vector variables and the scalar variables used in the test result
output. The variables are called as the analysis parameters. Thiswindow is closed
by the Close button.

Analysis parameters can be referred from atest definition which uses this
application test. To read the value, make a mapping table between the analysis
parameters and the local variables, device parameters, test parameters, or analysis
parameters defined in the test definition by using the “ External Variable Setup (page
3-23)” dialog box.

This area sets the analysis parametersfor the vector data. The vector dataisan array
datathat contains numeric data more than one.

Name Name of the analysis parameter

Unit Unit of the analysis parameter

Description Description of the analysis parameter

Add Adds arow for the parameter.

Delete Deletes the selected parameter. To select the parameter, use the
|eft radio button.

Up Moves the selected parameter upward.

Down Moves the selected parameter downward.

This area sets the analysis parameters for the scalar data. The scalar dataisa
numeric data.

Name Name of the analysis parameter

Unit Unit of the analysis parameter

Description Description of the analysis parameter

Add Adds arow for the parameter.

Delete Deletes the selected parameter. To select the parameter, use the
|eft radio button.

Up Moves the selected parameter upward.

Down Moves the selected parameter downward.
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Figure 3-3

Application Test Definition
Test Contents

Test Contents

Test contents are the core of the test definition, and consists of the local variables,
test setups, and test execution flow. In the test contents, the following elements can
be defined. See Figure 3-3.

Local variables

Program components

Application tests

Classic tests

My Favorite setup

Analysis components

Miscellaneous components

Device parameters defined in Test Specification
Test parameters defined in Test Specification
Analysis parameters defined in Test Output

The device parameters, test parameters, and analysis parameters can be used in the
Test Contents without defining as the local variables.

For the available components, see Figure 3-4.

Test Contents
Test Specification Test Output
Variables Variables

Local variables

*Device parameters
Test parameters

Test Contents

Miscellaneous

*Analysis parameters

Program Component

Application Test My Favorite setup
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Figure 3-4

Defining/Editing Test Contents

Application Test Definition

Test Contents

The Test Contents setup screen is used to define the test execution flow that is the
core of the test definition. To define the test execution flow, use the test flow list
area at the lower left of the window, and do following. Also see Figure 3-5.

1
2.

4.

Define local variables by using the Local Variables Definition statement.

Select a component from the component selection area. See Figure 3-4 for the

available components.

Insert it between the BLOCK and END BLOCK statements.

Repeat this until your test execution flow is completed.

Available Components

Program Component

B2 A& & ® B A
BLOCK ON ERROR  FINALLY F LOOF FOR. ASSIGN COMMENT END ERROR
Application Test
ek = = l@ Eﬁg
1= = B B 7
Ategory | oielv  Diodelv  FETIvg FETIRVd BT BT Icvel
Furd Rev GummelFlot
Analysis
[ ] = [~
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Auto Display Data Data Display
Analysis Setup Control
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o ] 5 R ]
IV Sweep Multi vt C-V Sweep SPGU Switching Direct
Channel L.. Sampling Control Matrix ... Control =
Miscellaneous
g = i
B0 B =
GFIB /O Message Command Data Store
Execution Control
~
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e 2 - e
trng - N1_OUT?7  idvggm Subsite Matrix
move Preset
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Program
Component

Application Test

Analysis

Classic Test

My Favorite Setup

Application Test Definition
Test Contents

This component selection menu lists the program components available for the test
flow. See “Program Component” on page 3-26.

This menu lists the application test setups available for the user. Inserting an
application test setup to the test flow displays the test setup screen almost same as
the “Application Test” on page 1-27. You set the test condition on this screen.

Variables can be used for setting the test condition. To use a Numeric or Module
variable, enter the variable name to the entry field. To use a String variable, type an
equal sign (=) and enter the variable name (for example, =VAR).

Clicking the Assign to external variables... button opens the External Variable Setup
dialog box. See “External Variable Setup” on page 3-23.

This component selection menu lists the analysis functions available for the test
flow, and provides the following components.

» “Auto Anaysis’ on page 3-27
» “Display Data Setup” on page 3-31
» “DataDisplay Control” on page 3-30

This component selection menu lists the classic test objects, 1/V Sweep, Multi
Channel 1/V Sweep, I/V List Sweep, I/V-t Sampling, C-V Sweep, SPGU Control
Switching Matrix Control, and Direct Control.

Inserting a classic test component to the test flow displays the test setup screen
almost same asthe “1/V Sweep” on page 2-4, “Multi Channel 1/V Sweep” on page
2-9, “l/V List Sweep” on page 2-13, “I/V-t Sampling” on page 2-21, “C-V Sweep”
on page 2-26, “ SPGU Control” on page 2-61, “ Switching Matrix Control” on page
2-59, or “Direct Control” on page 2-30. You set the test condition on the screen.

Clicking the Assign to external variables... button opens the External Variable Setup
dialog box. See “External Variable Setup” on page 3-23.

This component selection menu is used to select the My Favorite setup inserted to
the test flow. Specify the preset group, then select the setup.

If atracer test setup is selected, it is converted to and inserted asaMulti Channel I/V
Sweep test setup.
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Miscellaneous

Edit / Debug

Block Selection /
Line Selection

Application Test Definition
Test Contents

This component selection menu lists the miscellaneous functions available for the
test flow, and provides the following components.

e “GPIB I/O" on page 3-33

*  “Message’ on page 3-38

» “Command Execution” on page 3-40
» “Data Store Control” on page 3-39

To add a component to the test flow, select the destination line for the component
and drag the component from the component selection areato the test flow list area.
Instead, you can select aline and a component, then click the Insert button. The
component will be put on the line after the selected line, and the following lineswill
shift downward.

After adding a component to the test flow, selecting the new line might display an
editor at the center to lower right of the window. The editor is used to define the
setup. Some components provide the editor, and some components do not. For
example, the Local Variables Definition provides the editor used to define the local
variables. See “Local Variable Definition” on page 3-24.

You can edit the test flow by using the Block Selection/Line Selection, Insert,
Delete, Copy, Cut, and Paste buttons. Also you can debug the test flow by using the
Run/Pause, Abort, Step, Break, and Inspect buttons. See “ Debugging Test Contents’
on page 3-21.

The Edit tab displays the buttons Block Selection/Line Selection, Insert, Delete,
Copy, Cut, and Paste.

The Debug tab displays the buttons Run, Abort, Step, Break, and Inspect.

Only the buttons effective for the selected linein the list area are active.

The Line Selection button changes the list area sel ection mode to the line selection

mode. The Block Selection button changes the sel ection mode to the block
selection.

In the line selection mode, the line cursor selects every line.

In the block selection mode, the line cursor selects every block. For example, the
lines from the |F statement to END |F statement can be a block.
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Application Test Definition
Test Contents

Insert This button puts the selected component on the next line of the selected line. The
following lines will shift downward.

Delete This button deletes the selected line. The following lines will shift upward.

Copy This button copies the selected line to the clipboard.

Cut This button moves the selected line to the clipboard. The following lines will shift
upward.

Paste This button puts the components in the clipboard on the next line of the selected

line. The following lines will shift downward.

Figure 3-5 Test Contents Screen
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Figure 3-6

Run/Pause

Abort

Step

Break

Inspect

Application Test Definition
Test Contents

Debugging Test Contents

On the Test Contents tab screen, click the Debug tab. The following buttons will
appear. They are useful for debug of your test contents.

Set the break point, and click the Run button. And check the operation of the test
contents, the value of variables by using the Variable Inspector, and so on.

Debugging Test Contents
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This button starts the debug (executes the test flow). During execution, the |abel
changesto Pause. Clicking Pause pauses the execution, and changes the label to Run
that is used to continue the debug (execution).

This button aborts the debug (execution).

This button executes the selected line of thetest flow. Clicking the button repeatedly
continues the execution by aline.

This button sets/rel eases the break point. For the break point, this button releases the
break point from the selected line. Program execution will break at the break point
automatically.

Thisbutton is avail able when the debug (execution) is paused or broken. This button
opens the Variable Inspector used to monitor value of device parameters, test
parameters, analysis parameters, local variables, or system variables. See “Variable
Inspector” on page 3-22.
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Numeric Variable

Vector Variable

String Variable

Module Variable

Application Test Definition
Test Contents

Variable I nspector

This Variable Inspector is displayed by clicking the “Inspect (page 3-21)" button on
the Test Contents screen, and is used to monitor or change the value of the local
variables, device parameters, test parameters, and analysis parameters. For the
vector variables, only datamonitor is available. The Variable Inspector provides the
following buttons to add the variable monitor area.

Add Numeric Variable Adds the numeric variable monitor area.
Add Vector Variable Adds the vector variable monitor area.
Add String Variable Adds the string variable monitor area.
Add ModuleVariable  Addsthe module variable monitor area.

The following functions are available for the menu displayed by clicking the banner
of the variable monitor area.

Up This button shifts the variable monitor area upward.
Down This button shifts the variable monitor area downward.

Remove This button del etes the variable monitor area

You can monitor or change the following information.
Variable Numeric variable name

Value Value of the variable

You can monitor the following information.

Name Vector variable name. Two dimensional array.
Index1/2 Index for the primary/secondary plane of the two-dimensional array
Value Value of the variable

You can monitor or change the following information.
Variable String variable name

Value Value of the variable

You can monitor or change the following information.
Variable Module variable name

Value Value of the variable
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External variable

Measurement data

Example

Application Test Definition
Test Contents

External Variable Setup

Thisdialog box is displayed by clicking the Assign to external variable... button on
an Application Test setup screen or a Classic Test setup screen, and is used to make
amapping table between the test setup internal variables and the local variables,
device parameters, test parameters, or analysis parameters defined in the test
definition which uses this test setup. After making the mapping table, you can read
the value by using the external variables.

This dialog box provides the following buttons.

Add Adds the variable entry fields.

Delete Deletes the variable entry fields selected by the radio button.
Up Shifts the selected variable entry fields upward.

Down Shifts the selected variable entry fields downward.

This dialog box provides the following entry fields.

Name of local variable, device parameter, test parameter, or analysis parameter
connected with the variable set to the Measurement data field

Name of internal variable used in atest setup and to be read. For the Application
Test, only the analysis parameters are available.

The following example connects the internal vector variable Vdata with the local
variable VDATA.

1. Define VDATA asalocal variable by using the Local Variables Definition
statement.

Click the Assign to external variable... button on atest setup screen.
Click the Add button on the External Variable Setup dialog box.
Set VDATA to the External variable field.

Set Vdata to the Measurement data field.

o g~ WD

Click the Close button.
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Numeric Variable

Application Test Definition
Local Variable Definition

L ocal Variable Definition

This setup editor is displayed while the Local Variable Definition is selected in the
test execution flow list area, and is used to define the variables used in the test
definition. The setup editor provides the following buttons to add the variables.

Add Numeric Variable Addsthe numeric variable.
Add Vector Variable Adds the vector variable.
Add String Variable Adds the string variable.
Add Module Variable  Addsthe module variable.

The following functions are avail able for the menu appeared by clicking the banner
of the variable area.

Up This button shifts the variable area upward.
Down This button shifts the variable area downward.

Remove This button deletes the variable.

This area provides the following entry fields.
Name Numeric variable name
Value Initial value of the variable

Description Additional information for the variable
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Vector Variable

String Variable

Module Variable

Application Test Definition
Local Variable Definition

This area provides the following entry fields.

Name Vector variable name. Two dimensional array.
Count Number of elements, or array size
Description Additional information for the variable

This area also provides the following radio button used to specify how to set the
initial value of the array data automatically.

* Assign Linear Values FROM [value of first element] TO [value of last element]

If Count > 1, this setsfirst value + (N- 1) x (last value- first value)/(Count- 1) to
the N-th element. If Count = 1, this setsfirst value (=last value) to the element.

* Assign Linear Values FROM [value of first element] STEP [step value]
This setsfirst value + (N- 1) x step to the N-th element.

This area provides the following entry fields.
Name String variable name
Value Initial value of the variable

Description Additional information for the variable

This area provides the following entry fields.
Name Module variable name

Description Additional information for the variable
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ASSIGN

COMMENT

IF

ELSE IF

FOR

Application Test Definition
Program Component

Program Component

The Program Component selection menu provides the components described in
“Script Program Statements” on page 5-19. Especially, the following components
provide the setup editor.

. “ASSIGN”
« “COMMENT’
. P

. “ELSEIF

.+ “FOR’

This component provides the setup editor that contains the following entry fields
used to define the value of the variable.

Variable Variable name
Expression Definition of the variable

This component provides the setup editor used to enter the comment for the line.

This component provides the setup editor used to enter the condition for the IF
Statement.

This component provides the setup editor used to enter the condition for the
EL SE IF statement.

This component provides the setup editor that contains the following entry fields
used to define the FOR NEXT loop condition.

Variable Variable name

Initial Value Count to start the FOR NEXT loop

Terminate Value Count to terminate the FOR NEXT loop

Sep Value Loop count incremental step value
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Interpolation Mode

Line 1, Line 2

Application Test Definition
Auto Analysis

Auto Analysis

This component provides the setup editor used to set up the automatic analysis
function. When a measurement finishes, the function automatically drawslines, a
marker, or both on the X-Y Graph of the Data Display window.

You can set up two lines and one marker for the automatic analysis function by
using the setup editor.

IntheLine 1 and Line 2 areas, you can set up the lines to be drawn.
In the Marker area, you can set up the marker.

Check this box to enable the interpolation mode. You can position marker between
measurement points.

Thisareasetstheline 1 or line 2 automatically displayed and moved to the specified
position after the measurement.

Enable Check this box to enable the line.

Fix Check this box to fix the line on the graph after the auto
analysis is performed. Remove the check to make the line free.

Type Select one of the available line types listed below.

Axis Axis effective for the line. Specify onefromY1to Y8.

First Point See the following description for the line you selected.

Second Point See the following description for the line you selected.
Available line types:

*  “Normal ling": For drawing a line between any two points.
» “Gradient line": For drawing aline through any point with a specified gradient.
» “Tangent line": For drawing atangent line to a measurement point.

» “Regressionline’: For drawing aregression line by using the measurement data
included in the area specified by any two points.
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Marker

Normal line

Gradient line

Application Test Definition
Auto Analysis

This area sets the marker automatically displayed and moved to the specified
position after the measurement.

Enable Check this box to enable the marker.

Condition Enter a variable name and a condition expression to specify
where you want the marker to appear.

After Check this box to enable the additional condition.

Enter a second variable and condition expression. Thissetsup a
search start condition for finding specified point.

For example, you can specify the following expressionsto search for a measurement
point that satisfies the first condition after the second condition is satisfied.

Condition:[ DGM]=[MAX(DGM)*0.01] [x] After [DGM]=[MAX(DGM)]
The First Point area and the Second Point area are used to specify the pointsthe line
passes through. The following two ways are available to specify the point.
* X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition
Enter a variable name and condition expression to specify the point. Thisis the

same method as specifying the Marker point.

The First Point areais used to specify the point the line passes through. The
following two ways are available to specify the point.

» X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition

Enter a variable name and condition expression to specify the point. Thisisthe
same method as specifying the Marker point.

In the Gradient field, enter agradient value or expression.
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Application Test Definition
Auto Analysis

Tangent line The First Point areais used to specify the measurement point the tangent line passes
through.

Enter avariable name and condition expression to specify the point. Thisisthe same
method as specifying the Marker point.

Regression line The First Point area and the Second Point area are used to specify the range of the
measurement data used for the regression calculation. The following two ways are
available to specify the point.

* X-Y Coordinate
Enter the desired X-Y coordinate values or expressionsinthe X and Y fields.
» DataCondition

Enter a variable name and condition expression to specify the point. Thisis the
same method as specifying the Marker point.
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Application Test Definition
Data Display Control

Data Display Control

This component enables or disables the test result display of the application test or
the classic test used in the test definition.

Enable Data Display = Checking this box enables the test result display.

If you do not use this component, the test result display is enabled.

This component cannot control the test result display of the test definition. The test
result display is always enabled for the test definition. For the test result output of
the test definition, see“ Test Output” on page 3-14.
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X-Y Graph

Application Test Definition
Display Data Setup

Display Data Setup

This component is used to set the data output of the local variables defined in the
test execution flow. The values can be displayed on the Data Display window.

Selects the data to be displayed in the X-Y Graph Plot area. The X and Y1to Y8

axes can be set.
Name

Sharing

Scale
Min
Max
Add
Delete
Up

Down

Specifies the parameter for the axis.

Specifies the group for sharing the Y axis scale. Select from
Group 1, Group 2, Group 3, Group 4, or None (ho grouping).

The Scale, Min, and Max values are shared by the Y axesin the
same group. The scale set by Run Time Auto Scale, Auto Scale,
Zoom in, and/or Zoom out are also shared.

If another layer on the Data Display window contains an X-Y
trace which has the same name for both its grouped Y
parameter and its X parameter, the scaling will also be shared
by this X-Y trace.

Scale of the axis, Linear or Log

Minimum value of the axis

Maximum value of the axis

Adds a parameter (or axis).

Deletes the parameter selected with the radio button on the left.
Moves the selected parameter upward.

Moves the selected parameter downward.
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Application Test Definition
Display Data Setup

List Display, The List Display area sets the output for the List Display area of the Data Display
Parameters window. The Parameters area sets the output for the Parameters area of the Data

Display window. Up to 20 parameters can be set for each area.

parameter Specifies the parameter for the data output.

Add Adds arow for the parameter.

Delete Deletes the selected parameter. To select the parameter, use the

left radio button.
Up Moves the selected parameter upward.
Down Moves the selected parameter downward.
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CAUTION

Write String

Write Value

Application Test Definition
GPIB I/O

GPIB I/O

This component provides the setup editor that contains the following entry fields.
This component is used to control the GPIB interface. For the fieldsto enter a
variable name, only the variable name defined in the test definition can be entered.

Do not set the GPIB address of the B1500 to the Address parameter of this
component even if thisis on the Desktop EasyEXPERT software. Operation of the
B1500 is not guaranteed.

Sends the specified string data to the specified GPIB device.

Address
Sring

Terminator

GPIB address of the target device
String value to send

Terminator, DEFAULT, EOI, CR/LF+EOQI, LF+EQI, CR/LF,
LF, or NONE (not specified)

Translates the specified numeric data to the string data, and sendsit to the specified

GPIB device.
Address
Format

ValueO
Valuel
Value2
Value3

Terminator

GPIB address of the target device

Format of Write Value. Follow Agilent T& M Programmers
Toolkit.

Numeric value or string value to send
Numeric value or string value to send
Numeric value or string value to send
Numeric value or string value to send

Terminator, DEFAULT, EOI, CR/LF+EOQI, LF+EQI, CR/LF,
LF, or NONE (not specified).
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Read Value

Application Test Definition

GPIB 1/O

Reads a string value from the specified GPIB device.

Address
Sring
Length To Read

Length Actually
Read

Ter minator

Terminated

Timeout

GPIB address of the target device
String variable name. Used to store the returned value.
Byte length of the string value to read

Numeric variable name. Used to store the byte length of the
returned value. If the Length To Read is large enough and the
terminator is sent with the returned string value, the value of
this numeric variable is smaller than the specified Length To
Read.

Terminator, DEFAULT, EOI, CR/LF+EOQI, LF+EQI, CR/LF,
LF, or NONE (not specified)

Numeric variable name. Used to store the execution result. If
reading is completed by the terminator, 1 is entered. Otherwise,

0 is entered.
Timeout. The value must be less than 231
0 does not set timeout.

s, 1 msresolution.

Reads a numeric value from the specified GPIB device.

Address GPIB address of the target device

Value Numeric variable name. Used to store the returned value.

Preamble String variable name. Used to store preamble of the returned
value. The preamble is a part considered as non-numeric value.
If thisfield is not set, the preambleis del eted.

Postamble String variable name. Used to store postamble of the returned
value. The postambleisapart considered as non-numeric value.
If thisfield is not set, the postamble is del eted.

Success Numeric variable name. Used to store the execution result. For
the successful result, 1 is entered. Otherwise, O is entered.

Ter minator Terminator, DEFAULT, EOI, CR/LF+EOI, LF+EOQOI, CR/LF,
LF, or NONE (not specified)

Timeout Timeout. The value must be less than 231 s, 1 ms resolution.
0 does not set timeout.
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Read STB

GP-IB Control

Application Test Definition

GPIB I/O
Reads a vector data from the specified GPIB device.
Address GPIB address of the target device
Values Vector variable name. Used to store the returned value.
Delimiter Delimiter. 1 character. 0t0 9, E, g, +, - , and . (comma) cannot
be specified.
Length Actually
Read Numeric variable name. Used to store the number of data stored
in the vector variable.
Ter minator Terminator, DEFAULT, EOI, CR/LF+EOI, LF+EOQOI, CR/LF,
LF, or NONE (not specified)
Timeout Timeout. The value must be less than 231 s, 1 msresolution.
0 does not set timeout.
Reads the status byte of the specified GPIB device.
Address GPIB address of the target device
Satus Byte Numeric variable name. Used to store the status byte to read.
Timeout Timeout. The value must be less than 231 s, 1 msresolution.

0 does not set timeout.

This area selects one from the following GPIB statements to execute.

» Group Execution Trigger
Sends atrigger to the specified GPIB device.
Address GPIB address of the target device

231

Timeout Timeout. The value must be less than s, 1 msresolution.

0 does not set timeout.
» DeviceClear
Sends a device clear to the specified GPIB device.
Address GPIB address of the target device

Timeout Timeout. The value must be less than 231 s, 1 msresolution.
0 does not set timeout.
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» GoTolLoca
Returns the specified GPIB device to the local state.
Address GPIB address of the target device

Timeout Timeout. The value must be less than 231 s, 1 msresolution.
0 does not set timeout.

* Local LockOut
Locks the specified GPIB device.
Address GPIB address of the target device

Timeout Timeout. The value must be less than 231 s, 1 msresolution.
0 does not set timeout.

To send the following command to Agilent B2200A switching matrix (GPIB
address 22), use Write Value function and enter the parameters as shown bel ow.

‘ROUT:SYMB:CHAN 0, 1, “Gate”

This command assigns the string Gate to the output 1 of the B2200A in the auto
configuration mode.

*  Write Vaue
Address 22
For mat :ROUT:SYMB:CHAN {0}, {1}, “{2}"
Value0 0
Valuel 1
Value2 Gate
Value3 (blank)
Terminator LF+EOI

where, {0}, {1}, {2}, and { 3} are the variablesthat can be used in the Format field,
and corresponds to the Value0, Valuel, Value?, and Value3 respectively.
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Example 2 After performing Example 1, enter the following query command and read the
response by using Write String and Read String functions as shown below. Use
Write String to send the command, after that use Read String to read the response.

‘ROUT:SYMB:CHAN?O, 1

This command returns the string assigned to the output 1 of the B2200A in the auto
configuration mode.

»  Write String:
Address 22
Sring ‘ROUT:SYMB:CHAN?0, 1
Terminator LF+EOI

* Read String:
Address 22
Sring Returnedvalue
Length To Read 10
Length Actually Read Lengthl
Terminator LF+EOI
Terminated Term
Timeout 1.00s

where, ReturnedValue is a string variable to store the response of the
‘ROUT:SYMB:CHAN? 0, 1 command, Lengthl is a numeric variable to store the
byte length of the ReturnedValue value, and Term is a numeric variable to store the
execution result. They must be defined in the Local Variables Definition statement.
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Message
User Response

Button 1

Button 2

Button 3

Button 4

Application Test Definition
Message

M essage

This component provides the setup editor that contains the following entry fields.
These are used to set up the message box that pauses program execution, appears on
the screen, and waits for the response of the user.

Enter the message displayed on the message box.
This area provides the Button 1, Button 2, Button 3, and Button 4 areas.

This area provides the following entry fields.
Label Label or name of the button placed at the left side

Selected Variable name used in the test definition. The variable is used to store
the response of the user. The returned valueis 1 if the message box is
closed by clicking this button. Otherwise, the returned value is 0.

This area provides the following entry fields.

Label Label or name of the button placed at the second from the left

Selected Variable name used in the test definition. The variable is used to store
the response of the user. The returned valueis 1 if the message box is
closed by clicking this button. Otherwise, the returned value is 0.

This area provides the following entry fields.

Label Label or name of the button placed at the second from the right

Selected Variable name used in the test definition. The variable is used to store
the response of the user. The returned valueis 1 if the message box is
closed by clicking this button. Otherwise, the returned value is 0.

This area provides the following entry fields.

L abel Label or name of the button placed at the right side

Selected Variable name used in the test definition. The variable is used to store
the response of the user. The returned valueis 1 if the message box is
closed by clicking this button. Otherwise, the returned value is 0.
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Data Sore Control

This component enables or disables the test record of the application test or the
classic test used in the test definition.

Enable Creating Test Result Record
Checking this box enables the test record.

If you do not use this component, the test record is enabled.

This component cannot control the test record of the test definition. The test record
is always enabled for the test definition. For the test result output of the test
definition, see “ Test Output” on page 3-14.
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Command Execution

This component provides the setup editor that contains the following entry fields.
This component is used to execute the specified execution file (EXE file) and obtain
the execution results. For the fields to enter a variable name, only the variable name
defined in the test definition can be entered. See “Using Command Execution” on

page 3-42.
Command File name of the Windows execution file (EXE file) to execute.
Filename
Argument Argument or parameter to pass to the EXE file.
Write Type Type of datato write. String (string data) or List (vector data).
e String

Displays the Write String area used to specify the string data to write. Up to 20
string data can be defined.

+ List
Displays the Write List areathat provides the following entry fields.
Values Variable name of the List data to be passed to the EXE file.

Format
If you do not specify Format, this function passesthe List datato
the EXE file. To pass adatain the List data, enter the keyword to
specify the element. See “Defining Format Field” on page 3-45.

3-40 Agilent EasyEXPERT User’s Guide, Edition 1



Application Test Definition
Command Execution

Read Type Type of datato read. String (string data), Value (numeric data), List (vector data), or
None (no response).
String
Displays the Read String area that provides the following entry fields.
Result Numeric variable name. Used to store the execution result.
Sring String variable name. Used to store the returned value.
Length
Actually Read Numeric variable name. Used to store the byte length of the
returned value.
Value

Displays the Read Value area that provides the following entry fields.

Result Numeric variable name. Used to store the execution result.
Value Numeric variable name. Used to store the returned value.
List

Displaysthe Read List areathat provides the following entry fields.

Result Numeric variable name. Used to store the execution result.
Values Vector variable name. Used to store the returned value.
None

Thistypeisfor the EXE file without response or datato read.
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Using Command Execution

Windows execution file (.exe file) can be executed by using the Command
Execution component. Most execution files will need parameters to be sent or
returned. The parameters will be variables that can be defined on the Test
Specification tab screen or the Local Variable Definition component on the Test
Contents tab screen.

This section describes how to enter the windows execution file.

* “Command Parameters’

» “Defining Numeric/Vector Input Parameter”
» “Defining String/Numeric Input Parameters”
» “Defining Numeric Output Parameter”

» “Defining Vector Output Parameter”

» “Defining String Output Parameter”

» “Defining Format Field”

Command Parameters

The Windows Command Execution component supports one input variable and one
output variable. To use multiple string input parameters or multiple numeric input
parameters, set the variable as shown below. Multiple vector input parameters and
multiple output parameters are not supported.

» If the command requires multiple string input parameters, use string variables.
In the Windows Command Execution component, set the Write Type to String.
Up to 20 string data can be defined.

» If the command requires multiple numeric input parameters, use numeric
variables and set the Write Type to String. To enter the numeric variable name,
use the string built-in function. For example, enter st ri ng( Rz) to set the Rz
numeric variable.

» If the command requires both numeric and string input parameters, use numeric
and string variables respectively, and set the Write Type to String.

Before calling the command, enter the value to the input variable by using the
ASSIGN statement.
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string built-in function

The string built-in function is used to translate a numeric expression to a string
value. Be careful about the argument for this function. If it isanumeric variable
defined with the numeric-symbol assignment, the string function execution result
will be the symbol assigned to the numeric value, not the string value just trandl ated
from the numeric value. The numeric-symbol assignment is defined in the “ Test
Specification” on page 3-5.

For the following example setup of the numeric-symbol assignment,
st ri ng( Mode) execution result at Mode=0 is the string OFF, not the string O.

Parameter Mode, Value=0, Symbol=0OFF

Defining Numeric/Vector Input Parameter

1. Define avector variable in the Test Specification tab screen or the Local
Variable Definition component of the Test Contents tab screen.

2. Set the Write Type to List in the Windows Command Execution component.
3. Enter the variable name in the Values field of the Write List area.

For the numeric parameter, a data element of vector variableis used to store the
data for the parameter. Specify the data by using the Format field. For example,
enter { 0} to specify the datain the first element of the vector variable. For the

Format field, see “Defining Format Field” on page 3-45.

For the vector parameter, ignore the Format field.

Defining Sring/Numeric I nput Parameters

1. Define string or numeric variables in the Test Specification tab screen or the
Local Variable Definition component in the Test Contents tab screen.

2. Set the Write Type to String in the Windows Command Execution component.
3. Add alinein the Write String area.
4. Enter the variable name for the first input parameter in the first line.

If the command needs multiple input parameters, add a line and enter the
variable name for the variable in the added line. Then observe the order of
parameters.

To enter anumeric variable name, use the string built-in function. For example,
enter st ri ng( Rz) to set the Rz numeric variable.
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Defining Numeric Output Parameter

1. Define anumeric variable in the Test Specification tab screen or the Local
Variable Definition component of the Test Contents tab screen.

2. Set the Read Type to Vaue in the Windows Command Execution component.
3. Enter the variable namein the Value field of the Read Value area.

The Result field can be blank or the name of another numeric variable defined in the
Test Specification or Local Variable Definition. The variable will be used to receive
the command execution result.

Defining Vector Output Parameter

1. Define avector variable in the Test Specification tab screen or the Local
Variable Definition component of the Test Contents tab screen.

2. Set the Read Typeto List in the Windows Command Execution component.

3. Enter the variable namein the Values field of the Read List area

The Result field can be blank or the name of a numeric variable defined in the Test
Specification or Local Variable Definition. The variable will be used to receive the
command execution result.

Defining Sring Output Parameter

1. Defineastring variablein the Test Specification tab screen or the Local Variable
Definition component of the Test Contents tab screen.

2. Set the Read Type to String in the Windows Command Execution component.

3. Enter the variable name in the String field of the Read String area.

The Result field and the Length Actually Read field can be blank or the name of a
numeric variable defined in the Test Specification or Local Variable Definition. The
variable will be used to receive the command execution result or the length of the
returned string data.
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Defining Format Field

The Format field requires a keyword to specify adatain vector variable. The
keyword must have the style such as {I,A:F}. where,

I Index used to specify the element. Integer, O or positive number.
Mandatory. 0 specifies the first element.

A Character length of the specified data element. Positive integer for
right-aligned, or negative integer for left-aligned. If thisvalueisnot set,
the length is not specified (no limit).

F Style of the data. See Table 3-1. If thisvalueisnot set, G is selected..

Following are the example formats. For more information, see online help or
manual of Agilent T& M Programmers ToolKkit.

» {0,5:E} First element, five characters, exponential notation

» {1,10} Second element, 10 characters, general

o {2:x} Third element, no limit for length, hexadecimal numeric
» {3} Fourth element, no limit for length, genera

Available F values

F M eaning F M eaning
Corc | Circulation Norn | Numeric
Dord | Decima numeric Porp | Percent
Eore | Exponentia notation Rorr | Roundtrip
Forf Fixed point X orx | Hexadecimal numeric
Gorg | Genera
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Setup Example

The following example setup is used to execute a PlsdivM easureld command that
has two numeric inputs and four numeric outputs.

ranging and id_range are numeric variables used for the input parameters,

read data isavector variable used for the output parameters, and PassFail isa
numeric variable used to store the command execution result. They must be defined
in the Test Specification tab screen or the Local Variable Definition component on
the Test Contents tab screen. Input parameter values must be set to the variables
before executing the command. Four datawill be assigned to read_data in sequence.

Figure 3-7 Windows Command Execution Setup Example

Windows Command Exzecution |
Ccommand Filename: IEPngram Files¥a,gilent¥PLSDIVEPLSDIVEe¥ TISExe¥PlsdiviMeasurald. exe g Browse. .. |
Argument: I _@
Write Type: & String  List
Read Type: " String " Yalue & List  MNone

Write String |

Add Delete | Up | D |

© [string(ranging) =
o |string(id_range) =

Read List

Result: IPassFaiI 'I values: Iread_data vl
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Function Details

This chapter explains the following measurement functions of Agilent B1500 and
EasyEXPERT.

* “1/V Sweep Measurement”

o “Multi Channel I/V Sweep Measurement”
o “1/V-t Sampling Measurement”
* “C-V Sweep Measurement”

* "“SPGU Module’

* “Sweep Abort Function”

e “Standby Function”

» “BiasHold Function”

* “Current Offset Cancel”

e “SMU CMU Unify Unit”

» "Atto Sense and Switch Unit”
* “SMU/PG Selector”

* “Module Selector”

* “SMU Ranging Mode”

* “SMU Compliance”

e “SMU Pulse’

*  “"SMU Measurement Time"

e “SMU Filter”

* “SMU Series Resistor”

* “Interlock Function”

* “Auto Power Off Function”

e “Initial Settings”

4-2 Agilent EasyEXPERT User’s Guide, Edition 1



Figure4-1

Function Details
I/V Sweep Measurement

|/V Sweep M easurement

For the 1/V sweep measurements, sweep source channels (SMU) perform staircase
sweep output of voltage or current, while monitor channels (SMU) measure voltage
or current for each sweep step. According to the output function, the following
measurements are available. See Figure 4-1 for the SMU output function.

» “Basic Sweep Measurement” by using VAR function
» “Subordinate Sweep Measurement” by using VAR1 and VAR2 functions

» “Synchronous Sweep Measurement” by using VAR1 and VARY’ functions,
VAR2 function is also available

» “Pulsed Sweep Measurement”

Thisisthe basic, subordinate, or synchronous sweep measurement using a pulse
output SMU. Only one pulse output SMU is available.

SMU Output Function and Sweep Output

VAR1

VAR2 j—,—,i

VART’

Available M odules

SMUs and SPGUs can be used. SMU can be constant voltage/current source or
pulse voltage/current source and perform voltage/current measurement. SPGU can
be pulse voltage source. See “ SPGU Module” on page 4-27 for using the SPGU.

If multiple measurement channels are used, the channels perform measurement in
order. See “Multiple Measurement Channels’ on page 4-64.
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Function Details
I/V Sweep Measurement

Output Range

Output range of the sweep source channel is automatically set to the following
range.

e minimum range covers all sweep output valuesin Linear sweep.
e minimum range covers al sweep output valuesin Log voltage sweep.

» optimum range for output value every sweep step in Log current sweep.

Basic Sweep M easurement

Basic sweep measurement uses the primary sweep source (VARL). You can select
any combination of Direction and Linear/Log as shown in Figure 4-2.

» Direction

» Single source channel sweeps the output from user specified start value to
stop value.

« Double source channel sweeps the output from user specified start value to
stop value, then from stop value to start value.

* Linear/Log

¢ Linear staircase

* Logarithmic staircase

Saircase Sweep Outputs

Single Sweep Double Sweep

Linear Sweep JJI ﬁ
Log Sweep J J_H_HL

See “1/V Sweep” on page 2-4 for the GUI.
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The following setup is required to perform the basic sweep measurements.

1. Select the following on the Channel Setup tab screen.

* Seect VARL for the Function of the SMU used for VARL.

e SelectV, VPULSE, or COMMON for the Mode of current monitor SMU, or
| or IPUL SE for voltage monitor SMU. Pulseis available only for one SMU.

2. Specify the following parameters for VAR on the Measurement Setup tab

screen.
Direction

Linear/Log

Sart

Sop

Sep, No of Sep

Compliance

Pwr Comp

Hold

Delay

Single or double sweep.

Linear or logarithmic sweep. For logarithmic sweep, the
number steps in one decade is 10, 25, or 50.

Start value of sweep. Allowable range of start depends on
output range of sweep source. For logarithmic sweep, start
must not be zero.

Stop value of single sweep or turning back value of double
sweep. Allowable range of stop depends on output range of
sweep source. For logarithmic sweep, stop must have same
polarity as start, and must not be zero.

For linear sweep, step is step increment of sweep. No of Sep
is calculated from start, stop, and step.

For logarithmic sweep, step isinvalid. Number of sweep
stepsis calculated from start, stop, and number of stepsin
one decade.

Calculated number of steps must bein range: 1 to 1001.

Compliance value of sweep source. Allowable range of
compliance depends on the compliance range of sweep
source.

(Optional) Power compliance value of sweep source.
Allowable range depends on power compliance range of
Sweep source.

Time required for DUT to settle after forcing start value.
0 to 655.35 swith 10 msresolution.

Time required for DUT to settle after stepping the output.
0 to 65.535 swith 100 usresolution.
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Figure4-3 Basic Sweep M easurement
Qutput Voltage Th : hold time
or Current Td : defay time
N : #umber of steps
Stop Value T N
Th+Td . . Td

Single Sweep e 3

8]

Start Value + ¢

Time

} X

Trigger Completion
Th: hold time
Output Voltage Td : delay time
or Current Nt number of steps
Td
Stop N > N4
Value T
Double Sweep s % Td
LTt o T4
0 1 2N
Start T
Yalue
Time
X f
Trigger Completion

Subordinate Sweep M easurement

For subordinate sweep measurement, you set up a secondary sweep source (VAR?2)
in addition to aprimary sweep source (VARL). After VAR1 sweep is completed, the
output of VAR2 sweep source isincreased or decreased by the specified step value,
then the VAR1 sweep sourceis swept again.

Only the linear single sweep is available for the VAR2.

The following setup is required to perform the subordinate sweep measurements.
See “1/V Sweep” on page 2-4 for the GUI.

1. Select the following on the Channel Setup tab screen.
* Seect VARL for the Function of the SMU used for VARL.
* Seect VAR2 for the Function of the SMU used for VAR2.

e SelectV, VPULSE, or COMMON for the Mode of current monitor SMU, or
| or IPUL SE for voltage monitor SMU. Pulseis available only for one SMU.
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2. Set the VAR1 channel as shownin “Basic Sweep Measurement”.

3. Specify the following parameters for VAR2 on the Measurement Setup tab

screen.

Sart Start value of secondary sweep. Allowable range of start
